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Figure 1-1  Starting Autodesk 3ds Max 2014 using the taskbar

Figure 1-2  The Autodesk Customer Involvement Program dialog box



Introduction to Autodesk 3ds Max 2014		         1-3

Figure 1-3  The Welcome to 3ds Max dialog box

Figure 1-5  The 3ds Max message boxFigure 1-4  The New Scene dialog box

Figure 1-6  Different screen components of Autodesk 3ds Max interface screen
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Figure 1-7  The keyboard shortcuts 
in the Rendering pull-down menu

Figure 1-8  Partial view of the  
Application menu
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Figure 1-9  A flyout displayed 
on choosing the Icon or Image 
Display button

Figure 1-11  The Quick Access ToolbarFigure 1-10  The Application menu with the 
shortcuts
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Figure 1-12  The enhanced Lighting/Cameras pull-down menu displayed

 

Figure 1-13  The shortcut 
menu displayed to view the 
hidden toolbars 
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Figure 1-14  The Command 
Panel 

 
                                                  

Figure 1-15  Selecting a viewport to make it active
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Figure 1-16  Choosing the Reset Layout option from the shortcut menu

Figure 1-17  The world space tripod, grid, and ViewCube in the Perspective viewport
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Figure 1-18  The viewport labels in the Front 
viewport

Figure 1-19  The flyout displayed on clicking 
the POV viewport label

Figure 1-20  The Layout tab of the Viewport Configuration dialog box
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Figure 1-21  Different shading types in the cascading menu of the Stylized 
option

Figure 1-22  The viewport 
navigation controls

Figure 1-23  The 
animation playback 
controls

 

Figure 1-24  The animation 
keying controls

Figure 1-25  The track bar and the time slider
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Figure 1-26  The status bar

Figure 1-27  The Viewport Configuration dialog box
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Figure 1-29  The 
Snaps Toggle flyout

 

Figure 1-30  The Spinners 
area in the Preference Settings 
dialog box

Figure 1-28   The Grid and Snap Settings 
dialog box
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Figure 1-32  The Home Grid tab chosen 
in the Grid and Snap Settings dialog box

Figure 1-31  The Units Setup dialog box

Figure 1-33  The list of actions displayed after 
choosing on the Undo Scene Operation tool

Figure 1-34  The Scene Undo area 
in the Preference Settings dialog box

Figure 1-35  The About to Fetch. 
OK? dialog box
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Figure 1-36  The Customize User Interface dialog box 

Figure 1-37  The Revert Color File message box
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Figure 1-38  The Help tab chosen in the Preference Settings dialog box
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Figure 1-39  The search field Figure 1-40  List of commands displayed 
on entering first few characters 
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Figure 2-1  The Select From Scene dialog box

Figure 2-2  The circular gizmo in the Top 
viewport while rotating the object

Figure 2-4  Selecting the Z-axis 
for non-uniform scaling 

Figure 2-3  The scale gizmo 
for uniform scaling  

Figure 2-5  Selecting the YZ 
plane for non-uniform scaling 

Figure 2-6  The move gizmo Figure 2-7  The rotate gizmo Figure 2-8  The scale gizmo
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Figure 2-9  The Axis 
Constraints toolbar

 

Figure 2-11  A box displayed in the viewport Figure 2-10  Various rollouts to create a box

Figure 2-13  The Color Selector: 
Add Color dialog box

Figure 2-12  The Object Color dialog box
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Figure 2-15  A sphere displayed in 
the viewport

Figure 2-14  Various rollouts to create a sphere

Figure 2-17  A geosphere 
displayed in the viewport

Figure 2-16  Various rollouts to create a geosphere
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Figure 2-18  The geosphere 
displayed on selecting the 
Icosa radio button

Figure 2-19  The geosphere 
displayed on selecting the 
Tetra radio button

Figure 2-20  The geosphere 
displayed on selecting the 
Octa radio button

Figure 2-22  A cylinder 
displayed in the viewport

Figure 2-21  Various rollouts to create a cylinder 
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Figure 2-24  A cone displayed in 
the viewport

Figure 2-23  Various rollouts to create a cone 

Figure 2-26  A tube displayed in the 
viewport

Figure 2-25  Various rollouts to create a tube
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Figure 2-28  A torus displayed in 
the viewport

Figure 2-27  Various rollouts to create a torus

Figure 2-30  A pyramid displayed 
in the viewport

Figure 2-29  Various rollouts to create a pyramid
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Figure 2-32  A plane displayed in the 
viewport

Figure 2-31  Various rollouts to create a plane

Figure 2-33  Various rollouts to create a teapot Figure 2-34  A teapot displayed in the 
viewport
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Figure 2-35  The Perspective, frame 
0, RGBA Color16 Bits/Channel 
(1:1) window

Figure 2-36  The Render Setup: Quicksilver 
Hardware Renderer dialog box

Figure 2-37  The Rendering Level 
drop-down list
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Figure 2-39  The Environment 
and Effects dialog box

Figure 2-38  The iray rollout in the 
Render Setup dialog box

Figure 2-40  The model of a table with drawers
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Figure 2-41  The box displayed in viewports 

Figure 2-42  Alignment of left box with right box in viewports
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Figure 2-43  Alignment of drawer001 with left box

 

Figure 2-44  The Clone Options 
dialog box
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Figure 2-45  The drawer002 and drawer003 geometry created after cloning drawer001

Figure 2-46  Alignment of drawer004 in all viewports
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Figure 2-47  Alignment of left face001 with left side of the left box

Figure 2-48  Alignment of left face002
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Figure 2-49  Alignment of upper face with top of the table

Figure 2-50  Alignment of lower face with the bottom of left box
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Figure 2-51  Alignment of right lower face to the bottom of right box  of the table

Figure 2-52  Alignment of right face with the right side of right box of the table
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Figure 2-53  Alignment of knob001 with drawer001

Figure 2-54  Alignment of knobs in viewports
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Figure 2-55  The final output after rendering

    					                   

				                

Figure 2-56  The model of a park bench

Figure 2-57  A box created
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Figure 2-58  Horizontal back supports displayed in viewports

Figure 2-60  The horizontal back support005
geometry after rotating in the Left viewport 

Figure 2-59  The Rotate Transform Type-In 
dialog box

Figure 2-61  All horizontal back supports selected 
simultaneously 

Figure 2-62  The Group dialog box
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Figure 2-63  Alignment of horizontal seat support001 in viewports

     

Figure 2-64  Horizontal seat supports displayed in viewports
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Figure 2-65  The vertical back support001 geometry in viewports

Figure 2-66  The vertical back support002 in viewports 
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Figure 2-67  Alignment of cap and body Figure 2-68  The rivet001 group in the Left viewport

Figure 2-69  Rotating rivet001 in the Left viewport

Figure 2-70  Alignment of rivet001 with horizontal back support
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Figure 2-71  Alignment of rivets in the 
Left viewport

Figure 2-72  Rotating uppermost rivet

Figure 2-73  The right side rivets group displayed in viewports

  

Figure 2-74  Rotating back support in the 
Left viewport

Figure 2-75  Alignment of back support in the 
Left viewport
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Figure 2-76  Alignment of leg support001 with horizontal seat support

	

Figure 2-77  Alignment of leg support002 with horizontal seat support
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Figure 2-78  Alignment of leg support003 with horizontal seat support in viewports

Figure 2-79  Alignment of leg support004 in viewports
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Figure 2-80  The right side rivets group selected 
in the Select From Scene dialog box

Figure 2-81  The right side seat rivets group 
in the Left viewport

Figure 2-82  Rotating the right side seat 
rivets group in the Left viewport

Figure 2-83  Alignment of right side seat rivets 
in the Left viewport

Figure 2-84  Rotating rivet in the Left 
viewport
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Figure 2-85  Alignment of right side seat rivets in the Left viewport

Figure 2-86  Alignment of left side seat rivets in viewports
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Figure 2-87  Alignment of leg001 in viewports

Figure 2-88  Alignment of legs in viewports
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Figure 2-89  The final output after rendering 

				     					       

Figure 2-90  The model to be created in Exercise 2

Figure 2-92  The nut model (view 2) Figure 2-91  The nut model (view 1)
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Figure 2-93  The table model



Extended Primitives
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Figure 3-2  The Parameters 
rollout of the Bend modifier 

Figure 3-1  The Bend modifier 
displayed in the modifier stack

Figure 3-4  The Parameters 
rollout of the Taper modifier

Figure 3-3  The Taper modifier 
in the modifier stack
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Figure 3-5  Various rollouts to create a hedra Figure 3-6  A hedra displayed in the viewport

Figure 3-7 Five basic shapes of hedra
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Figure 3-8  Various rollouts to create 
a chamfer box

Figure 3-9  A chamfer 
box with rounded edges

Figure 3-10  A chamfer 
box with beveled edges
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Figure 3-11  Various rollouts to create a chamfer 
cylinder

 

Figure 3-12  A chamfer cylinder 
displayed in the viewport

Figure 3-13  A chamfer cylinder with 
beveled edges
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Figure 3-15  A capsule displayed 
in the viewport

Figure 3-14  Various rollouts to create a capsule
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Figure 3-17  A spindle displayed 
in the viewport

Figure 3-16  Various rollouts to create a spindle
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Figure 3-19  An L-Ext displayed 
in the viewport

Figure 3-18  Various rollouts to create an L-Ext
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Figure 3-21  A gengon displayed 
in the viewport

Figure 3-20  Various rollouts to create a gengon



3-10				                Autodesk 3ds Max 2014: A Comprehensive Guide

Figure 3-23  Partial view of the 
Parameters rollout of the ringwave

Figure 3-22  The Name and Color rollout

Figure 3-24  A ringwave 
displayed in the viewport



Extended Primitives		         3-11

Figure 3-25  The Name and Color rollout Figure 3-26  Partial view of the Hose 
Parameters rollout

Figure 3-27  A hose displayed in the viewport
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Figure 3-28  The model of a couch

Figure 3-29  A chamfer box created for seat support
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Figure 3-30  Alignment of back support with seat support

  

Figure 3-31  The left side geometry displayed in viewports
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Figure 3-32  The right side geometry displayed in viewports

Figure 3-33  The base geometry displayed in viewports
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Figure 3-34  The final output after rendering 

	

Figure 3-35  The model of a chair

Figure 3-36  The chamfer box created for seat support of the chair
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Figure 3-37  The back support geometry in viewports

Figure 3-38  The spring support geometry in viewports
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Figure 3-39  The spring support geometry after applying the Bend modifier

Figure 3-40  The spring support geometry 
zoomed in the Left viewport

Figure 3-41  The spring support geometry 
rotated in the Left viewport
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Figure 3-42  Alignment of  spring support in 
the Left viewport

Figure 3-43  Alignment of spring support in viewports 
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Figure 3-44  Alignment of leg support in viewports 

Figure 3-45  Alignment of leg01 in viewports
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Figure 3-46  The leg01 geometry after invoking the Zoom Extents All Selected tool  

Figure 3-47  The leg01 geometry displayed in viewports after applying the Taper modifier
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Figure 3-48  The box01 geometry displayed in viewports after applying the Bend modifier

	

Figure 3-49  Alignment of cylinder01 with box01 in viewports
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Figure 3-50  Alignment of roller01 with leg01 in viewports

 

Figure 3-51  A circular gizmo displayed at the 
location of the working pivot point

Figure 3-52  The f_leg01 group rotated about -72 
degrees with respect to the working pivot point
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Figure 3-53  The f_leg002, f_leg003, f_leg004, and f_leg005 groups in viewports

Figure 3-54  Alignment of right hand support01 in viewports
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Figure 3-55  The right hand support002 geometry after modifying the values of the Bend modifier

Figure 3-56  Alignment of right hand support002 in viewports
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Figure 3-57  The Mirror: World 
Coordinates dialog box

Figure 3-58  Alignment of left hand support in viewports
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Figure 3-59  The final rendered output 

	                                                                                             

Figure 3-60  The model of a stool

  
     

Figure 3-62  The model of a chairFigure 3-61  The model of a table

	



Default Objects
and Patch Grids
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Figure 4-1  The Mirror: World 
Coordinates dialog box

Figure 4-2  The align cursor in the Top viewport Figure 4-3  The Align Selection 
(Sphere001) dialog box
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Figure 4-4  Various rollouts 
to create a tree

 

       

       

 

Figure 4-5  A tree created 
using the Foliage tool
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Figure 4-6  The Parameters
 rollout

Figure 4-7  A tree with the 0 value 
in the Pruning spinner

Figure 4-8  A tree with the 0.5 value 
in the Pruning spinner

Figure 4-11  The tree with high 
level of detail at rendering  

Figure 4-9  The tree with low 
level of detail at rendering

Figure 4-10  The tree with medium 
level of detail at rendering 
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Figure 4-14  The railing with different 
dimensions

Figure 4-12  Partial view of various 
rollouts to create a railing

Figure 4-13  The railing with different parts labeled
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Figure 4-15  The Lower Rail 
Spacing dialog box

Figure 4-16  The railing with the extension 
in the posts

Figure 4-17  The railing with the picket 
type of fencing

 

Figure 4-18  The railing with the solid fill type of fencing
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Figure 4-19  The bottom offset in the 
picket fencing

Figure 4-20  Various offsets in the solid fill 
fencing

Figure 4-23  The Weld Point? message box

Figure 4-22  The wall 
segment displayed

Figure 4-24  A closed wall displayedFigure 4-21  Various rollouts 
to create a wall
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Figure 4-25  The Edit 
Object rollout

Figure 4-26  Partial view of various 
rollouts to create a pivot door

Figure 4-27  The pivot door 
created in the viewport
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Figure 4-28  A double pivot door Figure 4-29  An opened double door 

Figure 4-30  The modified 
door leaf

Figure 4-31  A door with 
the beveled panels 
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Figure 4-32  A sliding door

Figure 4-33  A bifold door

Figure 4-34  Partial view of various rollouts 
to create an awning window

Figure 4-35  An awning window
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Figure 4-36  An awning 
window with two panels

  

Figure 4-37  A casement window Figure 4-38  A casement window 
with two panels

Figure 4-39  A fixed window Figure 4-40  A fixed window with 
horizontal and vertical divisions 
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Figure 4-42  A pivoted window 
rotated around the vertical axis 

Figure 4-41  A pivoted window 
rotated around the horizontal axis 

 

Figure 4-43  A projected 
window

Figure 4-44  The 
sliding window

Figure 4-45  The sliding window 
with two horizontal and vertical 
chamfered divisions

Figure 4-46  The sliding window 
with the horizontal sliding
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Figure 4-47  Partial view 
of various rollouts to create 
L-type stairs

Figure 4-48  The L-type open stairs 
created
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Figure 4-50  The L-type box stairsFigure 4-49  The L-type closed stairs

 

Figure 4-51  The L-Type stairs with handrails, 
carriage, and stringers

Figure 4-52  The L-Type stairs with Angle 
value set to zero

Figure 4-53  The spiral 
stairs

Figure 4-55  The spiral 
box stairs

Figure 4-54  The closed spiral 
stairs
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Figure 4-57  The straight 
closed stairs

Figure 4-58  The straight 
box stairs

Figure 4-56  The straight 
stairs

Figure 4-59  The U-type stairs Figure 4-60  The U-type 
closed stairs

Figure 4-61  The U-type box 
stairs
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Figure 4-62  Various rollouts 
to create a quad patch

Figure 4-63  The quad patch displayed 
in the viewport
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Figure 4-64  The quad patch with rectangular 
and triangular faces in the Top viewport

Figure 4-65  Various rollouts to 
create a tri patch
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Figure 4-66  The tri patch

Figure 4-67  The tri patch with triangular faces in 
the Top viewport

Figure 4-68  The nature scene
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Figure 4-69  The floor after using the Zoom and Orbit tools 

Figure 4-70  The railing01 displayed in viewports 
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Figure 4-71  The railing01 geometry in viewports after aligning it in the Top viewport

Figure 4-72  The railing02 geometry in viewports after alignment
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Figure 4-73  The railing03 geometry after alignment

Figure 4-74  The railing03 geometry rotated in the Top viewport



4-22				                Autodesk 3ds Max 2014: A Comprehensive Guide

Figure 4-75  The railing04 geometry aligned in viewports

Figure 4-76  The railings geometry displayed in viewports
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Figure 4-77  Alignment of tree01 in viewports 

Figure 4-78  Multiple copies of tree01 created and aligned in viewports
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Figure 4-79  The final output at rendering

			    	   (Expected time: 30 min) 

Figure 4-80  The room model

 

Figure 4-81  The floor geometry in the Perspective viewport
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Figure 4-82  The railing01 geometry in viewports after alignment

Figure 4-83  The railings geometry displayed in viewports 
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Figure 4-84  The wall geometry displayed in viewports 

Figure 4-85  The roof geometry of wall in viewports after alignment
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Figure 4-86  The roof fencing geometry after scaling in the Front viewport 

 

Figure 4-87  The fc01 geometry in the 
Top viewport after alignment
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Figure 4-88  The fc002 geometry in the Top 
viewport after alignment

Figure 4-89  The fencing geometry at the four corners of wall in viewports
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Figure 4-90  The window geometry in viewports after alignment

Figure 4-91  The foot support geometry in viewports after the alignment
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Figure 4-92  The door geometry in viewports after alignment

Figure 4-93  The tree01 geometry displayed in viewports after alignment
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Figure 4-94  The tree02 geometry in viewports after the alignment

Figure 4-95  The final output of the scene at rendering
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Figure 4-96  The model of Exercise 1 



Splines and 
Extended Splines
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Figure 5-1  The torus created without 
selecting the AutoGrid check box 

Figure 5-2  The torus created after 
selecting the AutoGrid check box 

Figure 5-3  Various rollouts displayed to create 
and modify a line spline

Figure 5-4  An open line spline 
created

Figure 5-6  The line spline 
closed

Figure 5-5  The Spline dialog box
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Figure 5-7  A line with corner vertices Figure 5-8  A line spline with 
bezier vertex and smooth curve

Figure 5-9 The Rendering 
rollout

Figure 5-10  The Interpolation 
rollout
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Figure 5-11  The Keyboard 
Entry rollout

Figure 5-12  Various rollouts to 
create and modify a rectangular 
spline

 

Figure 5-13  A rectangular spline Figure 5-14  A square spline
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Figure 5-15  A rectangle 
with corner radius

Figure 5-16  Various rollouts to 
create and modify a circular spline

Figure 5-17  A circular spline 
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Figure 5-19  An elliptical splineFigure 5-18  Various rollouts to create 
and modify an elliptical spline



Splines and Extended Splines		         5-7

Figure 5-23  An arc splineFigure 5-20  Various rollouts to create 
and modify an arc spline

Figure 5-21  Creating an arc using the 
End-End-Middle method (step-1)

Figure 5-22  Creating an arc using the 
End-End-Middle method (step-2)

Figure 5-25  Creating an arc using 
the Center-End-End method (step-2)

Figure 5-24  Creating an arc using 
the Center-End-End method (step-1)
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Figure 5-26  The arcs created on using the Pie Slice check box

Figure 5-27  Various rollouts to create 
and modify the donut spline 

Figure 5-28  A donut spline
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Figure 5-29  Various 
rollouts to create and 
modify an NGon spline

Figure 5-30  An NGon spline Figure 5-31  The NGons with 3, 
6, and 8 number of sides
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Figure 5-32  The NGon with round corners Figure 5-33  An NGon after selecting the 
Inscribed radio button	

Figure 5-34  An NGon after selecting the 
Circumscribed radio button

Figure 5-37  The star splines with different 
number of points 

Figure 5-35  Various rollouts to create 
and modify a star spline

Figure 5-36  A star spline
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Figure 5-38  A star after setting the 
value in the Distortion spinner 

Figure 5-39  A star after setting the 
values in the Fillet Radius 1 and Fillet 
Radius 2 spinner

Figure 5-40  Various 
rollouts to create and 
modify a text spline
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Figure 5-42  Various align buttons to align the textFigure 5-41  The text in the viewports

Figure 5-44  A helix spline

Figure 5-43  Various rollouts to create 
and modify a helix spline

Figure 5-45  The helix spline with three 
turns and zero value in the Bias spinner

Figure 5-46  The helix spline with three 
turns and +1 value in the Bias spinner

Figure 5-47  The helix spline with three 
turns and -1 value in the Bias spinner
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Figure 5-48  Various 
rollouts to create and 
modify a section spline

Figure 5-50  The cross-section of the section 
spline according to the object

Figure 5-49  A section spline
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Figure 5-52  The cross-sections generated in 
both the objects in their planes on selecting the 
Infinite radio button 

Figure 5-51  The Name Section 
Shape dialog box

Figure 5-54  An egg splineFigure 5-53  Various rollouts to 
create and modify an egg spline
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Figure 5-55  Various 
rollouts to create and 
modify a WRectangle 
spline 

 

Figure 5-56  A WRectangle spline Figure 5-57  The WRectangle 
spline with corner radius
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Figure 5-58  Various 
rollouts to create and 
modify a channel 
spline

Figure 5-60  The channel spline 
with corner radius

Figure 5-59  A channel spline
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Figure 5-61  Various 
rollouts to create and 
modify an angle spline

Figure  5-62  An angle spline

Figure 5-63  The angle spline with 
corner radius

Figure 5-64  An angle spline with 
edge radii
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Figure 5-65  Various 
rollouts to create and
modify a tee spline

Figure 5-66  A T-shaped tee spline Figure 5-67  A tee spline 
with corner radius
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Figure 5-68  Various rollouts 
to create and modify a wide 
flange spline

Figure 5-69  An I-shaped wide flange 
spline

Figure 5-70  The wide flange 
spline with corner radius
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Figure 5-71  The Christmas tree model

Figure 5-72  The Christmas tree displayed in viewports
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Figure 5-73  The Christmas tree displayed in the Perspective viewport

                 

Figure 5-74  Alignment of outer spiral ring in viewports
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Figure 5-75  The Star A01 geometry displayed in viewports after the alignment

Figure 5-76  The Star A002 and Star A003 geometry displayed after the alignment
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Figure 5-77  Alignment of Star B01 in viewports

Figure 5-78   Alignment of Star B002, Star B003, and Star B004 in viewports
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Figure 5-79  Alignment of Star C01 in viewports

Figure 5-80  Alignment of spiral coil01 in viewports 
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Figure 5-81  Alignment of spiral coil002 and spiral coil003 in viewports

Figure 5-82  The balloon01 geometry 
in the Front viewport

Figure 5-83  The balloon01 geometry in 
the Front viewport after scaling
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Figure 5-84  Alignment of balloon01 in viewports

Figure 5-85  Alignment of balloon002 and balloon003 in viewports 
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Figure 5-86  Alignment of ring01 in viewports

	
	

Figure 5-87  Alignment of ring002 and ring003 in viewports
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Figure 5-88  The final output after rendering

				                             

Figure 5-89  The model of a book

Figure 5-90  The book geometry after invoking the Zoom Extents All tool
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Figure 5-91  Alignment of spiral binding with book in viewports

Figure 5-92  Alignment of text01 on book in viewports
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Figure 5-93  Alignment of rectangular design in viewports 

Figure 5-94  The final output 
after rendering 

Figure 5-95  The model of a grid
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Figure 5-96  The model of a photo frame

Figure 5-97  The model of an entrance



Modifying Splines 
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Figure 6-1  The Pivot tab 
chosen in the Hierarchy 
tab

Figure 6-2  The pivot point of a circle

Figure 6-3  The working pivot along with 
the gizmo in the scene 



Modifying Splines		         6-3

Figure 6-4  The move transform 
gizmo displayed 

Figure 6-5  The rotate transform 
gizmo displayed 

Figure 6-6  An arc displayed in the 
Front viewport

Figure 6-7  The arc converted into a 3D object 
after applying the Lathe modifier

Figure 6-9  The vertices of an arc spline displayed 
after selecting the Vertex sub-object level 

Figure 6-8  The sub-object 
levels and rollouts displayed 
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Figure 6-10  Various types of vertices highlighted in a quad menu

Figure 6-11  Various types of vertices in a line spline

Figure 6-12  The curved segment selected in 
an arc spline

Figure 6-13  The line segment selected in a 
rectangular spline
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Figure 6-14  The spline selected in an arc 

              

Figure 6-16  The vertex numbers displayed on 
selecting the Show Vertex Numbers check box

Figure 6-15  The Selection rollout
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Figure 6-17  Partial view 
of the Geometry rollout

Figure 6-18  The cursor displayed in the viewport 
on choosing the Create Line button

Figure 6-19  The cursor displayed after 
choosing the Insert button
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Figure 6-20  The new vertices and the segment created 
using the Refine button and the Connect check box

Figure 6-23  The cursor over another end 
vertex and the dotted line displayed

Figure 6-24  The end vertices 
connected with a segment

Figure 6-21  The end vertices in an arc spline Figure 6-22  The cursor over one of 
the end vertices 

Figure 6-26  The selected vertices fused at 
their average center

Figure 6-25  The selected vertices inside the 
rectangular area
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Figure 6-28  The changed shape of cursor 
displayed after moving the cursor over the 
selected vertex

Figure 6-27  The selected vertex in a star spline 

Figure 6-29  The two new vertices and the round corner displayed 

Figure 6-30  The new vertices with a beveled corner

Figure 6-31  A segment selected in the 
circle spline 

Figure 6-32  The selected segment sub-divided 
after using the Divide button   
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Figure 6-33  A segment sub-object 
selected in the circle spline

Figure 6-35  The detached segment as a new independent shape 

Figure 6-34  The Detach dialog box

Figure 6-36  The spline selected in a circle Figure 6-37  The reversed direction of the selected 
spline after choosing the Reverse button

Figure 6-38  The shape of the cursor 
changed after choosing the Outline 
button 

Figure 6-39  A copy of the spline created as 
an outline of the selected spline
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Figure 6-40  An open arc spline Figure 6-41  The closed spline after using 
the Outline button on the open spline 

Figure 6-44  The subtraction boolean 
final output

Figure 6-45  The intersection boolean 
final output 

Figure 6-43  The union boolean 
final output

Figure 6-42  The two attached splines 
overlapping each other

          

Figure 6-46  The angle extended 
spline created to mirror

Figure 6-47  The spline 
mirrored horizontally

Figure 6-48  The spline 
mirrored vertically

Figure 6-49  The spline mirrored horizontally 
after selecting the Copy check box 

Figure 6-50  The spline mirrored on both 
the sides after selecting the Copy check box
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Figure 6-51  The spline mirrored vertically after selecting the Copy check box

Figure 6-52  The two attached splines and 
the cursor over the overlapping segments  

Figure 6-53  The splines after 
using the Trim button

Figure 6-55  One of the broken splines 
selected after using the Explode button  

Figure 6-54  The rectangular spline for explosion

  

Figure 6-56  The Explode dialog box
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Figure 6-57  The glass models

Figure 6-58  The line spline created for glass 
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Figure 6-59  The pivot point of the line spline 
at its original position 

Figure 6-60  The pivot point after adjusting 
its position in the Front viewport
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Figure 6-61  The first vertex selected in the line spline
  

	

Figure 6-62  The glass geometry displayed in viewports after 
applying the Lathe modifier 
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Figure 6-63  A pair of glasses in viewports
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Figure 6-64  Partial view of the Material Editor 
dialog box
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Figure 6-65  The glass models in the final output after rendering 

Figure 6-66  The model of a vase with 
flower plants in it
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Figure 6-67  A line spline created for the vase Figure 6-68  The first vertex of the line 
spline selected in the Front viewport 

Figure 6-69  The vase geometry after applying the Lathe modifier 
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Figure 6-70  Alignment of plant with vase in viewports

	

Figure 6-71  Alignment of the circles in viewports
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Figure 6-72  The line splines created to join both the circles

Figure 6-73  The line spline for leg of stand
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Figure 6-74  Alignment of upper portion and leg01 in viewports

Figure 6-75  Alignment of leg01, leg002, leg003, and leg004 in viewports
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Figure 6-76  Alignment of flower vase and vase stand in viewports

							                      
	

Figure 6-77  The pair of cocktail glasses
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Figure 6-78  Set of vases

Figure 6-79  A candle stand
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Figure 6-80  The pair of glasses



Materials and Maps
 Learning Objectives
After completing this chapter, you will be able to:
• Use the Material Editor dialog box
• Understand the types of materials and maps
• Create materials and maps
• Assign materials to objects
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Introduction
In this chapter, you will learn to assign various materials and maps to the objects in a scene 
to make it more realistic. Materials are used to describe the reflection or transmission of light 
of an object. Maps are used to simulate texture, and apply designs, reflection, refraction, and 
other effects. To assign materials and maps, you need to use the Material Editor tool from 
the Main Toolbar, which is discussed next.
  

Material Editor
  Menu bar:	 Rendering > Material Editor > Compact/Slate Material Editor	  
  Main Toolbar:	Material Editor flyout > Compact/Slate Material Editor		   
  Keyboard:	 M								      

 In 3ds Max, there are two types of material editors, Slate Material Editor and Compact 
Material Editor. You can use any of these material editors to create new materials and 
maps, modify the existing materials, apply these new materials and maps to the models 

in the scene, and create a new environment for the scene. The Slate Material Editor uses nodes 
and wiring to graphically display the design of the materials created by you. The Compact 
Material Editor is easy and stripped down version of Slate Material Editor.  

To create a new material, press the M key; the Slate Material Editor dialog box will be 
displayed, as shown in Figure 7-1. Next, if you choose Modes > Compact Material Editor 
from the material editor menu bar, the Material Editor dialog box will be displayed, as shown 
in Figure 7-2. The title bar of the Material Editor dialog box displays the number and name 
of the current material, which gets changed depending on the material that you select. The 
Material Editor dialog box is divided into various areas, refer to Figure 7-2. These areas are 
discussed next.

   

Figure 7-1  The Slate Material Editor dialog box
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Figure 7-2  The Material Editor dialog box

Note
When you press the M key, the material editor that you opened last in 3ds Max will be displayed. 
However, if you press the M key for the first time in 3ds Max, then the Slate Material Editor 
will be displayed.    

Menu Bar
The menu bar is located at the top of the Material Editor dialog box. It consists of various 
pull-down menus such as Material, Navigation, and so on. The options in these pull-down 
menus are used to choose various tools. These tools can also be invoked using the options 
available below as well as on the right side of the sample slots in the Material Editor dialog 
box, refer to Figure 7-2.

Sample Slots 
The sample slots in the Material Editor dialog box are used to preview the material or the 
maps that are assigned to the objects in the viewport. By default, there are 6 slots which can be 
extended to 24 slots and each sample slot represents a single material or map. To view other 
sample slots, move the scroll bar available on the right, and just below the sample slots. You 
can also increase the number of visible sample slots. To do so, select one of the sample slots; 



7-4	   			               Autodesk 3ds Max 2014: A Comprehensive Guide

it will be surrounded by a white colored boundary and will get activated. Next, right-click on 
the active sample slot; a shortcut menu will be displayed, as shown in Figure 7-3. By default, 
the 3x2 Sample Windows option is chosen in the shortcut menu. Next, choose the required 
option; the number of visible sample slots will be increased accordingly, refer to Figures 7-4 
and 7-5. 

Figure 7-4  The sample slots 
after choosing the 5x3 Sample 
Windows option

Figure 7-5  The sample slots after 
choosing the 6x4 Sample Windows 
option 

Figure 7-3  The shortcut 
menu displayed

In the shortcut menu, the Drag/Copy option is chosen by default. It is used to copy the material 
or the map from one sample slot to another. Select the sample slot, whose material or map 
you want to copy. Next, press and hold the left mouse button on it, drag it to another sample 
slot, and then release the left mouse button; the same material or the map will be copied to 
the other sample slot, as shown in Figures 7-6 and 7-7.  

Figure 7-6  Two sample slots in the 
Material Editor dialog box 

Figure 7-7  The map/material of one 
sample slot copied to the other

  

On choosing the Drag/Rotate option in the shortcut menu, the shape

Figure 7-8  The sample 
slot displayed in a separate 
window 

 
of the cursor will change. Now, you can view the material map on 
the sample slot by rotating it. The Reset Rotation option in the 
shortcut menu is used to reset the sample slot to its default 
orientation. By default, the Render Map option in the shortcut menu 
is not activated. It will be activated on assigning a map to the sample 
slot. This option is used to render the map in the selected sample 
slot by creating a bitmap or an avi file (if the map is animated). When 
you choose the Options option, the Material Editor Options dialog 
box will be displayed. The options in this dialog box are used to 
modify the sample slots.

Choose the Magnify option; the selected sample slot will be displayed 
in an enlarged window, as shown in Figure 7-8. Alternatively, 
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double-click on the selected sample slot to display it in an enlarged window. To resize the 
window, move the shape of the cursor at the bottom of the window; the cursor will change to 
an arrow. Now, drag the cursor to resize the window.  

Material Editor Tools
The material editor tools are used to modify the default settings of the selected sample slot, 
and apply the materials or the maps to the objects. These tools are available below as well as 
on the right side of the sample slots in the Material Editor dialog box. The most commonly 
used tools are discussed next.

Get Material
  Material Editor Menu:  Material > Get Material	 
  Material Toolbar:	   Get Material		   
  Keyboard:	  	   G			 

The Get Material tool is used to get a material or a map for the selected sample slot. 
Materials affect the color, opacity, glossiness, and other physical properties of 
objects. 

To get a material, select one of the sample slots to activate it. Choose the Get Material tool 
available below the sample slots; the Material/Map Browser dialog box with a list of materials 
and maps will be displayed, as shown in Figure 7-9. You can collapse and expand this list as 
required. Now, double-click on one of the materials or maps from the list; the default material 
will be replaced by the new material or map. Also, the new material will be displayed on 
the sample slot in the Sample Slots rollout of the Material/Map Browser dialog box. The 
Material/Map Browser dialog box is discussed next.  

Note
The shortcut key G mentioned above will work only if the Keyboard Shortcut Override Toggle 
tool in the Main Toolbar is activated and the Material Editor dialog box is displayed.   

Material/Map Browser
The Material/Map Browser dialog box is used to select different types of materials 
and maps from the lists displayed in it. Various options in this dialog box are discussed 
next. 

Search by Name: The Search by Name text box is located on the top of this dialog  
box. It is used to search and select the name of the materials or the maps. For 
example, enter the alphabet d in this text box; a drop-down list of all the materials 
and maps starting with the alphabet d will be displayed, as shown in Figure 7-10. You can 
double-click on the required material or map; it will be displayed on the selected sample 
slot. Now, choose the Clear Results button on the right side of the text box; the drop-down 
list will be cleared. 

Material/Map Browser Options: The Material/Map Browser Options button is located 
on the left of the Search by Name text box. Choose the Material/Map Browser Options 
button; a flyout with various options will be displayed, as shown in Figure 7-11. The 
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options in this flyout are used to manage the Material/Map Browser dialog box based on 
the requirement. Also, these options will help you to create new material library, manage 
Autodesk material library, and so on. These options are discussed next.

Figure 7-9  Partial view of the rollouts in the Material/Map Browser 
dialog box

The New Group option is used to create a new group and add it to the Material/Map 
Browser dialog box. Choose the New Group option from the flyout; the Create New 
Group dialog box will be displayed, as shown in Figure 7-12. Type a name of your choice 
in the text box and then choose the OK button; a new group with the specified name will 
be displayed in the Material/Map Browser dialog box. You can expand and collapse the 
group as required.  

When you install 3ds Max, the material libraries will automatically get installed in your 
system in the .mat format. To select the material library of your choice, choose the 
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Open Material Library option from the shortcut menu; the Import Material Library 
dialog box will be displayed. Navigate to the location C:\Program Files\Autodesk\3ds Max 
2014\materiallibraries; the material libraries will be displayed in the Import Material Library 
dialog box, as shown in Figure 7-13. Next, select the required material and choose the 
Open button; all materials of the selected material library will be displayed in the Material/
Map Browser dialog box, as shown in Figure 7-14.

Figure 7-10  The drop-down list displayed after entering the alphabet 
d in the text box

You can also create a new library to put all materials and maps defined in the sample 
slots of the current file. To create a new library, choose the New Material Library option 
from the shortcut menu; the Create New Material Library dialog box will be displayed, 
as shown in Figure 7-15. Type a name in the text box and choose the OK button; a new 
library with the specified name will be displayed in the Material/Map Browser dialog box. 
You can expand and collapse this dialog box, as per your requirement. Next, you can put 
the materials defined in the sample slots to the new library using the Put To Library tool 
in the Material Editor dialog box.    
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Figure 7-11  The flyout displayed after choosing the 
Material/Map Browser Options button 

Figure 7-12  The Create New Group 
dialog box

Figure 7-13  The Import Material Library dialog box

When you create a new material library using the New Material Library option, the newly 
created library will have a default name and location assigned to it. To modify the name 
and location, right-click on the title bar of the new library in the Material/Map Browser 
dialog box; a shortcut menu will be displayed, as shown in Figure 7-16. Now, choose the 
Save As option from the shortcut menu; the Export Material Library dialog box will be 
displayed. Next, navigate to the location where you want to save the new library. Also, type 
a new name in the File name text box and make sure that the Material Libraries (*.mat) 
option is selected in the Save as type drop-down list. Now, choose the Save button; the 
new library will be saved at the specified location. You can use the newly created library 
in another scene. 
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There are various rollouts such as Materials, Maps, Scene Materials, and Sample Slots 
in the Material/Map Browser dialog box. You can toggle the display of these groups by 
choosing the respective option from the shortcut menu. 

You can also reset the Material/Map Browser dialog box to its default appearance. Choose 
the Additional Options option from the shortcut menu; a cascading menu will be displayed. 
Now, choose the Reset Material/Map Browser option; the Reset Material/Map Browser 
message box will be displayed. Choose the Yes button in this message box; the Material/
Map Browser dialog box will be reset to its default appearance.

Note
In 3ds Max 2014, when you right-click on a material or map in the Material/Map Browser 
dialog box, a shortcut menu will be displayed. On choosing the Copy to option from this shortcut 
menu, a cascading menu will be displayed. You can copy the material or map to an existing 
material library or to a new material library using the options available in this cascading 
menu.

Figure 7-14  The materials displayed in the 
Material/Map Browser dialog box Figure 7-16  The shortcut menu displayed 

Figure 7-15  The Create New Material Library 
dialog box
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Assign Material to Selection
  Material Editor Menu:	  Material > Assign to Selection 	  
  Toolbar:	 	   Assign Material to Selection	

The Assign Material to Selection tool is used to assign the material

Figure 7-17  The 
triangles displayed 
on a sample slot 

 
or map from the active sample slot to the selected object in the 
viewport. On choosing the Assign Material to Selection tool, the 

active sample slot will be surrounded by four triangles at corners, as shown 
in Figure 7-17. 

For assigning a material to the selected object in the viewport, select the 
sample slot and then select the object on which you need to assign the 
material in the viewport. Next, choose the Assign Material to Selection 
button in the Material Editor dialog box to assign the material to the 
selected object in the scene. You can also select more than one object to assign the same material 
to all of them. Alternatively, you can drag the material from the sample slot to the selected 
objects in the viewport to assign materials to them. You need to choose the Show Shaded 
Material in Viewport tool in the Material Editor dialog box to view the assigned material in 
the viewport. You will learn more about this tool later in the chapter. 

Reset Map/Mtl to Default Settings
  Toolbar:	 Reset Map/Mtl to Default Settings	

The Reset Map/Mtl to Default Settings tool is used to reset the values that were 
assigned to the map or material in the active sample slot using various rollouts displayed 
in the Material Editor dialog box.

        
Put to Library
  Material Editor Menu:  Material > Put to Library	  
  Toolbar:	 	   Put to Library			 

The Put to Library tool is used to add the selected material to the temporary library 
or the library created. To do so, select the sample slot that has the material that you 
want to add to the library. Next, choose the Put to Library tool; the Put to Library 

dialog box will be displayed, as shown in Figure 7-18. In the Name text box, enter a new name 
for the material and then choose the OK button; the material will be saved in the temporary 
library. 

If you are in the sub-level of the material and you invoke the Put to Library tool, the Material 
Editor message box will be displayed, as shown in Figure 7-19. In this message box, you will 
be prompted to specify if you want to put the entire material/map tree to the library. Choose 
the Yes option from the message box; the Put to Library dialog box will be displayed. As 
described earlier, in the Name text box, enter a new name of the material and choose the OK 
button; the material will be saved in the temporary library. Also, the material will be displayed 
in the Temporary Library rollout of the Material/Map Browser dialog box.
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Figure 7-18  The Put to Library dialog box 

Figure 7-19  The Material Editor message box 

Show Shaded Material in Viewport	
  Toolbar:	 Show Shaded Material in Viewport	

The Show Shaded Material in Viewport tool is used to display the material or map 
assigned to the selected object in the viewport. To do so, select the object in the viewport 
and assign a material to it and then choose the Show Shaded Material in Viewport 

tool; the material will be displayed on the selected object in the viewport.

Go to Parent
  Material Editor Menu:   Navigation > Go to Parent 	  
  Toolbar:	 	    Go to Parent			    
  Keyboard:	 	    Up Arrow key			 

The Go to Parent tool is used to go one level up in the current material.  

Go Forward to Sibling
  Material Editor Menu:	  Navigation > Go Forward to Sibling 	  
  Toolbar:	 	   Go Forward to Sibling			    
  Keyboard:	  	   Right Arrow key				 

The Go Forward to Sibling tool is used to go to the next map or material at the same 
level for the current material. This tool is active in compound materials such as 
Composite material, Blend material, and so on. These materials are discussed later in 
the chapter. 
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Sample Type
  Toolbar:	 Sample Type   

On invoking the Sample Type tool, a flyout will be displayed. This flyout consists of 
three options: sphere, cylinder, and cube. These options are used to choose the 
geometry type to be displayed in the active sample slot. By default, the material will 
be displayed on a spherical sample slot.   

Backlight
  Material Editor Menu:  Options > Backlight 	  
  Toolbar:	  	   Backlight		   
  Keyboard:		    L			 

The Backlight tool is invoked by default. It is used to add the backside light to the 
active sample slot, refer to Figures 7-20 and 7-21. 

Figure 7-20  The effect of the 
Backlight tool in the sample slot

Figure 7-21  The sample slot without 
the backlight effect

Background		
  Material Editor Menu:	  Options > Background 	 
  Toolbar:	  	   Background		   
  Keyboard:	  	   B			 

The Background tool is used to add a multicolored background to the active sample 
slot, refer to Figures 7-22 and 7-23. 

Figure 7-22  The sample slot with 
the Background tool invoked

Figure 7-23  The sample slot without 
invoking the Background tool
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Sample UV Tiling
  Toolbar:	 Sample UV Tiling	 

On invoking the Sample UV Tiling tool, a flyout will be displayed. This flyout has 
four options: 1x1, 2x2, 3x3, and 4x4. On selecting any of these tiling patterns, the 
object in the viewport will not be affected. The selected tiling pattern will be displayed 
only in the active sample slot, refer to Figures 7-24, 7-25, and 7-26.

Figure 7-24  The 1x1 sample UV 
tiling in a cube sample slot

Figure 7-25  The 2x2 sample 
UV tiling in a cube sample slot

Figure 7-26  The 3x3 sample 
UV tiling in a cube sample slot

Pick Material From Object       
The Pick Material From Object tool is used to pick the material from the object in 
the viewport and apply it to the active sample slot. To do so, select the sample slot to 
activate it and choose the Pick Material From Object tool; the shape of the cursor 

will be changed to the shape of an eye dropper. Now, move the cursor over the object in the 
viewport from which you want to pick the material and click on it; the selected sample slot 
will display the same material. 

You can change the name of the material of each sample slot by entering a new name in 
the Material Name drop-down list on the right of the Pick Material From Object tool. The 
Material Type button on the right of the Material Name drop-down list displays the name of the 
material that is selected from the Material/Map Browser dialog box, refer to Figure 7-27.

Figure 7-27  The Material Name drop-down 
list and the Material Type button

Materials 
In this section, you will learn about the Material Editor tool that helps you to create materials 
and assign them to the objects to make them more realistic. The materials assigned to the 
objects give the best results with lights, about which you will learn in the later chapters. In 
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3ds Max, you can create and assign various materials to the objects using the Material Editor 
tool in the Main Toolbar. 

Choose the Material Editor tool from the Main Toolbar; the Material Editor dialog box will 
be displayed. Now, choose the Material Type button on the right side of the Material Name 
drop-down list, refer to Figure 7-27; the Material/Map Browser dialog box will be displayed. 
Next, expand the Materials > Standard rollout, if it is not already expanded; a list of 16 
types of materials will be displayed. In this list, there are some materials that can combine 
other materials in them. These are known as Compound materials. The Compound materials 
in this list are Blend, Composite, Double-Sided, Morpher, Multi/Sub-Object, Shellac, and 
Top/Bottom. Select the material as per your requirement from the list and then choose the 
OK button; the name of the selected material will be displayed on the Material Type button 
in the Material Editor dialog box. Also, the rollouts related to that material will be displayed 
in the Material Editor dialog box. The material can be modified by using the parameters 
available in these rollouts. The most commonly used materials are discussed next.

Note
You can also get the default materials using the Get Material tool in the Material Editor 
dialog box, as discussed earlier in this chapter.

Standard Material
By default, the Standard material is selected in the Material Editor dialog box. Various 
rollouts are also displayed below the Material Type button to create new materials or modify the 
properties of the current material. The most commonly used rollouts are discussed next.

Shader Basic Parameters Rollout
The options in this rollout are used to specify the shading types and other properties for the 
material, refer to Figure 7-28. Select the Wire check box in this rollout to render the material 
as wireframe, as shown in Figure 7-29. Select the 2-Sided check box to apply the material 
to both sides of the selected faces on rendering. Select the Face Map check box to apply the 
maps or images to each face of the object, as shown in Figure 7-30. Select the Faceted check 
box to create a faceted object, as shown in Figure 7-31. In this case, each face of the surface 
will be rendered as flat face.

Note
1. To view the effect of the selection of the Face Map or Faceted check box on an object, you 
need to assign an image or a map to the object. You will learn more about assigning an image 
or a map to the object later in this chapter. 
	
2. You can see the effect of the selection of the Faceted check box only after rendering.  
	  

There are eight types of shaders in the drop-down list located on the top of this rollout, refer 
to Figure 7-28. These shaders provide different effects to the material after rendering. By 
default, the Blinn shader is selected in this drop-down list. Various shaders and their rollouts 
are discussed next.
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Figure 7-29  The sphere  
geometry with the Wire 
check box selected

Figure 7-31  The sphere 
geometry with the Faceted 
check box selected

Figure 7-30  The sphere 
geometry with the Face 
Map check box selected

Figure 7-28 The Shader Basic Parameters rollout 
with eight shaders displayed in the drop-down list

Anisotropic Shader
The Anisotropic shader is used to create elliptical highlights, refer to Figure 7-32. This 
shader is suitable for creating glasses, brushed metals, grass, and so on. To assign this 
shader to the material, select the Anisotropic option from the drop-down list in the Shader 
Basic Parameters rollout. On doing so, the Anisotropic Basic Parameters rollout will 
be displayed below the Shader Basic Parameters rollout, as shown in Figure 7-33. This 
rollout is discussed next. 

Figure 7-32  The sphere geometry 
with Anisotropic shader 

Figure 7-33  The Anisotropic Basic 
Parameters rollout
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Note
To view the effects of shaders, you need to set the parameters in the Basic Parameters rollout 
of the corresponding shader.    

     
Anisotropic Basic Parameters Rollout: The options in the Anisotropic Basic Parameters 
rollout are used to set the colors, transparency, shine, and so on of the material. 

The Ambient, Diffuse, and Specular color swatches are used to set the colors of the 
material. The Ambient color swatch is used to specify the color of an object in shadow. 
The Diffuse color swatch is used to specify the color of an object in direct light. It is the 
primary color of the material. The Specular color swatch is used to specify the color of 
the highlighted or the shiny part of the material, refer to Figure 7-34. 

Figure 7-34  The ambient, diffuse, and 
specular colors in a sphere

To set the color of the material, select one of the color swatches; the Color Selector 
dialog box will be displayed along with the name of the color swatch that you have selected. 
Select a color and choose the OK button; the selected color will be displayed in the color 
swatch and the active sample slot.         

Self-Illumination Area: The options in the Self-Illumination area are used to create 
incandescence effect by replacing shadows on the surface with color specified using the 
Diffuse color swatch. It creates an illusion of light being generated from the material. 
The value of the spinner in the Self-Illumination area specifies the percentage of shadow 
replaced with the color. To set the illumination of the object, select the Color check box in 
this area; the spinner on its right will be replaced by a color swatch. You can change the 
intensity as well as the color for the self-illumination using the color swatch. Choose the 
color swatch in the Self-Illumination area; the Color Selector: Self Illum Color dialog 
box will be displayed. As you increase the value in the Value spinner, the intensity of the 
incandescence effect also increases, refer to Figures 7-35 and 7-36.

Figure 7-35  A sphere 
geometry without 
self-illumination

Figure 7-36  A sphere geometry 
with self-illumination
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The value in the Opacity spinner is used to control the transparency of the material. By 
default, the value in the spinner is 100, which makes a material opaque. As you decrease 
the value, the transparency will increase, refer to Figure 7-37. 

Figure 7-37  A teapot geometry within a transparent box 

The value in the Diffuse Lev spinner is used to control the brightness of the diffuse color in 
the material, refer to Figures 7-38 and 7-39. By default, the value in this spinner is 100.

Figure 7-39  The torus knot geometry 
with the value 150 in the Diffuse 
Lev spinner

Figure 7-38  The torus knot geometry 
with the default value in the Diffuse 
Lev spinner

Specular Highlight Area: The options in the Specular Highlight area are used to set 
the shape, appearance, strength, and orientation of the specular highlight or the shiny 
part of the material.

The value in the Specular Level spinner is used to set the brightness or intensity of the 
specular highlight of the material. As you increase the value in the spinner, the brightness 
of the specular highlight will also increase, refer to Figures 7-40 and 7-41.

Figure 7-40  The sphere geometry 
with the value 0 in the Specular 
Level spinner

Figure 7-41  The sphere geometry 
with the value 66 in the Specular 
Level spinner
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The value in the Glossiness spinner is used to set the size of the specular highlight of 
the material. However, if you increase the value in the Glossiness spinner, the size of the 
specular highlight will decrease, refer to Figures 7-42 and 7-43.  

Figure 7-42  The sphere geometry 
with less value in the Glossiness 
spinner

Figure 7-43  The sphere geometry 
with more value in the Glossiness 
spinner

 

The value in the Anisotropy spinner is used to set the shape of the specular highlight of 
the material. As you increase the value in the Anisotropy spinner, the shape of the specular 
highlight will reduce, refer to Figures 7-44 and 7-45. 

Figure 7-44  The teapot  geometry with 
less value in the Anisotropy spinner 

Figure 7-45 The teapot geometry with 
more value in the Anisotropy spinner 

The value in the Orientation spinner is used to change the orientation of the specular 
highlight of the material in degrees. By default, its value is 0. By changing the value in 
the Orientation spinner, you can change the orientation of the specular highlight of the 
material, as shown in Figures 7-46 and 7-47.

Figure 7-47  The teapot 
geometry with the value 45 in 
the Orientation spinner 

Figure 7-46  The teapot geometry 
with the value 0 in the Orientation 
spinner 
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Note
In the Specular Highlight area, there is a graph on the right that graphically represents the 
changes in all spinners.    

Blinn Shader
The Blinn shader is used to create round and soft highlights, as shown in Figure 7-48. 
To assign this shader to the material, select the Blinn option from the drop-down list 
available in the Shader Basic Parameters rollout; the Blinn Basic Parameters rollout will 
be displayed below the Shader Basic Parameters rollout. This rollout is discussed next.

Blinn Basic Parameters Rollout: The Ambient, Diffuse, and Specular color swatches, 
the Self-Illumination area, and the Opacity spinner in this rollout are the same as those 
discussed in the Anisotropic Basic Parameters rollout. 

In the Specular Highlights area, the Specular Level and Glossiness spinners are the 
same as those discussed in the Anisotropic Shader. The value in the Soften spinner is 
used to soften the effect of the specular highlight. By default, its value is 0.1.

Figure 7-48  The sphere geometry with the Blinn shader

Metal Shader
The Metal shader is used to give a metallic effect to objects, as shown in Figure 7-49. 
To assign this shader to the material, select the Metal shader from the drop-down list 
available in the Shader Basic Parameters rollout; the Metal Basic Parameters rollout will 
be displayed below the Shader Basic Parameters rollout. This rollout is discussed next.

Figure 7-49  The teapot geometry with the Metal shader

Metal Basic Parameters Rollout: The options in this rollout are the same as discussed in 
the Anisotropic Basic Parameters rollout. 
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Multi-Layer Shader
The Multi-Layer shader is similar to the Anisotropic shader with the only difference that 
the Multi-Layer shader has two specular highlight controls. To assign this shader to the 
material, select the Multi-Layer shader from the drop-down list available in the Shader 
Basic Parameters rollout; the Multi-Layer Basic Parameters rollout will be displayed. 
This rollout is discussed next.

Multi-Layer Basic Parameters Rollout: In the Multi-Layer Basic Parameters rollout, 
the Ambient and Diffuse color swatches are same as those discussed in the Anisotropic 
Basic Parameters rollout. Also, the Self-Illumination area, the Opacity spinner, and the 
Diffuse Level spinner are same as those discussed in the Anisotropic Basic Parameters 
rollout. 

The Roughness spinner is used to set the transition from diffuse color to the ambient 
color. By default, its value is 0 and it ranges from 0 to 100. When you increase the value in 
the Roughness spinner, the material becomes less shiny, refer to Figures 7-50 and 7-51.

Figure 7-50  The teapot with less 
value in the Roughness spinner

Figure 7-51  The teapot with more 
value in the Roughness spinner

In the Multi-Layer Basic Parameters rollout, there are two specular highlight areas, First 
Specular Layer and Second Specular Layer. You can use both highlights independently 
to produce complex and blend shadings in the material. The options in the First Specular 
Layer and the Second Specular Layer areas are same. However, you can use different 
settings to produce the blend shadings in the material, as shown in Figure 7-52. These 
options are discussed next.  

Figure 7-52  The teapot with the 
Multi-Layer shader

Choose the Color color swatch to change the specular color of the first and the second 
highlights in the respective areas. The Level spinner is used to set the brightness or the 
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intensity of the specular highlight of the material. By default, its value is 0. As you increase 
the value in the spinner, the brightness of the specular highlight will also increase. The 
Glossiness, Anisotropy, and Orientation options are the same as those discussed in the 
Anisotropic shader.  
      
Oren-Nayar-Blinn Shader
The Oren-Nayar-Blinn shader is a variant of the Blinn 

Figure 7-53  The teapot geometry 
with the Oren-Nayer-Blinn shader

shader and is used to create dull or matte highlights, 
as shown in Figure 7-53. This shader can be used for 
rubber, clay, clothes, and so on. To assign this shader 
to the material, select the Oren-Nayar-Blinn shader 
from the drop-down list available in the Shader Basic 
Parameters rollout; the Oren-Nayar-Blinn Basic 
Parameters rollout will be displayed. This rollout is 
discussed next.

Oren-Nayar-Blinn Basic Parameters Rollout: The Ambient, Diffuse, and Specular color 
swatches, the Self-Illumination area, and the Opacity spinner in this rollout are the same 
as discussed in the Anisotropic Basic Parameters rollout. In the Advanced Diffuse area, 
the Diffuse Level and Roughness spinners are the same as discussed in the Multi-Layer 
shader. 

In the Specular Highlights area, the Specular Level, Glossiness, and Soften spinners 
are the same as discussed in the Blinn shader. 

Phong Shader
The Phong shader is very similar to the Blinn shader. The only difference is that the 
highlights produced by the Phong shader are stronger than those produced by the Blinn 
shader, as shown in Figure 7-54. To assign this shader to the material, select the Phong 
shader from the drop-down list available in the Shader Basic Parameters rollout; the 
Phong Basic Parameters rollout will be displayed. This rollout is discussed next.

Figure 7-54  The sphere geometry 
with the Phong shader

Phong Basic Parameters Rollout: The Ambient, Diffuse, and Specular color swatches, 
the Self-Illumination area, and the Opacity spinner in this rollout are the same as 
described in the Anisotropic Basic Parameters rollout. In the Specular Highlights area, 
the Specular Level, Glossiness, and Soften spinners are the same as those discussed in 
the Blinn shader. 
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Strauss Shader
The Strauss shader is used to create the metallic and non-metallic surfaces, as shown 
in Figure 7-55. To assign this shader to the material, select the Strauss shader from the 
drop-down list; the Strauss Basic Parameters rollout will be displayed. This rollout is 
discussed next.

Strauss Basic Parameters Rollout: The Strauss shader does not have the Ambient, Diffuse, 
and Specular color swatches. Choose the Color swatch to change the color of the material. The 
value in the Glossiness spinner is used to set the size and the intensity of the specular highlight of 
the material. The value in the Metalness spinner is used to set the metallic effect in 
the material. The value in the Opacity spinner is used to set the transparency of the 
material.

Figure 7-55  The teapot geometry with the Strauss shader

Translucent Shader
The Translucent shader is used to create translucent materials. In such materials, the 
light gets scattered as it passes through them, as shown in Figure 7-56. It is very similar to 
the Blinn shader. Additionally, it defines the translucency of the material. To assign this 
shader to the material, you need to select the Translucent Shader from the drop-down 
list in the Shader Basic Parameters rollout; the Translucent Basic Parameters rollout 
will be displayed. This rollout is discussed next.

Figure 7-56  The sphere geometry 
with the Translucent shader

Translucent Basic Parameters Rollout: Most of the options in this rollout are the same as 
discussed earlier. By default, the Backside specular check box is selected in this rollout. 
As a result, the specular highlight is displayed on both sides of the material. 
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Note
Select the Backside specular check box in the Specular Highlights area in the Translucent 
Basic Parameters rollout to create materials such as plastic or smooth glass. Clear the Backside 
specular check box to create the frosted or rough material.  

In the Translucency area, the Translucent Clr swatch is used to define the color of the 
light that will be scattered inside the material. The Filter Color swatch is used to define 
the color of the light that will be transmitted by the material.

Architectural Material
The Architectural material is used to provide a highly realistic view of an object when rendered 
with photometric lights and radiosity, about which you will learn in the later chapters. To apply 
the Architectural material, choose the Material Type button on the right side of the Material  
Name drop-down list; the Material/Map Browser dialog box will be displayed. Choose the 
Architectural material from the Material/Map Browser dialog box; the Architectural label will 
be displayed on the Material Type button. Also, various rollouts such as Physical Qualities, 
Special Effects, and so on will be displayed below the Architectural button. You can use these 
rollouts to create new materials and modify the physical properties of those materials. The 
most commonly used rollouts are discussed next.

Templates Rollout
The drop-down list in the Templates rollout consists of a number of preset materials such as 
Water, Glass-Clear, Metal, Paper, and so on, as shown in Figure 7-57. On selecting one of the 
preset materials from the drop-down list, you will get a template in the selected sample slot for 
the type of material you have selected. After selecting the material, you can set the parameters 
in other rollouts to get a realistic view of the material, as shown in Figure 7-58.

Physical Qualities Rollout
The Diffuse Color swatch is used to specify the color of an object in direct light. It is the main 
color of the material. Choose the Diffuse Color swatch to define the color of the material. 
The Diffuse Map option is used to assign a map or an image to the material. To do so, choose 
the Diffuse Map button labeled as None on the right side of the Diffuse Map spinner; the 
Material/Map Browser dialog box will be displayed. Select one of the maps from the Maps > 
Standard rollout and double-click on it to assign it. The basic parameters rollouts of the 
selected map will be displayed. Set the parameters as per your requirement and then choose 
the Go To Parent button to go back to the previous level; the None label will be replaced by 
the name of the selected map. The spinner on the right side of the Diffuse Map option is 
used to set the amount of visibility of the map in the material in percentage. By default, its 
value is 100. On decreasing the value in this spinner, the visibility of the map in the material 
will be decreased. Note that by default, the check boxes located in between the spinners and 
the buttons in the Physical Qualities rollout are selected. As a result, the selected map will 
be displayed on the material.  

The Set color to texture average button, available next to the Diffuse Color color swatch will 
be activated only if you assign a diffuse map to the material using the Diffuse Map button. 
This button is used to set the diffuse color according to the map that you have assigned to the 
material using the Diffuse Map button.        
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Figure 7-58  The teapot geometry with 
the Architectural material applied

Figure 7-57  The preset materials in the drop-down 
list in the Templates rollouts 

The Shininess, Transparency, and Translucency options in the Physical Qualities rollout 
are used to define the shine, transparency, and the translucency of the material. Also, you can 
assign a map or an image to these options as you did for the Diffuse Map option. The Index 
of Refraction spinner is used to set the amount of refraction of the light transmitted by the 
material. The Luminance cd/m2 spinner is used to give the glow effect to the material. The 
luminance is measured in candelas per meter square. The Set luminance from 
light button uses the scene light to obtain the materials luminance. Select the 
2-Sided check box to assign the material on both sides of the selected faces.   

Note
The Architectural material gives a realistic result only with photometric lights.
 

Raytrace Material
The Raytrace material creates highly refractive and reflective surfaces. When this material 
is assigned to an object in the scene, the materials/maps of other objects in the scene get 
reflected on it, as shown in Figure 7-59. It is an advance material and is used to provide realistic 
raytraced images. It also creates raytraced reflections and refractions, and takes a longer time 
to render. On selecting the Raytrace material, various rollouts will also be displayed below the 
Material Type button to create new materials and modify the properties of those materials. 
The Raytrace Basic Parameters rollout is most commonly used and is discussed next.
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Raytrace Basic Parameters Rollout
The basic parameters in this rollout are similar to those used in the Standard material but 
the color swatches in this rollout act differently, refer to Figure 7-60. These color controls are 
discussed next. 

Figure 7-59  The teapot geometry with the 
Raytrace material applied

Figure 7-60  The Raytrace Basic Parameters 
rollout

By default, the check box on the left side of the Ambient color swatch is selected, which is 
used to specify the amount of absorption of the ambient light by the material. By default, 
the black color is selected in this color swatch and it specifies the maximum absorption of 
the ambient light by the material. On setting a lighter color in the Ambient color swatch, the 
ambient light will be reflected. If you clear the check box, the color swatch will be replaced by 
a spinner. The value in the spinner specifies the grayscale value.

The Diffuse color swatch specifies the color of the object without the specular highlight. The 
Reflect color swatch is used to specify the specular reflection color. By default, the color in 
this color swatch is black and the object does not reflect. If you change the color to white, 
then the object will reflect everything and will be visible. If you clear the check box, the color 
swatch will be replaced by a spinner. If you set the value in the Reflect spinner to 100, then the 
diffuse color will not be visible on the object. The value in the spinner specifies the grayscale 
value. If you select this check box again, the spinner will be replaced by the Fresnel option. 
This option adds the fresnel effect to the reflecting object resulting in a bit of extra reflection 
in the reflecting object.

The Luminosity color swatch is very similar to the Self-Illumination area in the Standard 
material. By default, the check box on the right of the Luminosity option is selected. If you 
clear the check box, the Luminosity label will be replaced by Self-Illum and the color swatch 
will be replaced by a spinner. The value in the spinner specifies the grayscale value. 

The Transparency color swatch is used to define the transparency of the object. By default,  
the check box on the right of the Transparency option is selected. If you clear this check box, 
the Transparency color swatch is replaced by a spinner. The value in the spinner also defines 
the transparency of the object.  
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Blend Material
The Blend material is a compound material and is used to mix two different materials, as 
shown in Figure 7-61. You can assign this mixed or blend material as a single material. When 
you select the Blend material from the Material/Map Browser dialog box, the Replace 
Material dialog box will be displayed, as shown in Figure 7-62. Select the Discard old material? 
radio button to remove the current material of the selected sample slot. Select the Keep 
old material as sub-material? radio button to keep the material of the selected sample slot 
as a sub-material in the Blend material. Choose the OK button; the Blend material will be 
displayed in the Material Type button with a number of rollouts. The most commonly used 
rollout is discussed next.

Figure 7-61  The sphere geometry 
with the Blend material applied

Figure 7-62  The Replace Material 
dialog box

Blend Basic Parameters Rollout
On the top of this rollout, there are two buttons, Material 1 and Material 2, as shown in 
Figure 7-63. These buttons are labeled with the name of the default materials and are used 
to select two different materials to blend. By default, the Standard material is displayed as 
the sub-material. Choose these buttons to assign desired materials. Next, choose the Go To 
Parent tool to go back to the Blend material.

Figure 7-63  The Blend Basic Parameters 
rollout

The Mask button is used to insert an image or a map as a mask. The amount of blending of 
the two materials depends on the mask image. The lighter area of the mask image will show 
more of Material 1 and the darker area of the mask image will show more of Material 2.       



Materials and Maps		         7-27

By default, the check boxes on the right side of the Material 1, Material 2, and Mask buttons 
are selected, which specify that the concerned material or the mask will be displayed on the 
object. If you clear any of the check boxes, the corresponding material or mask will not be 
displayed.

Select the two Interactive radio buttons on the right side of the check boxes to specify the 
materials that will be displayed on the object in the shaded viewports. The value in the Mix 
Amount spinner is used to set the blending amount of the materials in percentage. When you 
insert a map using the Mask button, the Mix Amount spinner will become inactive. 

The Mixing Curve area is used to define the transition between two colors being blended. 
It affects the transition only when the mask map is applied to the Mask button. Select the 
Use Curve check box to apply the curve settings to the blending. This check box will be 
active only if you have assigned the mask map. In the Transition zone group, the values in the 
Upper and Lower spinners set the transition of the materials. The values in these spinners 
vary from 0 to 1.0.

Note
The blending of maps can be animated over time using the Mix Amount spinner.
 

Composite Material
The Composite material is similar to the Blend material and is used to mix ten different 
materials. You can assign this mixed material as a single material. On choosing the Material 
Type button, the Material/Map Browser dialog box will be displayed. Select the Composite 
material and choose the OK button; the Replace Material dialog box will be displayed. Select 
the Discard old material? radio button to remove the material of the selected sample slot. 
Else, select the Keep old material as sub-material? radio button to retain the material of the 
selected sample slot as a sub-material in the Composite material. Choose the OK button; the 
Composite material will be displayed in the Material Type button with a number of rollouts. 
The most commonly used rollout is Composite Basic Parameters rollout, which is discussed 
next. 

Composite Basic Parameters Rollout
On the top of this rollout, there is the Base Material button which is labeled with the name of 
the material on it, refer to Figure 7-64. It is used to define the base material of the object. By 
default, the Standard material is displayed on it. Choose this button and set the parameters 
for the base material as required. Next, choose the Go to Parent tool to go back to the parent 
level.

There are nine buttons below the Base Material button, from Mat.1 to Mat.9, labeled with 
None. These buttons are used to composite nine materials. Choose these buttons one by one 
to assign different materials; the None labels will be replaced by the names of the materials 
that will be assigned to them. The check boxes on the left side of these buttons are selected 
to display the corresponding materials in the objects. If you do not want to display any of the 
materials, then clear the respective check boxes.
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The A, S, and M buttons are used to specify the composition of the materials. Choose the A 
button to use the additive color to compose the materials. It specifies that the color of the 
base material will be added to the color of the composed material. Choose the S button to use 
the subtractive color to compose. It specifies that the color of the composed material will be 
subtracted from the color of the base material. Choose the M button to blend the materials as 
discussed in the Blend Material section with the only difference that the option for masking 
is not available in this case. For each material, the spinner on the right of the A, S, and M 
buttons determines the amount of mixing of the respective material with the Base Material. 
When the A and S buttons are active, the value in the spinner ranges from 0 to 200. Whereas, 
when the M button is active, the value in the spinner ranges from 0 to 100.   

Figure 7-64  The Composite Basic Parameters rollout

Double Sided Material
The Double Sided material is used to assign two different materials to the front and back 
faces of an object, refer to Figures 7-65 and 7-66. Choose the Double Sided material from 
the Material/Map Browser dialog box; the Double Sided material will be displayed in the 
Material Type button with a number of rollouts. The Double Sided Basic Parameters rollout 
is discussed next. 

Figure 7-65  The object with 
the Standard material

Figure 7-66  The object with the 
Double Sided material

Double Sided Basic Parameters Rollout
The Translucency spinner at the top of this rollout specifies the amount of  blending of  Facing 
Material and Back Material, refer to Figure 7-67. The value in this spinner varies from 0 to 
100.0. If you set the value 100 in the Translucency spinner, the back material will completely 
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cover the face material. Choose the buttons next to the Facing Material and Back Material 
options to select the material for the front and back sides of the object, respectively. 

Figure 7-67  The Double Sided Basic 
Parameters rollout

Multi/Sub-Object Material
The Multi/Sub-Object material is used to assign different materials to an object at the sub-object 
level, as shown in Figure 7-68. Select the object to which the Multi/Sub-Object material is to be 
assigned. Convert the object to editable poly and then select the Polygon sub-object level. Next, 
select the group of polygons in the viewport, refer to Figure 7-69. Now, expand the Polygon 
Material IDs rollout and enter the value 1 in the Set ID spinner and press ENTER. Then, 
invert the selection and enter the value 2 in the Set ID spinner. Next, press ENTER, refer to 
Figure 7-70. Note that multiple numbers of IDs can be assigned to an object depending on 
the number of materials to be assigned to it. Once IDs are set to different parts of the object, 
choose the Multi/Sub-Object material from the Material/Map Browser dialog box; the Replace 
Material message box will be displayed. Select the Discard old material? radio button from 
it and choose the OK button; the Multi/Sub-object material will be displayed in the Material 
Type button. Also, the Multi/Sub-Object Basic Parameters rollout will be displayed, refer to 
Figure 7-71. This rollout is discussed next. 

Figure 7-68  The object with the 
Multi/Sub-Object material

Figure 7-69  The object with 
group of polygons selected 

Figure 7-70  The object with 
remaining polygons selected

Multi/Sub-Object Basic Parameters Rollout
Choose the Set Number button in this rollout; the Set Number of Materials dialog box will 
be displayed. Enter 2 in the Number of Materials spinner and choose the OK button; the 
Multi/Sub-Object Basic Parameters rollout will display two entries instead of ten entries. Note 
that the value entered in the Number of Materials spinner should be equal to the number 
of IDs created for the object which in turn is equal to the entries in this rollout. Now, choose 
the None button for each of the IDs to assign the required sub-material. Also, you can enter 
the name of the sub-material in the Name text box. Next, assign the material to the object to 
see the effect of the Multi-Sub-Object material.



7-30	   			               Autodesk 3ds Max 2014: A Comprehensive Guide

Figure 7-71  The Multi/Sub-Object 
Basic Parameters rollout

Note
If you want to change only the color of the sub-material without assigning any map to it, then 
the color swatch next to it will be inactive. It will be activated only when you assign Standard 
material to it.

Top/Bottom Material
The Top/Bottom material is used to assign two different materials on the top and bottom 
portions of the object, as shown in Figure 7-72. To do so, choose the Top/Bottom material 
from the Material/Map Browser dialog box; the Top/Bottom material will be displayed in the 
Material Type button with a number of rollouts. The Top/Bottom Basic Parameters rollout 
is discussed next. 

Top/Bottom Basic Parameters Rollout
Choose the buttons next to Top Material and Bottom to select the material for the top and 
bottom portions of the object, respectively, refer to Figure 7-73. Choose the Swap button to 
exchange the material of the Top Material and Bottom buttons.

Figure 7-73  The Top/Bottom Basic 
Parameters rollout

Figure 7-72  The object with the 
Top/Bottom material applied

The options in the Coordinates area are used to set the boundary between the top and bottom 
of the object. By default, the World radio button is selected and the faces will point up or 
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down according to the world coordinates of the scene. In this case, if you transform the object, 
then the boundary remains constant at its place. If you select the Local radio button, then 
the faces will point up or down according to the local coordinates of the object. In this case, 
if you transform the object, the material will also get transformed. The Blend spinner is used 
to blend the edges of the top and bottom materials. The Position spinner is used to specify 
the position of the top and bottom materials on the object. By default, the value in both the 
spinners ranges from 0 to 100.0.  

Maps
In 3ds Max, maps are the default images assigned to a material. They are used to create 
texture for the objects to make them appear more realistic. In this section, you will learn 
about assigning the maps to the objects. When maps are assigned to the objects, the objects 
demonstrate best effects on applying lights.

To assign a map to the material, choose Modes > Compact Material Editor from the material 
editor menu bar; the Material Editor dialog box will be displayed. Select one of the sample 
slots in the Material Editor dialog box to activate it. Now, in the basic parameters rollout of 
the selected material, choose the small square buttons on the right of the parameters available, 
refer to Figure 7-74; the Material/Map Browser dialog box will be displayed with a list of 
default maps available in 3ds Max. Next, select the required map from the Maps > Standard 
rollout and then choose the OK button; the name of the selected map will be displayed on 
the Material Type button and the rollouts related to that map will also be displayed. Set the 
parameters for the map in various rollouts displayed. Next, choose the Go to Parent button 
to go back to the previous level; the small square button will be labeled as M. Also, when you 
move the cursor over the M button, it will display the name of the map that you have assigned 
to it.      

Figure 7-74  The square buttons highlighted 
for inserting maps 
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Various types of maps available in the Material/Map Browser dialog box are discussed next.

Note
You can also assign maps using different options such as Ambient Color, Diffuse Color, 
Specular Color, and so on to a material using the Maps rollout in the Material Editor 
dialog box. You need to choose the buttons on the right side of these options that are labeled as 
None, refer to Figure 7-73.

Types of Maps
In 3ds Max, the maps are categorized as bitmaps and procedural maps. The bitmaps are 
2D images and they get pixelated when zoomed on them. The procedural maps are Noise, 
Tiles, Marble, Gradient, and so on and they do not get pixelated when zoomed on them. 
The maps can be categorized into 2D maps, 3D maps, Compositors, Color Mods, and so on. 
These maps are discussed next. 

2D Maps
The 2D maps are two-dimensional images that can be assigned to geometric objects  
and are used to create an environment for the scene. The most commonly used two-
dimensional maps such as Bitmap, Checker, Combustion, Gradient, Gradient Ramp, 
Swirl, and Tiles are discussed next.

Bitmap 
The bitmaps are the simplest 2D images. To apply this map on an object, select the 
Bitmap map in the Material/Map Browser dialog box; the Select Bitmap Image File 
dialog box will be displayed. In this dialog box, select the image that you want to insert 
and choose the Open button; the image will be displayed in the selected sample slot. Also, 
various rollouts to modify the image map will be displayed in the Material Editor dialog 
box. Now, when the material is assigned to the object in the viewport, the object will be 
displayed with the assigned bitmap, as shown in Figure 7-75. You can select all the still or 
animated files that 3ds Max supports. 

Checker
The Checker map is a combination of two colors, as shown in Figure 7-76. You can change 
or replace the colors with the images using the Checker Parameters rollout in the Material 
Editor dialog box. 

Gradient
The Gradient map is used to create a ramp of three colors, as shown in Figure 7-77. You 
can modify or replace colors with images using the Gradient Parameters rollout of the 
Material Editor dialog box.

Gradient Ramp
The Gradient Ramp map is a 2D map similar to the Gradient map, as shown in Figure 7-78. 
However, in this map, you can use any numbers of colors and maps for creating the gradient. 
You can get the best effect using the Gradient Ramp Parameters rollout in the Material 
Editor dialog box. 
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Figure 7-75  A sphere with the 
Bitmap map applied

Figure 7-76  A sphere with the 
Checker map applied

Figure 7-77  An object with the 
Gradient map applied

Swirl
The Swirl map is a procedural map and is used to produce whirl effect in materials, as 
shown in Figure 7-79. You can modify the colors or replace the colors with the images 
using the Swirl Parameters rollout in the Material Editor dialog box.

Figure 7-79  A sphere with 
the Swirl map applied

Figure 7-78  A box with the 
Gradient Ramp map applied

Tiles 
The Tiles map is a procedural map and is used to create 
bricks or tiles effect using different colors and maps, as shown 
in Figure 7-80. The better effect of this map can be aquired 
using different rollouts displayed in the Material Editor dialog 
box.

Figure 7-80  A sphere with 
the Tiles map applied

Substance Map and Map Output Selector Map
	 The Substance map is a collection of 2D textures. To use a 

texture from the Substance map, choose any of the desired 
map buttons from the Material Editor dialog box and select 
the Map Output Selector map from the Maps rollout in the 
Material/Map Browser dialog box. On doing so, the Map 
Output Selector map will be displayed in the Material Type button. Also, the Parameters 
rollout will be displayed, as shown in Figure 7-81. Next, choose the None button on the 
right of the Source Map parameter from the Parameters rollout and then select Substance 
from the Material/Map Browser dialog box; various rollouts such as Global Substance 
Settings, Substance Package Browser, Coordinates, and so on will be displayed in the 
Material Editor dialog box, as shown in Figure 7-82. 
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	 Now, choose the Load Substance button from the Substance Package Browser rollout; 
the Browse from Substances dialog box will be displayed. In this dialog box, select 
the desired texture and choose the Open button; the Load Substance button will be 
replaced by the texture you have selected. Also, the rollout for the respective texture 
parameters will be added at the bottom in the Material Editor dialog box. In this 
rollout, different parameters can be changed to get the desired result. Choose the Get 
Substance From Marketplace button to buy textures online. Next, choose the Go to Parent 
button and select the desired channel name from the Channel Name drop-down list.   

 
Vector Displacement Map
The Vector Displacement map is a procedural map and is used to displace the meshes 
in three dimensions. This map uses a range of color to display its effect.

Figure 7-81  The Parameters rollout of the 
Map Output Selector map

Figure 7-82  The rollouts displayed on selecting 
the Substance map

Vector Map
In 3ds Max 2014, the Vector map is used to apply the vector-based graphics to objects. 
The image it generates is independent of display resolution. The Vector map supports 
a variety of industry-standard vector-graphic formats such as AutoCAD PAT Hatch, AI 
(Adobe Illustrator), SVG, PDF, and SVGZ. 

3D Maps
The 3D Maps are three-dimensional images that can be assigned to geometric objects. These 
are also known as procedural maps. The most commonly used three-dimensional maps such 
as Cellular, Falloff, Noise, and so on are discussed next.
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Dent
The Dent map is used to produce material with 3D bumps on its surface. It is basically 
used as the Bump map available in the Maps rollout, refer to Figure 7-83. The effects of 
this map can be modified at an advanced level by using the Dent Parameters rollout in 
the Material Editor dialog box.

Cellular
The Cellular map is a 3D procedural map. It is used to produce materials such as 
sand, pebbled surfaces, and so on, as shown in Figure 7-84. The effects of this map can 
be modified at an advanced level using the Cellular Parameters rollout in the Material 
Editor dialog box.

Noise
The Noise map is used to create disturbance on the surface of an object by combining  
two colors or materials in different ways, as shown in Figure 7-85. The effects of this map 
can be modified at an advanced level using the Noise Parameters rollout in the Material 
Editor dialog box.

Figure 7-84  An object 
with the Cellular map 
applied

Figure 7-83  A teapot with the 
Dent map applied

Figure 7-85  A sphere 
with the Noise map 
applied

Smoke
The Smoke map is used to produce textures such as smoke from the fire, cloudy effect, 
or the beam of lights on the surface of an object, as shown in Figure 7-86. The effects of 
this map can be modified at an advanced level using the Smoke Parameters rollout of 
the Material Editor dialog box.

Speckle
The Speckle map is used to produce the texture of the patterned surfaces such as granite 
and so on, as shown in Figure 7-87. The effects of this map can be modified at an advanced 
level using the Speckle Parameters rollout in the Material Editor dialog box.

Splat
The Splat map is used to produce texture such as splattered paint on the surface of an 
object, as shown in Figure 7-88. The effects of this map can be modified at an advanced 
level using the Splat Parameters rollout of the Material Editor dialog box.
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Figure 7-86  A sphere with 
the Smoke map applied

Figure 7-87  A box with the 
Speckle map applied

Figure 7-88  A box with the 
Splat map applied

Stucco
The Stucco map is used to produce the textures such as plaster or cement on the surface 
of an object, as shown in Figure 7-89. You need to assign a Bump map using the Maps 
rollout to get its best effect. The effects of this map can be modified at an advanced level 
using the Stucco Parameters rollout in the Material Editor dialog box.

Waves
The Waves map is used to create a wavy surface, as shown in Figure 7-90. The effects of 
this map can be modified at an advanced level using the Waves Parameters rollout in the 
Material Editor dialog box.

Wood
The Wood map is used to create the 3D wood texture on the surface of the object, refer 
to Figure 7-91. The effects of this map can be modified at an advanced level using the 
Wood Parameters rollout in the Material Editor dialog box.

Figure 7-89  A wall with 
the Stucco map applied

Figure 7-90  A plane with 
the Waves map applied

Figure 7-91  A box with 
the Wood map applied

Compositors Maps
The Compositors maps are used to combine the colors or the maps together. Various maps 
in this category are: Composite, Mask, Mix, and RGB Multiply. 

Color Mods Maps
The Color Mods maps are used to modify or change the color of pixels in a material. Various 
maps in this category are: Output, RGB Tint, and Vertex Color.
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Other Maps
There are some other types of maps such as Raytrace, Flat Mirror, and so on, which are used 
in a different way. These maps are discussed next.

Flat Mirror
The Flat Mirror map is used to create a material that generates reflection of other objects 
in the scene when assigned to the flat surfaces. You can get the best effect of this map 
using the Flat Mirror Parameters rollout in the Material Editor dialog box.

Raytrace
The Raytrace map is used to create the raytraced reflections and refractions on the 
surface of the objects. You can get the best effect of this map using the Raytrace Parameters 
rollout in the Material Editor dialog box. 

Reflect/Refract
The Reflect/Refract map is used to produce the reflection and the refraction based on 
the objects in the scene. You can modify the effects using the Reflect/Refract Parameters 
rollout in the Material Editor dialog box.

Once you assign any of the above maps on the square button  in the 

Figure 7-92  The shortcut menu 
displayed on right-clicking on 
the M button

Material Editor dialog box, M will be displayed on it. If 
you right-click on this button, a shortcut menu will be displayed, 
as shown in Figure 7-92. Using the options in the shortcut menu, 
you can cut or copy the map and paste it at the desired place. You 
can also clear the unwanted map using the Clear option.

tutorials
Tutorial 1

In this tutorial, you will assign material to two glasses that were created in Tutorial 1 of 
Chapter 6, refer to Figure 7-93. 	 	                		    (Expected time: 15 min)

Figure 7-93  The models of glasses
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The following steps are required to complete this tutorial:

a.	 Create the project folder.
b.	 Download and open the file.
c.	 Create base.
d.	 Create material for the base.
e.	 Create material for the glasses.
f.	 Save and render scene.

Creating the Project Folder
Create a new project folder with the name c07_tut1 at \Documents\3dsmax2014 and save the 
file with the name c07tut1, as discussed in Tutorial 1 of Chapter 2.
	
Downloading and Opening the File
In this section, you will download and open the file.
 
1.	 Before starting the tutorial, you need to download the c07_3dsmax_2014_tut.zip file from 

www.cadcim.com. The path of the file is as follows: Textbooks > Animation and Visual Effects > 
3ds Max > Autodesk 3ds Max 2014: A Comprehensive Guide 

	 Extract the contents of the zipped file and save them in the Documents folder. 

2.	 Choose the Open button from the Application menu; the Open File dialog box is 
displayed. In this dialog box, browse to \Documents\c07_3dsmax_2014_tut and then select 
the c07_tut1_start.max file from it. Choose the Open button to open the file, refer to 
Figure 7-94.

Figure 7-94  The file with glasses displayed 
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Note
Instead of following steps 1 and 2, you can directly open the file that you created in Tutorial 1 
of Chapter 6 and then follow step 3 given below to save it.

3.	 Choose the Save As button from the Application menu; the Save File As dialog box is 
displayed. Browse to the location \Documents\3dsmax2014\c07_tut1\scenes. Save the file with 
the name c07tut1.max at this location. 

4.	 Open the Windows Explorer and then browse to the c07_3dsmax_2014_tut folder and copy 
the CHROMBLU.jpg file from this folder to \Documents\3dsmax2014\c07_tut1\sceneassets\
images.

Creating Base
In this section, you will create the base for the cocktail glasses by using the Box tool.

1.	 Activate the Top viewport and choose Create > Geometry in the Command Panel; 
the Standard Primitives option is displayed in the drop-down list below the Geometry 
button. Choose the Box tool from the Object Type rollout and create a box in the Top 
viewport.

2.	 Name the box as base.

3.	 In the Parameters rollout, set the length and width parameters of the box according to 
your scene. Set the value in the Height spinner to 1.0.

4.	 Align base with glasses using the Select and Move tool, as shown in Figure 7-95.  

Figure 7-95  Alignment of base in viewports 
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	 Next, you need to create materials for objects in the scene.

Creating Material for the Base 
In this section, you will create the material and then assign it to the base by using the Material 
Editor dialog box.

1. 	 Select base in any viewport and then choose Rendering > Material Editor > Compact 
Material Editor from the menu bar; the Material Editor dialog box is displayed.

2.	 In the Material Editor dialog box, select the second sample slot to which no material 
is assigned; the selected sample slot is surrounded by a white triangles. In the Material 
Name drop-down list, enter base and then press the ENTER key. 

 	 Next, you need to set parameters for the Standard material.    

3.	 In the Shader Basic Parameters rollout, make sure that the Blinn shader is selected in 
the drop-down list.

4.	 In the Blinn Basic Parameters rollout, choose the small square button on the right of the 
Diffuse color swatch, as shown in Figure 7-96; the Material/Map Browser dialog box is 
displayed. 

5.	 Expand the Maps > Standard rollout and select the Checker map from the list displayed 
in the Material/Map Browser dialog box. Choose the OK button; the Checker map is 
displayed in the selected sample slot, as shown in Figure 7-97. Also, the Coordinates, 
Noise, and Checker Parameters rollouts are displayed in the Material Editor dialog box, 
as shown in Figure 7-98.

Figure 7-96  The highlighted square button to be chosen Figure 7-97  The Checker map 
in the sample slot

6.	 In the Coordinates rollout, set the value 3 in both the U Tiling and V Tiling spinners to 
apply the Checker map thrice on U and V. Note that the map is displayed in the selected 
sample slot, as shown in Figure 7-99. Use the default values for other options.

7.	 In the Checker Parameters rollout, select the black color swatch; the Color Selector: 
Color1 dialog box is displayed. Set the values as follows: 

										        
	 Red: 0	 		  Green: 12	 		  Blue: 104
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	 Now, choose the OK button to close this dialog box.

Figure 7-98  The rollouts displayed on 
selecting the Checker map

Figure 7-99  The Checker map 
with 3x3 tiling

8.	 Make sure that the white color is selected in the other color swatch, refer to Figure 7-98.
 

9.	 Choose the Go to Parent tool to go back to the Standard material.

	 Next, you need to assign the Raytrace map to the material to give it a realistic look.

Note 
After assigning the map, the small square button on the right of the Diffuse color swatch is 
labeled as M.     

10.	 Expand the Maps rollout; a list of maps is displayed, as shown in Figure 7-100.   

Figure 7-100  The Maps rollout 
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11.	 In this rollout, select the Reflection check box to make it active. Choose the Reflection 
map button on the right of the spinner that is labeled as None; the Material/Map Browser 
dialog box is displayed. Select the Raytrace map from the Maps > Standard rollout and 
choose the OK button; the Raytrace map with various rollouts is displayed in the Material 
Editor dialog box. Use the default values for the Raytrace map. 

12.	 Choose the Go to Parent tool. Expand the Maps rollout and set the value 20 in the 
Reflection spinner. 

	 Now, you need to assign the base material to base. 

13.	 Make sure that base is selected in the viewport and the base material is selected in the 
Material Editor dialog box.

14.	 Choose the Assign Material to Selection tool from the Material Editor dialog box; the 
base material is assigned to base in the viewport. 

15.	 Choose the Show Shaded Material in Viewport tool to display the base material on the 
object in the viewport, as shown in Figure 7-101.

Figure 7-101  The base material displayed on the floor

Creating Material for the Glasses 
The material has already been assigned to the cocktail glasses in Tutorial 1 of Chapter 6. But, 
in this section, you will assign another material to it. 

1. 	 Select glasses in the viewport and then select another sample slot in the Material Editor 
dialog box. In the Material Name drop-down list, enter glass and press ENTER.
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2.	 Use the Standard material for the cocktail glasses. 

	 Next, you need to set parameters for the Standard material.    

3.	 In the Shader Basic Parameters rollout, select the Phong shader; the Phong Basic 
Parameters rollout is displayed. Select the 2-Sided check box.

4.	 In the Phong Basic Parameters rollout, choose the small square button on the right of 
the Diffuse color swatch; the Material/Map Browser dialog box is displayed. 

5.	 Select the Bitmap map from the list displayed in the Material/Map Browser dialog box 
and double-click on it; the Select Bitmap Image File dialog box is displayed. 

	 As the project folder is already set, the images folder is displayed in the Look in drop-down 
list of this dialog box. 

6.	 Select the file CHROMBLU.jpg from it and choose the Open button; the image is 
displayed in the selected sample slot, as shown in Figure 7-102. 

Figure 7-102  The sample slot after 
assigning the Bitmap map 

7.	 Choose the Go to Parent tool from the Material Editor dialog box to go back to the 
Standard material.

8.	 In the Specular Highlights area of the Material Editor, set the values as follows:

	 Specular Level: 96		  Glossiness: 18 		  Soften: 0.1

9.	 In the Opacity spinner, set the value 30 to make the object transparent. 

	 Next, you need to assign the CHROMBLU.jpg image, which you had assigned to the 
Diffuse map, to the Opacity map to get a realistic effect.

10.	 Move the cursor over the Diffuse map button that is labelled as M. Press and hold the left 
mouse button and then drag the button to the Opacity map button on the right of the 
Opacity spinner. Next, release the left mouse button; the Copy (Instance) Map dialog 
box is displayed. 	

11.	 In this dialog box, make sure the Copy radio button is selected and then choose the OK 
button; the CHROMBLU.jpg image is assigned to the Opacity map. Also, the square button 
is labeled as M.
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Note
You can also insert the Diffuse and Opacity maps using the Maps rollout. 
	

	 Next, you need to apply glass material to cocktail glasses. 

12.	 Make sure that cocktail glasses are selected in the viewport. In the Material Editor dialog 
box, make sure that glass material is selected.

13.	 Choose the Assign Material to Selection tool; the glass material is assigned to cocktail 
glasses in the viewport, refer to Figure 7-103.

Figure 7-103  The glass material displayed on cocktail glasses

14.	 Close the Material Editor dialog box.

Saving and Rendering the Scene
In this section, you will save the scene and then render it. You can also view the final rendered 
image of this model by downloading the c07_3dsmax_2014_rndr.zip file from www.cadcim.com. 
The path of the file is as follows: Textbooks > Animation and Visual Effects > 3ds Max > Autodesk 
3ds Max  2014: A Comprehensive Guide

1.	 Choose Save from the Application menu.

2.	 Activate the Perspective viewport. Next, choose the Render Production tool from the 
Main Toolbar; the Rendered Frame window is displayed. This window shows the final 
output of the scene, refer to Figure 7-104.
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Figure 7-104  The final output of the scene

Tutorial 2
In this tutorial, you will create brass material and assign it to a flower pot, as shown in 
Figure 7-105. 			                                                         (Expected time: 15 min)

			     

Figure 7-105  The model of a flower pot

The following steps are required to complete this tutorial:

a.	 Create the project folder.
b.	 Download and open the file.
c.	 Create brass material for the flower pot.
d.	 Save and render the scene.

Creating the Project Folder
Create a new project folder with the name c07_tut2 at \Documents\3dsmax2014 and then save 
the file with the name c07tut2, as discussed in Tutorial 1 of Chapter 2.
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Downloading and Opening the File
In this section, you will download and open the file.

1.	 Before you start the tutorial, download the c07_3dsmax_2014_tut.zip file from www.cadcim.com. 
The path of the file is as follows: Textbooks > Animation and Visual Effects > 3ds Max > 
Autodesk 3ds Max  2014: A Comprehensive Guide  

	
	 Extract the contents of the zipped file and save them in the \Documents folder. 

2.	 Choose Open from the Application menu; the Open File dialog box is displayed. 
In this dialog box, browse to the location Documents\c07_3dsmax_2014_tut and select 
the c07_tut2_start.max file in it. Choose the Open button to open the file, refer to 
Figure 7-106.

Figure 7-106  The flower pot geometry with a plant

3.	 Choose Save As from the Application menu; the Save File As dialog box is displayed. 
Browse to the location \Documents\3dsmax2014\c07_tut2\scenes. Save the file with the 
name c07tut2.max at this location. 

4.	 Open the Windows Explorer and then browse to the c07_3dsmax_2014_tut folder and 
copy the Lakerem2.jpg file from this folder to the location \Documents\3dsmax2014\c07_tut2\
sceneassets\images.

    
Creating Brass Material for the Flower Pot
In this section, you will create the brass material for the flower pot by using the Compact 
Material Editor tool.

1. 	 Select flower pot in a viewport and choose the Compact Material Editor tool from the 
Main Toolbar; the Material Editor dialog box is displayed.
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2.	 Select one of the empty sample slots in the Material Editor dialog box. In the Material 
Name drop-down list of this dialog box, enter brass and then press the ENTER key. 

3.	 By default, the Standard material is displayed on the Material Type button and you need 
to use the same for creating the brass material. 

	 Next, you need to set parameters for the Standard material.  
 
4.	 In the Shader Basic Parameters rollout, select the Metal shader option from the drop-down 

list; the Metal Basic Parameters rollout is displayed. Select the 2-Sided check box.

5.	 In the Metal Basic Parameters rollout, choose the Diffuse color swatch to change the color 
of the material; the Color Selector dialog box is displayed. Set the values as follows: 

	 Red: 253			   Green: 159			   Blue: 37 

	 Now, choose the OK button to close this dialog box.

6.	 In the Specular Highlights area, set the values as follows:

	 Specular Level: 80			   Glossiness: 75 		
	
	 Next, you need to assign the Reflection map from the Maps rollout to get a realistic 

effect.

7.	 Expand the Maps rollout in the Material Editor dialog box; a list of maps is displayed.

8.	 Select the Reflection check box to make it active. Choose the Reflection map button that 
is labeled as None on the right of the Reflection spinner; the Material/Map Browser 
dialog box is displayed. Select the Bitmap map from the 

Figure 7-107  The brass material 
displayed in the sample slot

Maps > Standard rollout and choose the OK button; the 
Select Bitmap Image File dialog box is displayed. 

	
	 As the project folder is already set, the images folder is 

displayed in the Look in drop-down list of this dialog 
box.

9.	 Select the file Lakerem2.jpg from this dialog box and 
choose the Open button; the image is displayed in the 
selected sample slot, as shown in Figure 7-107. 

10.	 Choose the Go to Parent tool from the Material Editor 
dialog box. In the Maps rollout, set the value 50 in the Reflection spinner.

11.	 Make sure that flower pot is selected in the viewport and the brass material is selected in 
the Material Editor dialog box.
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12.	 Choose the Assign Material to Selection tool; the brass material is assigned to 
flower pot. 

13.	 Choose the Show Shaded Material in Viewport tool; the brass material is displayed on 
flower pot in the Perspective viewport, as shown in Figure 7-108.

Saving and Rendering the Scene
In this section, you will save the scene and then render it. You can also view the final rendered 
image of this model by downloading the c07_3dsmax_2014_rndr.zip file from www.cadcim.com. 
The path of the file is as follows: Textbooks > Animation and Visual Effects > 3ds Max > Autodesk 
3ds Max  2014: A Comprehensive Guide

1.	 Choose Save from the Application menu.

2.	 Activate the Perspective viewport. Next, choose the Render Production tool from the 
Main Toolbar; the Rendered Frame window is displayed. This window shows the final 
output of the scene, refer to Figure 7-109.

Figure 7-109  The final output after 
rendering

Figure 7-108  The brass material displayed in flower 
pot

 



Materials and Maps		         7-49

Tutorial 3
In this tutorial, you will assign a map to the LCD monitor, as shown in Figure 7-110. 		
	   					                                 (Expected time: 15 min) 

Figure 7-110  The model of LCD monitor

The following steps are required to complete this tutorial:

a.	 Create the project folder.
b.	 Download and open the file. 
c.	 Assign the map to the LCD screen.
d.	 Save and render the scene.

Creating the Project Folder
Create a new project folder with the name c07_tut3 at \Documents\3dsmax2014 and then save 
the file with the name c07tut3, as discussed in Tutorial 1 of Chapter 2.

Downloading and Opening the file
In this section, you will download and open the file.

1.	 Before starting the tutorial, download the c07_3dsmax_2014_tut.zip file from www.cadcim.com. 
The path of the file is as follows: Textbooks > Animation and Visual Effects > 3ds Max > 
Autodesk 3ds Max  2014: A Comprehensive Guide  

	
	 Extract the contents of the zipped file and save them in the Documents folder. 

2.	 Choose Open from the Application menu; the Open File dialog box is displayed. 
In this dialog box, browse to the location \Documents\c07_3dsmax_2014_tut and select 
the c07_tut3_start.max file in it. Choose the Open button to open the file, refer to 
Figure 7-111.

3.	 Choose Save As from the Application menu; the Save File As dialog box is displayed. 
Browse to the location \Documents\3dsmax2014\c07_tut3\scenes. Save the file with the 
name c07tut3.max at this location.
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Figure 7-111  The LCD computer in viewports 

Assigning the Map to the LCD Screen
In this section, you will apply an image to the LCD screen of the computer.

1.	 Display the image on your computer screen and press the PRT SCR keys. Next, open 
the Microsoft Paint software and press the CTRL+V keys to paste the image. Now, 
save the file with the name desktop_screen in the jpg format at the following location: 
\Documents\3dsmax2014\c07_tut3\sceneassets\images.

2.	 Select LCD monitor in the viewport and then choose Group > Open from the menubar. 
Select screen in any viewport and then choose the Compact Material Editor tool from the 
Main Toolbar; the Material Editor dialog box is displayed.

3.	 Select one of the sample slots from the Material Editor dialog box. In the Material Name 
drop-down list, enter screen and press the ENTER key. By default, the Standard material 
is displayed on the Material Type button. You will use the same material for assigning the 
map.

	 Next, you need to assign the desktop_screen.jpg image to the Diffuse map button.

4.	 Make sure that the Blinn shader is selected in the Shader Basic Parameters rollout.

5.	 In the Blinn Basic Parameters rollout, choose the Diffuse map button; the Material/Map 
Browser dialog box is displayed. Choose the Bitmap map from the Maps > Standard 
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rollout and choose the OK button; the Select Bitmap Image File dialog box is displayed. 
As the project folder is already set, the images folder is displayed in the Look in drop-down 
list of this dialog box. Select the file desktop_screen.jpg and then choose the Open button; 
the image is displayed in the selected sample slot. 

6.	 Choose the Go to Parent tool. 

7.	 In the Specular Highlights area, set the values as follows:

	 Specular Level: 40			   Glossiness: 16	 		  Soften: 0.1	

	 Next, you need to apply the map to screen. 

8.	 Make sure that screen is selected in the viewport and the screen material is selected in the 
Material Editor dialog box.

9	 Choose the Assign Material to Selection tool; the screen material is assigned to screen of 
LCD computer in the viewport.

10. Now, choose the Show Shaded Material in Viewport tool, if it is not already chosen; 
the screen material is displayed on screen in the Perspective viewport, as shown in 
Figure 7-112.  

Figure 7-112  The screen material assigned 
to the screen of the computer

	 You can also assign other materials or maps to different parts of the computer to give it 
a realistic look.

Saving and Rendering the Scene
In this section, you will save the scene and then render it. You can also view the final rendered 
image of this model by downloading the file c07_3dsmax_2014_rndr.zip from www.cadcim.com. 
The path of the file is as follows: Textbooks > Animation and Visual Effects > 3ds Max > Autodesk 
3ds Max  2014: A Comprehensive Guide

1. 	 Change the background color of the scene to white, as discussed in Tutorial 1 of 
Chapter 2.
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2.	 Choose Save from the Application menu.

3.	 Activate the Perspective viewport. Next, choose the Render Production tool from the 
Main Toolbar; the Rendered Frame window is displayed. This window shows the final 
output of the scene, refer to Figures 7-113 and 7-114.

Figure 7-114  The final output after 
rendering (view 2)

Figure 7-113  The final output after 
rendering (view 1)

 Self-Evaluation Test 
Answer the following questions and then compare them to those given at the end of this 
chapter:

1.	 Which of the following  keys is used to invoke the Slate Material Editor dialog box? 
	
		  (a) S	 				    (b) L
		  (c) M		  			   (d) G

2.	 Which of the following tools in the Material Editor dialog box is used to pick material 
from an object in the viewport to apply it to the active sample slot?

		  (a) Assign Material to Selection		 (b) Get Material
		  (c) Pick Material from Object		  (d) All of these	

3.	 Which of the following materials is known as the Compound material?
	
		  (a) Blend		  		  (b) Composite 
		  (c) Double-Sided	 		  (d) All of these
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4.	 Which of the following materials has the Templates rollout to insert preset materials to 
the objects? 

	
		  (a) Standard	 			   (b) Architectural		
		  (c) Raytrace	 			   (d) Composite	

5.	 Which of the following shaders in the Standard material is used to create elliptical 
highlights?

	
		  (a) Anisotropic	 			   (b) Blinn
		  (c) Metal		  		  (d) Phong

6.	 The __________ color swatch in the Basic Parameters rollout of shaders is used to specify 
the color of the objects in direct light. 

7.	 The __________ shader in the Standard material is used to create matte highlights.

8.	 The __________ material is used to provide highly realistic raytraced images.

9.	 The Material Editor dialog box is used to create new materials and maps for objects to 
make them look more realistic. (T/F)

10.	 The Get Material tool is used to select materials or maps for the selected sample slot.                                    
(T/F)

11.	 The Phong shader is very similar to the Oren-Nayar-Blinn shader. (T/F)

 Review Questions 
Answer the following questions:

1.	 Which of the following maps in the Material/Map Browser dialog box is a 2D map? 

		  (a) Checker		  		  (b) Bitmap
		  (c) Cellular	 			   (d) Wood

2.	 Which of the following Standard maps is used to select the Bitmap image file to make the 
objects realistic?

		  (a) Checker	 			   (b) Dent
		  (c) Bitmap				    (d) All of these

3.	 Which of the following maps is used to produce textures such as plaster and cement?

		  (a) Stucco	 			   (b) Speckle
		  (c) Splat	 			   (d) Smoke
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4.	 The Composite maps are used to modify or change the color of pixels in a material. 
(T/F)

5.	 You can apply maps to different materials using the Maps rollout. (T/F)

6.	 The Flat Mirror map is used to generate reflections and refractions based on the objects 
in the scene. (T/F)

7.	 The Anisotropic shader in the Standard material has two specular highlight 
controls. (T/F)

8.	 The __________ spinner in the Basic Parameters rollout of the Standard material is used 
to control the transparency of material.

9.	 The __________ material is used to create the preset materials such as Glass, Water, Paper, 
and so on.

10.	 The Ambient color swatch in the __________ material is used to specify the amount of 
absorption of the ambient light by the material. 

exercises
The rendered output of the models used in the following exercises can be accessed by 
downloading the c07_3dsmax_2014_exr.zip from www.cadcim.com. The path of the file is 
as follows: Textbooks > Animation and Visual Effects > 3ds Max > Autodesk 3ds Max 2014: A 
Comprehensive Guide

 Exercise 1                                                                

Start Autodesk 3ds Max 2014 and then perform the following operations:

Create an object in the viewport and choose the Compact Material Editor tool; the Material 
Editor dialog box will be displayed. Then, perform the following steps:

1.	 By default, the Standard material is selected. In the Shader Basic Parameters rollout, 
select the Anisotropic shader from the drop-down list. Modify the parameters of the 
Anisotropic Basic Parameters rollout and assign a material to the object in the viewport 
using the Assign Material to Selection tool. Then, render the Perspective viewport to 
notice the effects. Use different shaders in the drop-down list to notice the difference in 
the shaders.   	      

2.	 Choose the Get Material tool; the Material/Map Browser dialog box is displayed. Select the 
Architectural material from the material list in the dialog box. In the Templates rollout, 
select various preset materials from the drop-down list. Set the parameters for the selected 
materials using the Physical Qualities rollout. Then, assign a material to the object in the 
viewport using the Assign Material to Selection tool. Render the Perspective viewport to 
notice the effects in the output. Select different materials from the list displayed in the 
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Material/Map Browser dialog box and assign them to the objects to view various realistic 
effects in the objects. 

3.	 In the Standard material, select any shader from the drop-down list in the Shader Basic 
Parameters rollout. In the Basic Parameters rollout, select the Diffuse map button on the 
right of the Diffuse color swatch; the Material/Map Browser dialog box will be displayed. 
Select different maps from the maps list in the Material/Map Browser dialog box and 
assign the maps to the objects in the viewports. Next, render the Perspective viewport to 
notice the effects in the final output.   

4.	 In the Standard material, set the value below 100 in the Opacity spinner. Modify other 
parameters in the Basic Parameters rollout and assign material to the objects in the 
viewport. Next, render the Perspective viewport to notice the effect of opacity in the final 
output.  

5.	 Try to assign different maps and materials to all objects created in the previous chapters 
to make them more realistic. 

 Exercise 2                                                                 
Create the model of cups and glasses shown in Figure 7-115 using the Line tool and the Lathe 
modifier. To create the steel material, you need to use the Oren-Nayar-Blinn shader in the 
Standard material and the Reflection map in the Maps rollout.	   (Expected time: 15 min)	
	                                                                                                          

Figure 7-115  The model of cups and glasses

 

 Exercise 3                                                                 
Download the file c07_3dsmax_2014_exr.zip from www.cadcim.com. Extract the contents of the 
zipped file and open c07_exr3_start from it. Next, assign different maps and materials to give 
it a realistic view, as shown in Figure 7-116. 	   		    (Expected time: 15 min)
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Figure 7-116  The model of a room

		                

 Exercise 4                                                                
Create the model of tea cup in the viewport, as shown in Figure 7-117. Then, create a copper 
material using the Phong shader from the Standard material and assign it to the object. 		
								          (Expected time: 15 min)

Figure 7-117  The model of a tea cup

Answers to Self-Evaluation Test
1. c, 2. c, 3. d, 4. b, 5. a, 6. Diffuse, 7. Oren-Nayar-Blinn, 8. Raytrace, 9. T, 10. T, 11. F
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Figure 8-1  The Modify panel 

Figure 8-2  The cascading menu displayed on 
choosing the Convert To option

Figure 8-3  The shortcut 
menu displayed
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Figure 8-5  The sub-object levels of an 
object displayed

Figure 8-4  The Utilities rollout displayed 
after choosing the Utilities tab

Figure 8-6  Displaying the vertices of the sphere Figure 8-7  Displaying the vertices of the box

 Note
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Figure 8-8  Selecting the edges of the sphere Figure 8-9  Selecting the edge of the box

Figure 8-10  The face sub-object level Figure 8-11  A box with the faces selected 

Figure 8-13  A polygon of the box selected Figure 8-12  The polygon sub-object level 
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Figure 8-14  The element sub-object level Figure 8-15  The element of the box selected

 

Figure 8-16  The Soft Selection
rollout 

     

Figure 8-18  Additional face created in 
a box using the Create button

Figure 8-17  Additional vertices created 
in a box using the Create button
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Figure 8-19  The attach cursor after choosing the 
Attach button 

Figure 8-20  The Attach List dialog box

 

Figure 8-21  The Detach dialog box
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Figure 8-22  The box before choosing the 
Turn button

Figure 8-23  The rotated edge of the box 
after choosing the Turn button

Figure 8-25  The face divided after using the 
Divide button

Figure 8-24  The face before 
choosing the Divide button

Figure 8-26  The extrude cursor displayed 
over the selected polygon 

Figure 8-27  The selected polygon 
sub-object after extrusion

Figure 8-28  The selected polygon after negative extrusion
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Figure 8-29  The bevel cursor displayed over 
the selected polygon 

Figure 8-30  The polygon extruded

Figure 8-32  The increased size of the extruded 
polygon using the Bevel button

Figure 8-31  The reduced size of the extruded 
polygon using the Bevel button

Figure 8-33  The chamfer cursor displayed 
over the selected vertex 

Figure 8-35  The edge sub-object chamfered 
using the Chamfer button 

Figure 8-34   The vertex sub-object chamfered 
using the Chamfer button 
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Figure 8-37  The selected object sliced 
after choosing the Slice button

Figure 8-36  The slice plane gizmo 
displayed in the selected object

Figure 8-38  The dotted lines Figure 8-39  The cut on the object after 
using the Cut button

Figure 8-40  The cut on the selected 
polygon  

Figure 8-41  The selection box around the 
vertices to be welded 

Figure 8-42  The vertices welded together 
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Figure 8-43  The Weld message box

Figure 8-44  The vertices selected for 
welding 

Figure 8-45  The selected vertices welded 
to the target vertex 

Figure 8-46 Flyout displayed after moving the 
cursor over the Polygon Modeling panel
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Figure 8-47  The sub-object
 levels displayed

Figure 8-48  The border selected around the 
hole of the spout of a teapot

Figure 8-49  The maximized view of the border 
selected around the hole of the spout of a teapot
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Figure 8-51  The selection area in the teapotFigure 8-50  The Selection rollout with 
the Border sub-object level selected

Figure 8-52  The selection area in the teapot 
decreases after choosing the Shrink button

Figure 8-53  The selection area in the teapot 
increases after choosing the Grow button

Figure 8-54  An edge selected in a cylinder Figure 8-55  The parallel edges selected 
after choosing the Ring button
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Figure 8-56  The selected edge of the teapot Figure 8-57  The edges selected after 
choosing the Loop button

Figure 8-59  More than one polygon highlightedFigure 8-58  The selected sub-object
level highlighted 

Figure 8-60  The extruded polygon in 
a cylinder

Figure 8-61  The same extrusion on other polygons 
after choosing the Repeat Last button
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Figure 8-63  The box sliced in the Perspective 
viewport

Figure 8-62  The quick slice cursor and slice 
plane displayed 

Figure 8-64  Selecting the 
cylinder in the viewport

Figure 8-65  The cylinder smoothened 
after choosing the MSmooth button 

Figure 8-66  The MeshSmooth Selection caddy control

Figure 8-67  The Tessellate Selection 
caddy control

Figure 8-68  The drop-down list displayed after 
clicking on the arrow 



Modifying 3D Mesh Objects		         8-15

Figure 8-71  The box after selecting the 
Face radio button  

Figure 8-70  The box after selecting the Edge 
radio button  

Figure 8-69  A box

Figure 8-72  The Paint 
Deformation rollout
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Figure 8-74  The object deformed at 
the corner vertex

Figure 8-73  The brush displayed on 
choosing the Push/Pull button 

Figure 8-75  The Edit 
Vertices rollout

Figure 8-76  The vertices selected in the object Figure 8-77  The edge created between the 
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Figure 8-78  The Edit 
Edges rollout

Figure 8-79  The Connect Edges caddy control 
in the viewport

Figure 8-80  The Chamfer caddy control in 
the viewport

Figure 8-81  An edge selected to be chamfered Figure 8-82  The edge after chamfering 
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Figure 8-83  The number of segments 
increased in the chamfer

Figure 8-84  A hole created on selecting 
the Open Chamfer check box

Figure 8-85  The Create Shape 
dialog box

Figure 8-87  The spline created after using 
the Create Shape From Selection button

Figure 8-86  The edges selected in the box

Figure 8-88  The Edit 
Borders rollout
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Figure 8-89  The border selected in 
the spout of a teapot

Figure 8-90  The cap after choosing the 
Cap button 

Figure 8-91  The Edit 
Polygons rollout

Figure 8-92  The selected polygons 
in a sphere

Figure 8-93  The selected polygons after 
choosing the Outline button 
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Figure 8-94  The group of polygons inset 
on selecting the Group option

Figure 8-95  The Inset caddy control 
displayed

Figure 8-96  The drop-down list displayed in 
the Inset caddy control

Figure 8-98  The hinge created on choosing 
the Hinge From Edge button 

Figure 8-97  The polygon selected in the box
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Figure 8-99  The Hinge From Edge 
caddy control

Figure 8-100  The Extrude Along 
Spline caddy control

Figure 8-101  The polygon selected in the 
plane and the spline 

Figure 8-102  The selected polygon extruded 
along the spline 

Figure 8-103  An editable patch sphere 
with vector handles and interior vertices 

Figure 8-104  The vector handles in a plane 
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Figure 8-105  The patch sub-object selected in 
an editable patch sphere 

Figure 8-106  The element sub-object 
selected in an editable patch box

Figure 8-107  The Selection rollout 
with the Vertex button chosen

Figure 8-108  Partial view 
of the Geometry rollout

 . 
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Figure 8-109  The patch selected in an 
editable patch box

Figure 8-110  The selected patch subdivided 
on choosing the Subdivide button 

Figure 8-111  The selected patch subdivided 
after selecting the Propagate check box 

Figure 8-112  The open edge selected in 
the editable patch sphere 

Figure 8-113  The tri patch after choosing 
the Tri Patch button

Figure 8-114  The quad patch after choosing 
the Quad Patch button
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Figure 8-115  A golf ball model

Figure 8-116  The geosphere displayed in viewports  

Figure 8-117  The golf ball geometry zoomed in the 
Perspective viewport 
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Figure 8-118  Selected polygon of the golf ball 

Figure 8-119  All polygons in the golf ball selected

Figure 8-120  The edge selected on golf ball 
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Figure 8-121  All edges of golf ball selected

 

Figure 8-122  All edges of golf ball 
chamfered

Figure 8-123  All polygons in golf ball, except 
new hexagonal polygons selected

Figure 8-124  All hexagonal polygons of 
golf boll selected in the viewport 

Figure 8-125  Hexagonal polygons displayed 
after negative extrusion 
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Figure 8-127  The final output
 after rendering

Figure 8-126  The golf ball geometry after 
applying the Mesh Smooth modifier

Figure 8-129  The model of an LCD
 monitor (view 2)

Figure 8-128  The model of an LCD 
monitor (view 1)
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Figure 8-130  The box for the front portion of the monitor displayed in viewports

Figure 8-131  The Ignore 
Backfacing check box 
selected

Figure 8-132  All polygons selected in 
the Front viewport
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Figure 8-133  The Extrude Polygons caddy
 control

Figure 8-134  The extrusion effect displayed 
in the Perspective viewport 

Figure 8-135  Alignment of screen with front 
portion in the Left viewport

Figure 8-136  Alignment of screen with front 
portion in the Front viewport

Figure 8-137  Alignment of the back portion 
with the front part in the Left viewport
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Figure 8-138  A flyout showing various options to display views

Figure 8-139  The outer polygons selected in back portion
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Figure 8-140  The selected polygons uniformly 
scaled in back portion

Figure 8-141  The inner polygons selected 
in back portion

Figure 8-142  The selected polygons 
uniformly scaled to 90 percent

Figure 8-143  Selected polygons dragged 
horizontally

Figure 8-144  Alignment of the speaker with the monitor in viewports 
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Figure 8-145  Alignment of b01 with front portion in viewports 

Figure 8-146  Alignment of b002, b003, b004, b005, and b006 in viewports
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Figure 8-147  The LCD monitor displayed 
after rotating it in the Left viewport

Figure 8-148  The LCD monitor group 
displayed in the Perspective viewport

Figure 8-149  The support geometry moved in the Left viewport 

Figure 8-150  The support geometry zoomed in viewports
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Figure 8-151  The inner polygons of support selected 

Figure 8-152  The Extrude Polygons 
caddy control 

Figure 8-153  The value set in the Height 
spinner of the Bevel caddy control

Figure 8-154  The selected polygons in the Top 
viewport after extruding and beveling

Figure 8-155  The selected polygons in 
the Perspective viewport after extruding 
and beveling
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Figure 8-156  Alignment of support in viewports 

Figure 8-157  The view of Perspective viewport 
after using the Zoom and Orbit tools 

Figure 8-158  The polygons selected in the 
Perspective viewport 
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Figure 8-159  The back side geometry of 
LCD monitor in the Perspective viewport 

Figure 8-160  The selected polygons extruded 
in the Left viewport

Figure 8-161  The support geometry in the 
Left viewport after moving it horizontally

Figure 8-162  The support geometry in the 
Left viewport after extrusion 

Figure 8-163  The selected polygons of support 
in the Left viewport
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Figure 8-164  Model of the bed



Graphite Modeling 
Technique
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Figure 9-1  The graphite modeling toolset

 

Figure 9-2  The shortcut menu 
displayed on right-clicking the Main 
Toolbar
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Figure 9-3  The Polygon 
Modeling panel

Figure 9-4  The Polygon Modeling 
panel expanded

Figure 9-6  The Floor2 topology pattern 
displayed on the polygonal object

Figure 9-5  The Topology 
dialog box

Figure 9-7  The Smoothstar topology pattern
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Figure 9-8  Vertex moved without choosing 
the Use Soft Selection tool

Figure 9-9  Vertex moved after choosing the 
Use Soft Selection tool

Figure 9-10  The Edit panel

Figure 9-11  Checker map applied to 
an object

Figure 9-12  Checker map distorted before 
choosing the Preserve UVs tool

Figure 9-13  The checker map after choosing 
the Preserve UVs tool
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Figure 9-14  Checker map applied to an 
object

Figure 9-15  Checker map tweaked 
using the Tweak tool

Figure 9-16  A green colored gizmo displayed 
on the object

Figure 9-17  A new edge loop created using 
the SwiftLoop tool

Figure 9-19  The Geometry 
(All) panel

Figure 9-18  New segments created on 
an object using the Paint Connect tool

Figure 9-20  An object with a hole Figure 9-21  The hole covered after 
choosing the Cap Poly tool
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Figure 9-22  The Modify 
Selection panel

Figure 9-24  The polygons selected after 
choosing the Loop tool

Figure 9-23  A polygon selected to 
create a loop selection

Figure 9-25  Two polygons selected to 
create a loop

Figure 9-26  The loop created after 
choosing the Loop tool

Figure 9-27  The polygons selected 
on a sphere

Figure 9-28  The polygons selected after 
choosing the Grow Loop tool
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Figure 9-29  The loop selection Figure 9-30  The selected polygons after 
choosing the Loop Mode tool

Figure 9-31  Two adjacent polygons selected Figure 9-32  The selection loop on 
choosing the Dot Loop tool

Figure 9-33  Two adjacent polygons selected Figure 9-34  The sub-objects selected 
in the form of a ring

Figure 9-35  The edges selected Figure 9-36  The Modify 
Selection panel expanded

Figure 9-37  An ouline created 
around the selected edges
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Figure 9-38  Two polygons selected Figure 9-39  All sub-objects selected between 
the two selected polygons

Figure 9-40  The sub-objects selected 
to create a boundary

Figure 9-41  All sub-objects selected inside 
the defined boundary

Figure 9-42  The two vertices selected Figure 9-43  A new edge created between the 
two selected vertices

Figure 9-44  Multiple vertices connected on 
choosing the Connect tool
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Figure 9-45  The edges selected Figure 9-46  The selected edges connected 
by new edges

Figure 9-47  The Connect Edges caddy control Figure 9-48  Multiple edges created between 
the selected edges

Figure 9-49  Two vertices selected Figure 9-50  Connection made between the 
selected vertices

Figure 9-51  An edge selected on the 
sphere

Figure 9-52  The complete edge loop of the 
selected edge
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Figure 9-53  The polygons selected on 
an object

Figure 9-54  An edge loop created along the 
selected polygons using the Insert Loop tool

Figure 9-55  The two vertices selected Figure 9-56  A quad built at the ends of the 
two selected vertices

Figure 9-57  The edges selected Figure 9-58  Randomly connected edges
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Figure 9-59  The model of a acoustic guitar

Figure 9-60  The outline of the body of guitar

Figure 9-61  The outline created using the 
Outline spinner
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Figure 9-62  Duplicate copies of Line001

Figure 9-63  Line001 extruded

Figure 9-64  Different parts of the guitar aligned
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Figure 9-65  The circle aligned with soundhole_guitar

Figure 9-66  The circle attached to soundhole_guitar
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Figure 9-67  The body of the guitar in viewports

Figure 9-68  The profile curve created for the bridge

Figure 9-69  The expanded Polygon 
Modeling panel
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Figure 9-70  New segments created on the bridge

Figure 9-71  The selected polygon Figure 9-72  Choosing the Bevel 
Settings button from the Bevel 
drop-down

Figure 9-73  The beveled polygons
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Figure 9-74  The bridge geometry aligned with guitar body

Figure 9-75  The profile curve for neck
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Figure 9-76  The vertices scaled down

Figure 9-77  The new edge slice loop added

Figure 9-78  Alignment of vertices
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Figure 9-79  The neck aligned with the guitar

Figure 9-80  Profile curve for the head

Figure 9-81  The head aligned with the neck
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Figure 9-82  The modified box Figure 9-83  The vertices modified to 
create a key shape

Figure 9-84  The polygons selected

Figure 9-85  The polygons rotated Figure 9-86  Key after applying the
 MeshSmooth modifier
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Figure 9-87  Key aligned with guitar

Figure 9-88  The keys aligned with the head

Figure 9-89  The polygons selected
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Figure 9-90  The string capstan aligned in viewport

Figure 9-91  The fret vertex aligned

Figure 9-92  The frets geometry duplicated and aligned with neck of guitar
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Figure 9-93  The string1 geometry aligned with neck of guitar

Figure 9-94  All strings aligned with neck of guitar
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Figure 9-95  The rendered model of the guitar



NURBS Modeling
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Figure 10-1  A point curve Figure 10-2  The tools for creating  
NURBS curves

Figure 10-3  The Create 
Point Curve rollout

Figure 10-4  A CV curve
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Figure 10-5  A point surface Figure 10-6  The tools displayed 
to create NURBS Surfaces

Figure 10-7  The Create 
Parameters rollout

Figure 10-8  The points in the point 
surface moved up

 

Figure 10-9  A CV surface
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Figure 10-10  The Create 
Parameters rollout

Figure 10-11  The 
General rollout 

Figure 10-13  The NURBS surface 
object displayed as iso lines  

Figure 10-12  The NURBS surface 
object displayed as a mesh object 
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Figure 10-14  The NURBS surface 
object displayed as shaded lattices

Figure 10-15  The NURBS toolbox

Figure 10-16  The Display 
Line Parameters rollout

Figure 10-17  The dependent and independent 
sub-objects in a loft object

Figure 10-18  The Create 
Points rollout

Figure 10-20  The independent points 
created in the viewport

Figure 10-19  The cursor displayed to 
create independent points
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Figure 10-21  The Offset Point rollout Figure 10-22  The offset point displayed

Figure 10-23  The red line displayed between 
the parent point and the offset point

 

Figure 10-25  A blue box displayed along 
with the cursor 

Figure 10-24  The Curve Point rollout
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Figure 10-26  A curve point placed 
on the curve

Figure 10-27  The curve after selecting 
the Trim Curve check box

Figure 10-28  The curve after selecting 
the Flip Trim check box

Figure 10-29  The intersection point created Figure 10-30  The blue lines displayed
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Figure 10-31  A seed created on the 
NURBS curve

Figure 10-32  A surface curve intersection 
point created in the Left viewport

Figure 10-33  A surface curve intersection 
point created in the Top viewport

Figure 10-34  The Create 
Curves rollout
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Figure 10-35  The changed shape of the 
cursor

Figure 10-36  The new CV curve 
created

Figure 10-37  The new CV curve 
attached to the NURBS object

Figure 10-38  A NURBS curve object Figure 10-39  A fit curve created between the 
points in a NURBS curve object

Figure 10-40  A NURBS curve object Figure 10-41   A transform curve created
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Figure 10-42  A NURBS curve to create a chamfer curve

Figure 10-43  The seeds placed on 
the curves

Figure 10-44  A chamfer curve 
created

Figure 10-45  A surface edge 
curve created

Figure 10-46  The Create 
Surfaces rollout
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Figure 10-47  The cursor placed over 
another edge

Figure 10-48  A blend surface created

Figure 10-49  The cursor displayed to 
create the ruled surface

Figure 10-50  A ruled surface created

Figure 10-52  A U loft surface createdFigure 10-51  The green iso lines of the U loft 
surface displayed

    

Figure 10-53  The curves to create 
1-rail surface

Figure 10-54  A 1-rail surface created
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Figure 10-55  An open ended 
closed surface 

Figure 10-56  A cap created to cap the 
open end of the closed surface 

   

Figure 10-57  The sub-object levels 
displayed in the modifier stack

Figure 10-58  The quad menu displayed

    	

Figure 10-59  The model of a washbasin
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Figure  10-60  All ellipses displayed in viewports

Figure 10-61  All NURBS curves scaled in the Front viewport
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Figure 10-62  A NURBS surface created in viewports

Figure 10-63  The washbasin modified at the Curve sub-object level

Figure 10-64  A number of capsules created and aligned
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Figure 10-65  A sieve created in the Perspective viewport

Figure 10-66  A sieve created and aligned in viewports

 

Figure 10-67  A duct created and aligned in viewports
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Figure 10-68  The duct geometry rotated and aligned in viewports

Figure 10-69  The vertices of duct 
aligned in the Left viewport
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Figure 10-70  The washbasin slab created and aligned in viewports

Figure 10-71  The inner polygons selected to 
be deleted 

Figure 10-72  The washbasin slab after 
deleting the polygons 
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Figure 10-73  The vertices moved to view the 
inner portion of washbasin

Figure 10-75  The line spline created in 
the Left viewport

Figure 10-74  The tap01 geometry created 
and aligned in viewports

Figure 10-76  Alignment of upper tap and base 
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Figure 10-77  Alignment of the main tap in viewports 

Figure 10-78  The final output at rendering
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Figure 10-79  The model of cap (view 1) Figure 10-80  The model of cap (view 2)

	

Figure 10-82  The Circle001 
spline scaled along the X-axis

Figure 10-81  The Scale Transform 
Type-In dialog box

Figure 10-83  The Rebuild CV 
Curve dialog box
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Figure 10-84  The circular NURBS curves displayed in viewports

Figure 10-85  The Circle001 spline 
moved vertically
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Figure 10-86  The Circle001 and Circle002 
splines scaled vertically

Figure 10-87  A NURBS surface created
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Figure 10-88  The NURBS surface capped at one end

Figure 10-89  The NURBS curves  
modified in the Front viewport
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Figure 10-90  The outer control vertices  
moved vertically

Figure 10-91  The surface modified at the sub-object level

Figure 10-92  The final output after rendering
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Figure 10-93  The NURBS curve to create 
the model of heart

Figure 10-94  The model of heart



Compound Objects
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Figure 11-1  The tools for 
creating compound objects 
displayed in the rollout

Figure 11-2  Two overlapping objects created
in the viewport

Figure 11-4  The object after performing 
the boolean operation

Figure 11-3  Partial view of the rollouts displayed 
on invoking the Boolean tool
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i

Figure 11-7  Two spheres in the perspective viewport after 
performing the Union boolean operation

Figure 11-5  Two spheres in the Top viewport 
before performing the Union boolean operation

Figure 11-6  Two spheres in the Top viewport after 
performing the Union boolean operation

Figure 11-8  Two spheres for the 
Intersection boolean operation 

Figure 11-9  Two spheres after performing 
the Intersection boolean operation 

Figure 11-11  The boolean object 
after performing the Subtraction  
(B-A) boolean operation 

Figure 11-10  The operand A and B 
selected for performing the Subtraction 
(B-A) boolean operation



11-4				                Autodesk 3ds Max 2014: A Comprehensive Guide

Figure 11-13  The contour lines aligned for 
the terrain object in the Front viewport

Figure 11-12  The contour lines created for 
the terrain object in the Top viewport

Figure 11-14  The terrain object 
created from the contour lines

Figure 11-15  The 
Pick Operand rollout

Figure 11-16  Different areas 
in the Parameters rollout

Figure 11-17  The terrain object with the 
Layered Solid radio button selected
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Figure 11-18  Different areas in the 
Simplification rollout

 

Figure 11-19  The distribution and 
source objects 

Figure 11-20  The duplicates of the source objects 
distributed over the distribution object  

Figure 11-21  The Pick Distribution Object rollout

  

Figure 11-22  The Objects 
area

Figure 11-23  The Source 
Object Parameters area
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Figure 11-24  Two spheres with holes 
on their surfaces

Figure 11-25  The spheres after performing 
the Connect operation
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Figure 11-26  the rollouts 
displayed after invoking 
the Connect tool
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Figure 11-27  Two splines to create a loft object

Figure 11-29  The loft object created Figure 11-28  Partial view of the rollouts 
displayed after invoking the Loft tool

Figure 11-30  The Deformations 
rollout
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Figure 11-31  The Scale Deformation(X) dialog box

Figure 11-32  The loft object modified 
using the Scale tool

Figure 11-33  The loft object modified 
using the Twist tool

Figure 11-35  The loft object modified 
using the Bevel tool

Figure 11-34  The loft object modified 
using the Fit tool

Figure 11-36  The loft object modified 
using the Teeter tool
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Figure 11-38  The shape embedded in 
the mesh object

Figure 11-39  The shape subtracted  
from the mesh object

Figure 11-40  Partial view of the rollouts displayed 
after invoking the ShapeMerge tool

Figure 11-37  Alignment of the shape 
with the mesh object 

Figure 11-42  The road (Wrapper object) over 
a hilly area (Wrap-To object) after using the 
Conform tool

Figure 11-41  The road (Wrapper object) over 
a hilly area (Wrap-To object) before using the 
Conform tool
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Figure 11-43  The objects to perform 
the proboolean operation in the Front 
viewport

Figure 11-44  The objects to perform the 
proboolean operation in the Perspective 
viewport

Figure 11-45  The objects after performing 
the proboolean operation in the Front 
viewport

Figure 11-46  The objects after performing 
the proboolean operation in the Perspective 
viewport

Figure 11-47  The two spheres intersecting 
each other to perform the boolean operation

Figure 11-48  The proboolean object after 
performing the boolean operation

 

Figure 11-49  The proboolean object after 
selecting the Imprint check box 

Figure 11-50  The proboolean object after 
selecting the Cookie check box 
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Figure 11-52  The proboolean 
object after selecting the Apply 
Operand Material radio button

Figure 11-53  The proboolean 
object after selecting the Retain 
Original Material radio button 

Figure 11-51  The two 
spheres with materials 
applied on them 

Figure 11-54  The cutter and stock objects 
aligned for the procutter operation

Figure 11-55  The cutter and stock objects 
before performing the procutter operation in 
the Front viewport

Figure 11-56  The cutter and stock objects after 
performing the procutter operation
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Figure 11-58  The cutter and stock objects after 
selecting the Cutter Outside Stock check box

Figure 11-57  The cutter and stock objects after 
selecting the Stock Inside Cutter check box

Figure 11-59  The toothpaste model

Figure 11-60  The Circle001, Circle002, and Line001 splines in viewports 
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Figure 11-61  The Rectangle001 in viewports

	

Figure 11-62  A shape created along the path spline (Line001)
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Figure 11-63  The shape of the tube created along the path spline

Figure 11-64  The shape of tube created in viewports
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Figure 11-65  The cap01 geometry zoomed in viewports

Figure 11-66  The cap002  geometry 
displayed

Figure 11-67  The cap002 geometry  
after the alignment

Figure 11-68  The cap01 after performing the Subtraction(A-B) 
boolean operation in viewports
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Figure 11-69  The selected polygons of the cap01

Figure 11-70  The Named Selection Sets 
drop-down list

Figure 11-71  The extruded polygons 
in the Perspective viewport

Figure 11-72  The objects in viewports
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Figure 11-73  The cap01 geometry in viewports after aligning with toothpaste tube

 

Figure 11-75  The map on the toothpaste tube 
after applying the UVW Map modifier

Figure 11-74  The map on the toothpaste tube  

Figure 11-76  The toothpaste tube 
after assigning the map 
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Figure 11-77  The Twist Deformation dialog box

Figure 11-78  The first vertex point moved in the Twist Deformation dialog box
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Figure 11-79  On applying Twist the tent on other sides is distorted 

Figure 11-80  The final output 
after rendering (view 1)

Figure 11-81  The final output 
after rendering (view 2)

Figure 11-82  Scene for Tutorial 2
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Figure 11-83  All vertices displayed in viewports

 

Figure 11-84  A vertex selected in the 
Top viewport

Figure 11-85  The vertices selected after 
choosing the Grow button 

Figure 11-86  The selected vertices dragged 
up in the Front viewport

Figure 11-87  The selected vertices dragged 
up in the Perspective viewport
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Figure 11-89  The hilly surface after applying 
the MeshSmooth modifier 

Figure 11-88  The hilly surface created using 
the vertices of the plane 

Figure 11-90  The plane after assigning the map to it in the Perspective viewport

Figure 11-91  The plane after using the viewport navigation tools 
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Figure 11-92  A close line spline 
created in the Top viewport 

Figure 11-93  Four copies of the line 
splines created in the Front viewport

Figure 11-94  The scaled lines after using the 
Select and Uniform Scale tool 

  

Figure 11-95  The terrain object created in viewports
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Figure 11-96  The map assigned to hill01

Figure 11-97  The hill01 after scaling 
and aligning with the ground 

Figure 11-98  The hills displayed after 
scaling and alignment 

Figure 11-99  Alignment of the tree01 in viewports
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Figure 11-100  Alignment of trees in viewports

Figure 11-101  The line created in the Top viewport
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Figure 11-102  The road geometry aligned with ground

Figure 11-103  The road after assigning the map to it

Figure 11-104  The scene after using the Conform tool
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Figure 11-105  The final output of the scene

 

Figure 11-106  Model to be created in Exercise 2 

Figure 11-107  Model to be created in Exercise 3 



Modifiers
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Figure 12-1  The Modifier List 
drop-down list 

Figure 12-2  Partial view of the Modifier 
List drop-down list 

Figure 12-3  The modifier stack
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Figure 12-4  The shortcut menu 
displayed on right-clicking on the 
modifier in the modifier stack 

Figure 12-5  Partial view of the 
rollouts displayed on selecting the 
Mesh Select modifier 

Figure 12-6  The Displacement 
area in the Parameters rollout
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Figure 12-8  The bitmap image that has been 
used for displacement in Figure 12-7

Figure 12-7  The plane after using the 
bitmap image in the Displace modifier 

Figure 12-9  The plane after using the 
map image in the Displace modifier 

Figure 12-10  The map image that has been 
used for displacement in Figure 12-9

Figure 12-11  The 
Parameters rollout
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Figure 12-12  The text spline before 
applying the Extrude modifier

Figure 12-13  The text spline after 
applying the Extrude modifier

Figure 12-14  The 
Parameters rollout

 

Figure 12-16  The object after applying 
the Melt modifier

Figure 12-15  The object before 
applying the Melt modifier
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Figure 12-17  The Optimization Level rollout

 

Figure 12-18  The object before 
applying the ProOptimizer modifier

Figure 12-19  The object after
applying the ProOptimizer modifier

 

Figure 12-20  The 
Parameters rollout

Figure 12-21  The faces selected to 
be extruded in a sphere 

Figure 12-22  The selected faces 
extruded  
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Figure 12-23  The sphere after applying 
the Lattice modifier 

Figure 12-24  Partial view of 
the Parameters rollout

        

Figure 12-26  The sphere after selecting the 
Struts Only from Edges radio button 

Figure 12-25  The sphere after selecting the 
Joints Only from Vertices radio button 
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Figure 12-28  The object displayed 
in two different colors after applying 
the Material modifier

Figure 12-27  Partial view of the Multi/Sub-Object 
Basic Parameters rollout in the Material Editor 
dialog box

Figure 12-29  The 
Parameters rollout
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Figure 12-30  The plane with the Noise 
modifier applied

Figure 12-31  The plane with the 
Fractal checkbox selected

Figure 12-32  The 
Parameters rollout

Figure 12-33  The Twist modifier 
applied to the pyramid object

Figure 12-34  The Twist modifier applied 
to a portion of the pyramid object using the 
options in the Limits area  
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Figure 12-35  The Line spline 
created to apply the Lathe modifier

Figure 12-36  The Line spline 
after applying the Lathe modifier

Figure 12-37  Partial 
view of the Parameters 
rollout

Figure 12-38  The surface before applying 
the MeshSmooth modifier

Figure 12-39 The surface after 
applying the MeshSmooth modifier

 

Figure 12-40  The Subdivision 
Amount rollout
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Figure 12-42  The selected sub-objects 
converted into triangular faces after 
applying the Tessellate modifier

Figure 12-41  The sub-objects selected in a 
object to apply the Tessellate modifier

Figure 12-43  The 
Parameters rollout

Figure 12-44  The selected sub-objects 
converted into polygonal faces after 
choosing the Polygons button

Figure 12-45  The selected sub-objects 
converted into triangular faces after 
choosing the Face-Center radio button
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Figure 12-46  The 
Parameters rollout

Figure 12-48  The plane after applying 
the Push modifier

Figure 12-47  The selected sub-objects of a 
plane before applying the Push modifier 

Figure 12-50  The inner and outer materials 
interchanged after applying the Normal modifier

Figure 12-49  The object with two different 
materials on the inner and outer sides 

Figure 12-51  The Parameters rollout
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Figure 12-52  Partial view 
of the Parameters rollout

 

Figure 12-53  A box with the Planar mapping coordinate

Figure 12-54  A cylinder with the Cylindrical 
mapping coordinates

Figure 12-55  The Cylindrical mapping 
coordinates applied to a cylinder and its cap
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Figure 12-56  The Spherical mapping 
coordinates applied to a sphere

Figure 12-57  The Shrink Wrap mapping 
coordinates applied to a sphere

Figure 12-58  The Box mapping 
coordinates applied to a box

Figure 12-59  The Face mapping 
coordinates applied to a sphere

               

Figure 12-60  Coordinates of the object 
adjusted to match the new shape
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Figure 12-61  The FFD 2x2x2 modifier 
applied to an object

Figure 12-62  The FFD 3x3x3 
modifier applied to an object

Figure 12-63  The FFD 4x4x4 
modifier applied to an object

Figure 12-64  A box object with the 
FFD(box) modifier applied

Figure 12-65  A cylindrical object 
with the FFD(cyl) modifier applied
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Figure 12-66  The sub-object 
levels in the modifier stack 

   

Figure 12-67  The FFD modifier 
applied to the objects

Figure 12-68  The shape of the object modified 
after transforming the control points

Figure 12-69  Partial view 
of the FFD Parameters 
rollout
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Figure 12-70  The Set FFD Dimensions 
dialog box

 

Figure 12-71  A tennis racket model

	  

Figure 12-72  The plane created in the 
Top viewport

 

Figure 12-73  The vertices of the stringed area 
displayed in the Top viewport
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Figure 12-74  A selection box dragged around 
the vertices using the Zoom Region tool

Figure 12-75  The selected area zoomed in

Figure 12-76  The vertices arranged 
into the shape of the head 

Figure 12-77  The objects after invoking 
the Zoom Extents tool

	  

Figure 12-79  The stringed area after 
applying the Lattice modifier

Figure 12-78  All outer vertices aligned to 
the shape of the head 
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Figure 12-81  A line created around 
the racket head

Figure 12-80  The racket head in 
the Top viewport

Figure 12-82  Alignment of the shaft01 
at the bottom of the racket head

Figure 12-83  Alignment of the shaft002 
at the top of the racket head

Figure 12-84  Alignment of handle in viewports
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Figure 12-85  The final output

 							     

Figure 12-86  The water surface
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Figure 12-87  The water surface in viewports

Figure 12-88  The water surface displayed after entering the values in the 
Parameters rollout of the Noise modifier
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Figure 12-89  Choosing the Open Material Library option from the 
flyout

Figure 12-90  The final output of the scene after rendering
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Figure 12-91  The model of a basket

	

Figure 12-92  The model of a chair

Figure 12-93  The model of a bowl



Lights and Cameras
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Figure 13-1  The tools to 
create standard lights in 
the Object Type rollout

Figure 13-2  The General 
Parameters rollout

                                         

Figure 13-3  The scene without any light Figure 13-4  The scene with the omni 
lights applied

Figure 13-5  The cascading menu displayed 
in the viewport

Figure 13-6  The quad menu displayed 
in the viewport
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Figure 13-7  The shadow of the object 
displayed in the Perspective viewport

Figure 13-8  The Light Lister dialog box

Figure 13-9  The Exclude/Include dialog box
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Figure 13-11  The effect of light 
on selecting the None option

Figure 13-10  The Intensity/
Color/Attenuation rollout

Figure 13-13  The effect of light on 
selecting the Inverse Square option

Figure 13-12  The effect of light on 
selecting the Inverse option

Figure 13-14  The Advanced 
Effects rollout

Figure 13-15  The Shadow 
Parameters rollout

Figure 13-16  A dent map 
used as a shadow map
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Figure 13-17  The Atmospheres 
& Effects rollout

Figure 13-18  The lens effect applied to 
the omni light 

Figure 13-19  The Add Atmosphere 
or Effect dialog box

Figure 13-20  The Environment and 
Effects dialog box
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Figure 13-21  The effect of the target spot 
light with the Volume Light effect

Figure 13-22  The target spot light

 

Figure 13-23  The 
Spotlight Parameters 
rollout

 

     

Figure 13-24  The free spot light



Lights and Cameras		         13-7

 

Figure 13-25  The effect of the target 
direct light

Figure 13-26  The target direct light

Figure 13-27  The Directional 
Parameters rollout

.

Figure 13-28  The free direct light

Figure 13-29  The skylight Figure 13-30  The effect of the skylight
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Figure 13-31  The Skylight 
Parameters rollout

  

Figure 13-32  The effect of the area omni light 

Figure 13-33  The Choose Renderer button 
highlighted in the Assign Renderer rollout

Figure 13-34  The Choose Renderer 
dialog box

Figure 13-35  The Area 
Light Parameters rollout
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Figure 13-36  The effect of the area spot light Figure 13-37  The Area 
Light Parameters rollout

   

Figure 13-38  Various tools 
to create Photometric lights

Figure 13-39  The Photometric Light Creation message box
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Figure 13-40  The Templates rollout Figure 13-41  The drop-down list 
displayed to select the type of light

Figure 13-42  The Intensity/
Color/Attenuation rollout

    

Figure 13-43  The 
Shape/Area Shadows 
rollout
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Figure 13-44  The Viewport Configuration dialog box

Figure 13-45  The Add Default Lights to 
Scene dialog box

 

Figure 13-46  The selection cursor displayed 
after invoking the Place Highlight tool

Figure 13-47  The light aligned as per the 
selection of the face of the object
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Figure 13-49  The free cameraFigure 13-48  The target camera

    

 

Figure 13-50  The Object 
Type rollout with tools to 
create cameras  

Figure 13-52  Partial view 
of the Parameters rollout

Figure 13-51  The cascading menu displayed on choosing
 the Cameras option
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Figure 13-54  The Camera viewport 
before alignment

Figure 13-53  The cursor displayed on the 
object to get the proper alignment

Figure 13-56  The Camera viewport after 
using the Align Camera tool 

Figure 13-55  The new position of the 
camera after using the Align Camera tool

 
                                    

Figure 13-57  The scene to be created
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Figure 13-58  A plane created for the water surface in viewports 

Figure 13-59  Alignment of the Camera001 in viewports
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Figure 13-60  The background after scaling

Figure 13-61    Camera001 and background aligned in viewports
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Figure 13-62  The scene after rendering

Figure 13-63  Alignment of Omni001 in viewports
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Figure 13-64  Alignment of Omni002 in viewports

Figure 13-65  The Lens Effects Parameters rollout
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Figure 13-66  The final output of the scene

Figure 13-67  The illuminated room
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Figure 13-68  The Wall001 geometry created in viewports

Figure 13-69  Alignment of Camera001 in viewports
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Figure 13-70  The roof geometry aligned at the top of Wall001 in viewports  

Figure 13-71  Alignment of box with Wall001 in viewports



Lights and Cameras		         13-21

Figure 13-72  A hole created in Wall001

	

Figure 13-73  Alignment of window in viewports
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Figure 13-74  The window geometry after applying the Lattice modifier

Figure 13-75  The design01 geometry zoomed 
to its extent in the Perspective viewport

Figure 13-76  The inner edges selected in 
design01

Figure 13-77  The selected edges after 
chamfering 

Figure 13-78  The polygon selected to be 
extruded
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Figure 13-79  The design01 displayed after extruding the alternate polygons

 

Figure 13-80  Alignment of all designs in viewports
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Figure 13-81  Alignment of all designs at the joining point of the Wall001 and roof

	   

Figure 13-82  The Omni001 light in viewports
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Figure 13-83  Alignment of the Direct001 light in viewports

Figure 13-84  The final output after rendering
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Figure 13-85  The teapot model

Figure 13-86  The target spot lights illuminating the 
wall

Figure 13-87  Various lights illuminating 
the room
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Figure 13-88  The scene illuminated by the 
spot lights



Animation Basics
 Learning Objectives
After completing this chapter, you will be able to:
• Work with the time slider
• Understand animation playback controls
• Understand animation and time controls
• Morph compound object
• Render and preview an animation
• Understand rendering effects
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Introduction
In 3ds Max, you can create different types of animation. You can create character animation 
and animation based on different types of motions that you see in real life. You can also create 
special lighting effects in your scene by animating lights and cameras.  

The basic concept of computer animation is to define different positions, rotations, and scale 
of an object at different key points in a sequence in the time slider. These defined points are 
known as keyframes. The interpolation between the keyframes consists of the information of 
the actions performed between those keyframes. When you play the animation, the computer 
plays a series of frames quickly and the object seems to be moving. In 3ds Max, the standard 
frame rate is 30 frames per second. It means, if you want to create an animation for one 
minute, then you need to adjust about 1,800 frames. Therefore, before starting an animation, 
you need to calculate the frames according to the time limit. 

Time Slider and Animation Playback Controls
3ds Max provides various options to animate the objects that you create in it. To do so, you 
need to be familiar with the animation playback controls and time slider. These controls enable 
you to play, pause, and stop an animation. They are available at the lower right corner of the 
3ds Max interface and are discussed here briefly.

Time Slider
The time slider displays the current frame and the total 
number of frames in the current time segment, refer to 
Figure 14-1. You can view the animation at each frame by 
dragging the time slider. 

Figure 14-1  The time sliderNote
The time segment is the total range of frames that you can access using the time slider. By default, 
it ranges from 0 to 100. You can set the range using the Time Configuration dialog box. You 
will learn about this dialog box in the later section.   

Animation Playback Controls
The animation playback controls are used to play and stop the animation in the active viewport. 
These controls are discussed next.

The Play Animation button is used to play or start the animation in the active viewport. 
When you click on the Play Animation button, it turns into a stop button.

The Stop Animation button is used to stop the animation. This button is displayed 
when you play the animation.

The Go to Start button is used to set the time slider at the first frame of the active 
time segment.

The Go to End button is used to set the time slider at the last frame of the active time 
segment.
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The Previous Frame button is used to move the time slider one frame at a time in 
the reverse direction. You can view the current frame on the time slider when it moves 
from one frame to another.

The Next Frame button is used to move the time slider one frame at a time in the 
forward direction.

Figure 14-2  The time control tools

Understanding Animation and Time Controls 
In 3ds Max, different types of tools are available at the bottom of the screen to control 
animation and its time settings, refer to Figure 14-2. You have already learned about the time 
slider and the animation playback controls in the previous section. The other controls are 
discussed next.

Toggle Auto Key Mode  
The Toggle Auto Key Mode button that is labeled as Auto Key is used to turn on the 
auto key animation mode. When you choose the Toggle Auto Key Mode button, it 
turns red. Also, the background of the time slider and the border of the active viewport 
turns red, indicating that you are in the animation mode. Now, if you make any changes in 
the object, the changes will be keyframed in the time slider. 

To perform an animation using the Toggle Auto Key Mode button, first you need to 
make sure that the object that you want to animate is selected in the viewport. Choose 
the Go to Start button to set the time slider to the first frame. Next, choose the Toggle 
Auto Key Mode button to turn on the auto key animation mode; it will turn red. Now,  
drag the time slider to a frame other than 0 and animate the selected object by modifying 
its parameters or by transforming the object; a keyframe will be created on that frame and at 
frame 0 on the track bar below the time slider. Again, move the time slider to another frame 
and change the parameters. You can continue this process until you get all the keyframes in 
a sequential order for your animation. Next, choose the Toggle Auto Key Mode button again 
to turn it off. Choose the Play Animation button to view the animation of the selected object 
in the current viewport.   
 

Toggle Set Key Mode
The Toggle Set Key Mode button that is labeled as Set Key is used to turn on the set  
key animation mode. In this mode, you need to set keys for the animation of the 
selected object by choosing the Set Keys button on the left side of the Toggle Set Key  
Mode button. 
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To perform an animation using the Toggle Set Key Mode button, select the object in the 
viewport that you want to animate. Choose the Go to Start button to set the time slider to the 
first frame. Next, choose the Toggle Set Key Mode button to turn on the set key animation 
mode; the button will turn red. Choose the Set Keys button; it will flash in red color and a 
keyframe will be set for the current position of the selected object. Now, drag the time slider to 
set a frame other than 0 and animate the selected object. Again, choose the Set Keys button; 
it will flash in red color and another keyframe will be set on the track bar for the changed 
position. You can continue this process until you get all the keyframes in a sequential order for 
your animation. Then, choose the Toggle Set Key Mode button to turn it off. Also, choose the 
Play Animation button to view the animation of the selected object in the current viewport. 

Note
If you transform an object when the Toggle Set Key Mode button is chosen, then the keyframe 
will be set only when you choose the Set Keys button. 

Current Frame (Go To Frame)
The value in this spinner shows the current frame number at which the time slider is positioned. 
While animating your scene, if you want to go to another frame, you can enter the frame 
number directly in the Current Frame (Go To Frame) spinner. As you drag the time slider, 
the value in the Current Frame (Go To Frame) spinner will change automatically according 
to its position. 

Key Mode Toggle
By default, the Key Mode Toggle button is not activated. If activated, it allows you to jump 
between the keyframes directly. To understand the function of this button, you need to select 
the animated object in the viewport. Next, choose the Key Mode Toggle button; the Previous 
Frame and Next Frame buttons in the animation playback controls will be replaced with the 
Previous Key and Next Key buttons, refer to Figures 14-3 and 14-4. Choose the Previous 
Key or Next Key button to move the time slider from one keyframe to the other.

Figure 14-3  Animation playback controls 
before choosing the Key Mode Toggle button

Figure 14-4  Animation playback controls after 
choosing the Key Mode Toggle button

Time Configuration
The Time Configuration button is used to set the length of an animation by defining the number 
of frames in the track bar. It is also used to set the frame rate, time display, and so on. To set 
these parameters, choose the Time Configuration button; the Time Configuration dialog box 
will be displayed, as shown in Figure 14-5. You need to use the options in this dialog box to set 
the animation length, frame rate, and time display. The options in this dialog box are discussed 
next.
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Frame Rate Area
There are four radio buttons in this area, namely NTSC, Film, PAL, 

Figure 14-5  The Time 
Configuration dialog box

and Custom. These radio buttons are used to define a particular 
frame rate for the animation in frames per second. By default, 
the NTSC radio button is selected. On selecting the Custom 
radio button, the FPS spinner is activated wherein you can 
specify the frame rate in seconds for the animation.

Time Display Area
The radio buttons in this area are used to define the method of 
time displayed in the time slider. The radio buttons in this area 
are Frames, SMPTE, FRAME: TICKS, and MM:SS: TICKS. 
By default, the Frames radio button is selected.

Playback Area
This area is used to specify the playback speed and the viewport 
that will be playing the animation. By default, the Real Time 
check box in this area is selected. As a result, animation is 
played at the selected playback speed and it skips the frames 
so that the animation synchronizes with the current frame rate 
settings. You can select one of the radio buttons such as 1/4x, 1/2x, and so on in the Speed 
group to define the speed of the animation. If you clear the Real Time check box, then the 
Speed group will be deactivated and the Direction group will be activated. The radio buttons 
in the Direction group are used to define the direction of the animation. The direction of 
the animation can be forward, reverse, or ping-pong. The ping-pong direction means that 
first the animation will be played in the forward direction and then in the reverse direction. 
The Active Viewport Only check box is selected by default and is used to play the animation 
only in the active viewport. If you clear this check box, then the animation will be played in 
all viewports, simultaneously. The Loop check box is also selected by default and is used to 
play the animation repeatedly.     

Animation Area
The options in this area are used to set the length of animation. The default values in the 
spinners of this area specify the number of frames for the animation. The Start Time and 
End Time spinners are used to specify the current time segment in the time slider. The 
current time segment is the total range of frames that you can access using the time slider. 
The Length spinner is used to specify the total number of frames in the current time segment 
or the length of the animation. The Frame Count spinner is used to specify the number of 
frames that will be rendered. The Current Time spinner is used to specify the current frame 
number at which the time slider is positioned. If you choose the Re-scale Time button, the 
Re-scale Time dialog box will be displayed. You can specify the options in this dialog box to 
change the existing time segment to a new time segment.       

Track Bar
The track bar lies between the time slider and the status bar. It shows a timeline with the frame 
numbers in it, as shown in Figure 14-6.
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Figure 14-6  Partial view of the track bar 

Track View
  Menu bar:	   Graph Editors > Track View - Curve Editor	  
		    Graph Editors > Track View - Dope Sheet	  
  Main Toolbar:	  Curve Editor (Open)				  

The track view is used to control the animation keys in the animation created by you. 
You can also insert sound in the scene and create notes of it. The track view uses two 
different modes, Curve Editor and Dope Sheet. In the Curve Editor mode, the 

animation is displayed as the function curve on a graph, as shown in Figure 14-7. In the Dope 
Sheet mode, the animation is displayed as a spreadsheet of keys, as shown in Figure 14-8. 

Figure 14-7  The Track View - Curve Editor window 

Figure 14-8  The Track View - Dope Sheet window

To edit the animation of an object using Curve Editor, select the animated object and invoke 
the Curve Editor (Open) tool from the Main Toolbar; the Track View - Curve Editor window 
will be displayed, refer to Figure 14-7. The pull-down menus on the top of this window are 
used to choose different options to edit the animation. The hierarchy on the left side of this 
window is used to display all objects of the scene. To view the sub-options in this tree, you 
need to click on the plus sign (+). The edit window on the right of the hierarchy tree is used 
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to edit the animation of the objects using the tangent handles available on the keys found on 
the curves. 

Tip: You can also invoke Track View - Curve Editor in place of the track bar. To 
do so, choose the Open Mini Curve Editor button on the left side of the track 
bar.   

To edit the animation of an object using Dope Sheet, select the animated object and choose 
Graph Editors > Track View - Dope Sheet from the menu bar; the Track View - Dope Sheet 
window will be displayed, refer to Figure 14-8. 

In this window, you can view all the keys in a spreadsheet format. You need to select the keys 
and edit them according to the animation.

Morph Compound Object
  Menu bar:	   Create > Compound > Morph						       
  Main Toolbar:	  Create > Geometry > Compound Objects > Object Type rollout > Morph	

The Morph tool is used to create morphing in the objects. The morphing is an animation 
technique in which the morph object combines two or more objects by matching their vertices 
in a sequential form to produce the animation result. The original object is known as the base 
object and the other object into which the base object gets morphed is known as the target 
object. Note that to perform morphing, the base and target objects must be mesh, patch, or 
poly objects and they should have the same number of vertices.      

                                                                          
To create a morph object, first create an object 

Figure 14-9  The base and target objects for 
morphing

and convert it into an editable object. This 
object will be the base object. Next, create two 
copies of the object and modify their shapes 
by selecting the Vertex sub-object level, as 
shown in Figure 14-9. You can also give the 
shape of your choice to the objects. These 
objects will be the target objects. Now, choose 
the Toggle Auto Key Mode button to turn it 
on and choose the Go to Start button to move 
the time slider to frame 0. Select the base 
object and choose Create > Compound > Morph from the menu bar; the Pick Targets and 
Current Targets rollouts will be displayed in the modify panel. Next, set the value 35 in the 
Current Frame (Go To Frame) spinner to move the time slider to frame 35. In the Pick 
Targets rollout, choose the Pick Target button and move the cursor over the first target object; 
a selection cursor will be displayed. Select the first target object in the viewport. Similarly, set 
the value 70 in the Current Frame (Go To Frame) spinner to move the time slider to frame 
70 and select the second target object. When you select the target objects in the viewport, the 
names of the base and target objects will be displayed in the Morph Targets area of the Current 
Targets rollout. Choose the Toggle Auto Key Mode button again to turn it off. Choose the 
Play Animation button to view the animation.   
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 Rendering an Animation
  Menu bar:	    Rendering > Render Setup			    
  Main Toolbar:	   Render Setup					      
  Keyboard:	    F10						    

Rendering is a process of generating a 

Figure 14-10  The Render Setup: 
Default Scanline Renderer dialog box

2-dimensional image from a 3-dimensional 
scene. It shows the lighting effects, materials 

applied, background, and other settings that you set for 
the scene. In earlier chapters, you have already learned 
about the basic rendering for the still images. The 
advanced rendering used for the animated scene is 
discussed next.

To render the final animation, invoke the Render Setup 
tool; the Render Setup: Default Scanline Renderer 
dialog box will be displayed, as shown in Figure 14-10. 
The Common tab is chosen by default in this dialog box. 
Set the parameters in different rollouts displayed in the 
Common tab.Also, in the View drop-down list located 
at the bottom of this dialog box, select the viewport 
that you want to render. Next, choose the Render 
button; the Perspective, frame 0, Display Gamma:2.2, 
RGBA Color 16 Bits/Channel (1:1) dialog box and 
the Rendering dialog box will be invoked, displaying the 
rendering process, refer to Figure 14-11. Various rollouts 
in the Render Setup: Default Scanline Renderer dialog 
box are discussed next. 

Common Parameters Rollout
There are different types of renderers to render the 

Figure 14-11  The Rendering dialog box

scene in 3ds Max such as NVIDIA mental ray 
renderer, VUE File Renderer, and so on. The 
options in this rollout are used to set the common 
parameters for all types of renderers. The 
commonly used areas in this rollout are discussed 
next.

Time Output Area 
This area is used to set the number of frames that 
you want to render. By default, the Single radio button is selected that enables you to render 
only a single frame. To render the animation, you need to select the Active Time Segment 
radio button. This radio button renders all the frames in the current time segment. Select the 
Range radio button to specify a range of frames for rendering by entering the start and end 
frame numbers in the spinners given on the right of this radio button. The Frames radio button 
allows you to render the frame numbers of your choice. To do so, select this radio button and 
enter the required frame number in the text box given on the right of this radio button. 
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Output Size Area
The options in this area are used to define the size of the rendered image. The drop-down list 
in this area is used to specify industry-standard film and video aspect ratios. You can choose 
one of the formats and then use the remaining group controls to set the output resolution. 
You can also set the aspect ratio and resolution of your choice by using the Custom option. 
Choose one of the default buttons, 320x240, 640x480, 720x486, or 800x600 to define the 
size of the output window. When you choose any of these buttons, the corresponding values 
will be displayed in the Width and Height spinners. You can also set the values manually in 
the Width and Height spinners to define the size. 

Options Area
The check boxes in this area are used to filter the options to render for the final output such 
as atmosphere, lighting effects, and so on.   

Advanced Lighting Area
The check boxes in this area are used to select options for using advanced lighting or computing 
it on a per-frame basis when required.

Bitmap Performance and Memory Options Area
This area is used to decide whether 3ds Max will use the full resolutions maps or the proxies 
of the maps at rendering. To assign the settings, you need to choose the Setup button in this 
area; the Global Settings and Defaults for Bitmap Proxies dialog box will be displayed. You 
can set the required parameters in this dialog box.

Render Output Area 
This area is used to specify a file where the rendered animation can be saved. To do so, choose 
the Files button; the Render Output File dialog box will be displayed. Enter the name of the 
file in the File name text box and then select the type of file from the Save as type drop-down 
list. Next, choose the Save button. If you have selected AVI File (*.avi) file type, the AVI File 
Compression Setup dialog box will be displayed. Use the default settings and choose the OK 
button; the Save File check box will get selected and the path of the file will be displayed just 
below the Files button in the Render Output area.

Assign Renderer Rollout
This rollout is used to set renderer for the scene. The Production option is used to assign a 
renderer for the graphics. The Material Editor option is used to assign a renderer for the 
sample slots in the Material Editor dialog box. The ActiveShade option is used to assign a 
renderer for the lighting effects in the scene, refer to Figure 14-12.

To assign the renderer, choose the Choose Renderer button on the right of the options given in 
this rollout; the Choose Renderer dialog box will be displayed, as shown in Figure 14-13. Select 
the renderer and choose the OK button; the name of the selected renderer will be displayed 
in the text box on the right of the selected option. Choose the Save as Defaults button in the 
Assign Renderer rollout to save the settings as default for further use. 
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Note
If you install any additional renderer plug-ins in 3ds Max, the renderer types will be added in 
the Choose Renderer list.  

Figure 14-12  The Assign Renderer rollout Figure 14-13  The Choose Renderer 
dialog box

Previewing The Animation
If a scene has a large number of objects, lights, and special effects, it may take a longer time 
to render the final animation. In 3ds Max, you can preview the animation in low resolution 
so that you can check the animation. Note that in the preview rendering, only the diffuse 
color maps are displayed. Therefore, it takes lesser time to render. You can have a look at your 
animation before the final rendering. 

To create a preview animation, choose Tools > Preview - Grab Viewport > Create Preview 
Animation from the menu bar; the Make Preview dialog box will be displayed, as shown in 
Figure 14-14. Alternatively, choose Create Preview > Create Preview Animation from the 
General viewport label menu to invoke the Make Preview dialog box, refer to Figure 14-15. 
Set the parameters for different options in this dialog box and select the viewport that you 
want to render from the Render Viewport drop-down list which is located at the bottom of 
the dialog box. Next, choose the Create button; the Video Compression dialog box will be 
displayed. Use the default settings and choose the OK button; the rendering of the preview 
will start. Once the preview has been created, it will automatically start in the Windows Media 
Player. 

To view the last preview animation, choose Tools > Preview - Grab Viewport > Play Preview 
Animation from the menu bar; the animation will start playing in the Windows Media Player. 
Alternatively, choose Create Preview >  Play Preview Animation from the General viewport 
label menu, refer to Figure 14-15.

Rendering Effects 
The Rendering effects are the special effects assigned to a scene. These effects are visible only 
on rendering. To assign a rendering effect to a scene, choose Rendering > Effects from the 
menu bar; the Environment and Effects dialog box will be displayed, as shown in Figure 14-16. 
The Effects tab is chosen by default. In the Effects rollout of this tab, choose the Add button; 
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the Add Effect dialog box will be displayed, as shown in Figure 14-17. Select the rendering 
effect from the list given in this dialog box and choose the OK button; the selected rendering 
effect will be displayed in the Effects text area of the Effects rollout. Also, the rollouts related to 
the selected effect will be displayed in the Environment and Effects dialog box. Next, set the 
parameters for the selected rendering effect in these rollouts and close the dialog box. Now, 
render the final scene; the rendering effects will be displayed in the final rendered image.

Figure 14-14  The Make Preview dialog box Figure 14-15  The flyout and the cascading menu of 
the General viewport label

Figure 14-16  The Environment and 
Effects dialog box

Figure 14-17  The Add Effect dialog box
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tutorials
Tutorial 1

In this tutorial, you will create a walkthrough animation in a water tunnel, refer to Figures 14-18  
and 14-19. 					      		    (Expected time: 60 min)

Figure 14-19  Animated scene for cave at 
frame 920

Figure 14-18  Animated scene for cave at 
frame 600 

The following steps are required to complete this tutorial:

a.	 Create the project folder.
b.	 Download files.	
c.	 Create a cave.
d.	 Create a camera.
e.	 Create water surface. 
f.	 Create and assign materials to water surface.
g.	 Create walkthrough animation.
h.	 Rescale the active time segment.
i.	 Create animation in water.
j.	 Assign environment to the scene.
k.	 Save and render the scene.

Creating the Project Folder
Create a new project folder with the name c14_tut1 at \Documents\3dsmax2014 and then save 
the file with the name c14tut1, as discussed in Tutorial 1 of Chapter 2.

Downloading Files
Before starting the tutorial, you need to download the c14_3dsmax_2014_tut.zip file 
from www.cadcim.com. The path of the file is as follows: Textbooks > Animation and Visual Effects > 
3ds Max > Autodesk 3ds Max 2014: A Comprehensive Guide  
	
Extract the contents of the zipped file and copy the files cave_material.jpg and ice_environment.jpg 
at the location \Documents\3dsmax2014\c14_tut1\sceneassets\images. 
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Creating a Cave 
To create a cave, you need to use various splines and the Loft tool from Compound 
Objects. 

1.	 Activate the Front viewport. Choose Create > Shapes in the Command Panel; the Splines 
option is displayed by default in the drop-down list below the Shapes button. Invoke the 
Donut tool from the Object Type rollout. 

2.	 Create a donut in the Front viewport. It is automatically named as Donut001. Now, set its 
parameters in the Parameters rollout as follows:

	 Radius 1: 720.539			   Radius 2: 848.293

3.	 In the Interpolation rollout, set the value 20 in the Steps spinner.	

4.	 Invoke the Zoom Extents All tool to view Donut001 in viewports properly.

5.	 Activate the Top viewport. Invoke the Zoom tool and zoom out the viewport so that 
Donut001 is visible only half of its original size.    

   
6.	 Invoke the Line tool from Create > Shapes > Splines > Object Type rollout from the 

Command Panel. In the Creation Method rollout, select the Smooth and Corner radio 
buttons in the Initial Type and Drag Type areas, respectively.

7.	 Create a line in the Top viewport, as shown in Figure 14-20. It is automatically named as 
Line001.

	 Next, you need to create a loft compound object.

8.	 Make sure Line001 is selected in the Top viewport. Choose Create > Geometry in 
the Command Panel; the Standard Primitives option is displayed by default in the 
drop-down list below the Geometry button. Select the Compound Objects option from 
the drop-down list and invoke the Loft tool from the Object Type rollout. 

9.	 In the Creation Method rollout of the Loft tool, choose the Get Shape button and move 
the cursor over Donut001 in the Front viewport; the shape of the  cursor changes, as shown 
in Figure 14-21. Click on Donut001; the shape of a cave is created in viewports. Right-click 
to exit the loft command. Invoke the Zoom Extents All tool to view the entire shape in 
the viewports, as shown in Figure 14-22.

Note
If the shape displayed after performing the loft command is not similar to the cave, you need to 
modify the placement of vertices of Line001 spline at the Vertex sub-object level.  

10.	 The lofted object is automatically named as Loft001. Modify its name to water tunnel. 
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Figure 14-21  The cursor displayed after 
moving it over Donut001

Figure 14-20  A line created for the cave 

Figure 14-22  The shape of the cave created in viewports using the Loft tool

Creating a Camera
In this section, you will create a walkthrough animation inside water tunnel by using the Target 
camera tool.

1.	 Activate the Front viewport. Choose Create > Cameras in the Command Panel and then 
invoke the Target tool from the Object Type rollout.  	

2.	 In the Front viewport, create a target camera and align it in all viewports using the Select 
and Move and Select and Rotate tools, as shown in Figure 14-23. It is automatically named 
as Camera001. 
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Figure 14-23  Alignment of Camera001 in viewports

 

Note
While aligning the target camera, make sure that the target of the camera is also selected along 
with Camera001.

3.	 Activate the Perspective viewport and press the C key to switch to the Camera001 viewport; 
the camera view is displayed, refer to Figure 14-23. Also, choose the Shaded option from 
the Shading viewport label menu of the Camera 001 viewport.

Creating Water Surface
In this section, you will create water surface by using the Plane tool.

1.	 Invoke the Plane tool from Standard Primitives in the Command Panel. Create a plane 
in the Top viewport. 

2.	 In the Parameters rollout, set the values in the Length and Width spinners so that the 
plane covers the area around the cave, as shown in Figure 14-24. Also, set the values in 
the Length Segs and Width Segs spinners to 30.	

3.	 Name the plane in the Name and Color rollout as water surface and align it in viewports, 
refer to Figure 14-24.

  	 Next, you need to create and assign materials to water tunnel and water surface.  
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Figure 14-24  The water surface created and aligned in viewports

Creating and Assigning Materials to Water Surface
In this section, you will create materials for water surface. 

1.	 Select water surface in any viewport and press the M key; the Material Editor dialog box 
is displayed. 

	
2.	 Select the 01-Default sample slot, if it is not already been selected, and then modify its 

name in the Material Name text box to water surface material. 

3.	 Choose the Material Type button that is currently labeled as Standard; the Material/Map 
Browser dialog box is displayed. Select the Raytrace material from Materials > Standard 
and choose the OK button; the Standard material is replaced by the Raytrace material.

	 Make sure in the Raytrace Basic Parameters rollout, the Phong shader is selected in the 
Shading drop-down list. 

4.	 Choose the Diffuse color swatch; the Color Selector: Diffuse dialog box is displayed. Set 
the following values and then choose the OK button.

	 Red: 136		  Green: 210		   Blue: 213 

5.	 Choose the Reflect color swatch; the Color Selector: Reflect dialog box is displayed. Set 
the following values and then choose the OK button.

	 Red: 240		  Green: 240		   Blue: 240 
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6.	 Choose the Reflect map button on the right of the Reflect color swatch; the Material/
Map Browser dialog box is displayed. Select the Falloff map from the Maps > Standard 
rollout and choose the OK button; the Falloff map is displayed as sub-material. 
Use the default settings and choose the Go to Parent button to go back to the 
parent level.

Note
The map assigned using the Reflect map button in the Raytrace Basic Parameters rollout is 
same as assigning the map using the Reflect map button in the Maps rollout.

7.	 Select the Bump check box in the Raytrace Basic Parameters rollout. Next, choose 
the button on the right of the Bump spinner that is labeled as None; the Material/Map 
Browser dialog box is displayed. Select the Noise map and choose the OK button; the 
Noise map is displayed as sub-material.

8.	 In the Noise Parameters rollout, select the Fractal radio button and set the following 
parameters:

	
	 Size: 30.0		  High: 1.0		  Low: 1.0

9.	 Choose the Go to Parent button to go back to the parent level. Alternatively, you can select 
the water surface material option from the Material Name drop-down list. 

10.	 Make sure that water surface is selected in the viewport, and then choose the Assign 
Material to Selection button; the water surface material is assigned to water surface in 
the viewport. 

	 Next, you need to create material for water tunnel to make it look more realistic.

11.	 Select the 02-Default sample slot and modify its name in the Material Name text box to 
water tunnel material. 

12.	 In the Shader Basic Parameters rollout, make sure that the Blinn shader is selected in 
the drop-down list. 

	 Next, you need to assign a map to the selected sample slot. 

13.	 In the Blinn Basic Parameters rollout, choose the Diffuse map button on the right of 
the Diffuse color swatch; the Material/Map Browser dialog box is displayed. Select the 
Bitmap map and choose the OK button; the Select Bitmap Image File dialog box is 
displayed. As the project folder is already set, the images folder is displayed in the Look 
in drop-down list of this dialog box. Select the file cave_material.jpg and choose the Open 
button; the selected image is displayed in the sample slot. 

14.	 Choose the Go to Parent button. Expand the Maps rollout and then select the Bump 
check box to make it available for material. Choose the Bump map button that is labeled 
as None; the Material/Map Browser dialog box is displayed. Select the Bitmap map and 
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choose the OK button; the Select Bitmap Image File dialog box is displayed. Browse 
to the same image (cave_material.jpg) that you used for the Diffuse map and choose the 
Open button; various rollouts are displayed to modify the coordinates of the map.   

  
15.	 In the Coordinates rollout, set the value to 4 in the U Tiling and V Tiling spinners. Next, 

choose the Go to Parent button to go back to the parent level; the name of the selected 
image is displayed over the Bump map button. 

16.	 In the Bump spinner, set the value to 100.  

17.	 Make sure that water tunnel is selected in the viewport, and then choose the Assign 
Material to Selection button; the water tunnel material is assigned to water tunnel in the 
viewport.

18.	 Close the Material Editor dialog box.

19.	 Activate the Camera001 viewport and invoke the Render Production tool to view the maps 
and materials assigned to the objects. The scene is displayed, as shown in Figure 14-25.

Creating Walkthrough Animation 
In this section, you will create a walkthrough animation. 

1.	 Activate the Top viewport and invoke the Maximize Viewport Toggle tool to maximize 
it.

2.	 Create a line from the lower left side to the upper right side of the viewport according to 
the shape of the water tunnel, as shown in Figure 14-26. Alternatively, you can also use the 
Line001 spline created earlier to loft the cave.

Figure 14-26  A line created for the pathFigure 14-25  The scene after assigning 
the materials

3.	 Modify the name of the line as path and align it in viewports, as shown in Figure 14-27. 
Next, invoke the Maximize Viewport Toggle tool.
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Next, you need to increase the number of frames in the track bar to create a smooth 
animation.

Figure 14-27  The path aligned in viewports

4.	 Choose the Time Configuration button at the bottom of the screen; the Time 
Configuration dialog box is displayed. In the Animation area of this dialog box, 
set the value 1000 in the End Time spinner and press the ENTER key; the number 
of frames increases in the track bar. Choose the OK button to exit the dialog 
box.

	
	 Next, you need to move Camera001 along with path.  

5.	 Select Camera001 in any viewport and choose the Motion tab in the Command 
Panel. By default, the Parameters tab is chosen in this panel. 

6.	 Expand the Assign Controller rollout in the Parameters tab and then choose the  
Position : Position XYZ option from it; the Assign Controller button is activated, 
as shown in Figure 14-28.

7.	 Choose the Assign Controller button; the Assign Position Controller dialog box is 
displayed. Choose the Path Constraint option and then choose the OK button to exit the 
dialog box; various rollouts are displayed below the Assign Controller rollout.   

  
8.	 In the Path Parameters rollout, choose the Add Path button and select path in the viewport; 

the name of path is displayed in the Target Weight area, as shown in Figure 14-29. Also, 
Camera001 is moved along with path in the viewport. Right-click to exit the command.
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Figure 14-28  The Assign Controller 
rollout 

Figure 14-29  Partial view of 
the Path Parameters rollout

9.	 Activate the Top viewport and choose the Play Animation button from the time controls 
area; you will notice that Camera001 moves along with path but the movement is not proper. 
To create a proper movement, you need to adjust the target of Camera001 at different 
frames.

10.	 Choose the Go to Start button to drag the time slider to frame 0. Next, choose the Toggle 
Auto Key Mode button to turn on the animation mode. 

11.	 Invoke the Select by Name tool; the Select From Scene dialog box is displayed. Select 
Camera001.Target and choose the OK button to exit the dialog box; Camera001.Target is 
selected in the viewport.  	

12.	 In the Top viewport, position Camera001.Target using the Select and Move tool, as shown 
in Figure 14-30. 

Note 
While aligning the Camera001.Target,  you need to view Camera001 viewport simultaneously 
to make sure that the animation is proper.   

13.	 Drag the time slider to frame 153 and move Camera001.Target along the path, as shown in 
Figure 14-31. To move the time slider to a particular frame, you can also enter the frame 
number in the Current Frame (Go to frame) spinner.    

14.	 Move the time slider to frame 300 by entering the frame number in the Current Frame 
(Go to frame) spinner. Then, align Camera001.Target, as shown in Figure 14-32.  

 
15.	 Move the time slider to frame 429 by entering the frame number in the Current Frame 

(Go to frame) spinner. Now, align Camera001.Target with path, as shown in Figure 14-33.
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Figure 14-30  The position of the 
Camera001.Target at frame 0

Figure 14-31  The position of the 
Camera001.Target at frame 153

Figure 14-32  The position of the 
Camera001.Target at frame 300

Figure 14-33  The position of the 
Camera001.Target at frame 429

16.	 Move the time slider to frame 581 and align Camera001.Target, as shown in 
Figure 14-34.

17.	 Move the time slider to frame 700 and align Camera001.Target, as shown in 
Figure 14-35.

Figure 14-34  The position of the 
Camera001.Target at frame 581

Figure 14-35  The position of the 
Camera001.Target at frame 700

18.	 Move the time slider to frame 801 and align Camera001.Target, as shown in 
Figure 14-36.
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19.	 Move the time slider to frame 935 and align Camera001.Target, as shown in 
Figure 14-37.

Figure 14-36  The position of the 
Camera001.Target at frame 801

Figure 14-37  The position of the 
Camera001.Target at frame 935

20.	 Move the time slider to frame 1000 and align Camera001.Target, as shown in 
Figure 14-38. After creating the frame-by-frame animation, the frames are displayed in 
the track bar, as shown in Figure 14-39.

Figure 14-38  The position of the 
Camera001.Target at frame 1000

Figure 14-39  The track bar after creating the animation

21.	 Choose the Toggle Auto Key Mode button to turn off the animation mode and activate 
Camera001 viewport. Next, choose the Play Animation button; Camera001 starts moving 
along path inside the cave.

Note
You can also use your own dimensions to align Camera001.Target at different frames.

Rescaling the Active Time Segment 
While playing animation, if you feel that the pace of animation is very fast, you can increase 
the number of frames in the active time segment to make it slow and smooth. 



Animation Basics		         14-23

1.	 Choose the Time Configuration button at the bottom of the 3ds Max screen; the Time 
Configuration dialog box is displayed. In the Animation area of this dialog box, choose 
the Re-scale Time button; the Re-scale Time dialog box is displayed. 

2.	 In the New area, set a new value in the End Time spinner and choose the OK button to 
exit the dialog box; the active time segment and animation keys are adjusted accordingly. 
Choose the OK button in the Time Configuration dialog box to close it.  

Creating Animation in Water
In this section, you will create animated waves on the water surface by using the Compact 
Material Editor tool.

1.	 Invoke the Compact Material Editor tool from the Main Toolbar; the Material Editor 
dialog box is displayed. 

2.	 Select the water surface material sample slot. Now, in the Raytrace Basic Parameters 
rollout, choose the Bump map button that is labeled as Map# X (Noise); various rollouts 
are displayed for the Noise modifier.

	 Next, you need to set the keys on the parameters of the Noise modifier to animate 
water surface. 

3.	 Choose the Go to Start button to drag the time slider to frame 0. Next, choose the 
Toggle Auto Key Mode button to turn on the animation mode; the selected sample slot 
is surrounded by a red border, which indicates that the animation mode is active.

4.	 In the Noise Parameters rollout, make sure that the value in the Phase spinner is 0.0 at 
frame 0. Next, choose the Go to End button to move the time slider to the end frame, 
and then set the value 7.0 in the Phase spinner and then press ENTER; the arrows of the 
spinner turn red. 

5.	 Choose the Toggle Auto Key Mode button to turn off the animation mode and close the 
Material Editor dialog box.      

Assigning Environment to the Scene
In this section, you will create environment to the scene.

1.	 Choose Rendering > Environment from the menu bar; the Environment and Effects 
dialog box is displayed. 

2.	 The Environment tab is chosen by default. In the Background area of the Common 
Parameters rollout, choose the Environment Map button that is labeled as None; the 
Material/Map Browser dialog box is displayed.

3.	 Select the Bitmap map and choose the OK button; the Select Bitmap Image File dialog 
box is displayed. Select ice_environment.jpg image and choose the Open button; the selected 
image is displayed as background after rendering. Close the Environment and Effects 
dialog box. 
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	 Note that when Camera001 moves toward the end frames, then only the background of 
the scene is displayed in the animation.

Saving and Rendering the Scene
In this section, you will save the scene and then render it. You can also view the final rendered 
image sequence by downloading the file c14_3dsmax_2014_rndr.zip from www.cadcim.com. The 
path of the file is as follows: Textbooks > Animation and Visual Effects > 3ds Max > Autodesk 3ds 
Max  2014: A Comprehensive Guide

1.	 Invoke the Render Setup tool from the Main Toolbar; the Render Setup: Default 
Scanline Renderer dialog box is displayed. In this dialog box, the Common tab is chosen 
by default. Also, various rollouts are displayed in the Common tab. 

2.	 In the Common Parameters rollout, select the Active Time Segment radio button in the 
Time Output area.

3.	 In the Output Size area, choose the 640x480 button. 

4.	 In the Render Output area, choose the Files button; the Render Output File dialog box is 
displayed. Enter a name for the file in the File name text box and then select the AVI File 
(*.avi) file type from the Save as type drop-down list and specify the desired location of 
the file in the Save in text box.  Next, choose the Save button; the AVI File Compression 
Setup dialog box is displayed. Use the default settings and choose the OK button to exit 
the dialog box.

5.	 Choose Save from the Application menu.

6.	 Make sure the Quad 4 - Camera001 option is selected in the View drop-down list at the 
bottom of the Render Setup: Default Scanline Renderer dialog box. Next, choose the 
Render button; both the Camera001, frame# window and the Rendering dialog box are 
displayed showing the rendering process. 

	 After the completion of the rendering process, the final output of the animation is saved at 
the specified location in the *.AVI format. You can view the final output of the animation 
by opening the corresponding *.AVI file.  



Animation Basics		         14-25

Tutorial 2
In this tutorial, you will create an animated scene that contains light effects and animation of 
lights and objects, as shown in Figure 14-40. 			     (Expected time: 60 min) 

Figure 14-40  The animated scene

The following steps are required to complete this tutorial:

a.	 Create the project folder.
b.	 Create the wireframe earth sphere.
c.	 Create the text.
d.	 Assign the camera in the scene.
e.	 Create the animated space background.
f.	 Create and animate lights in the scene.
g.	 Animate the wireframe earth sphere and the text.
h.	 Save and render the scene.

Creating the Project Folder
Create a new project folder with the name c14_tut2 at \Documents\3dsmax2014 and then save 
the file with the name c14tut2, as discussed in Tutorial 1 of Chapter 2.

Creating the Wireframe Earth Sphere 
In this section, you will create two spheres to create a wireframe earth sphere.

1.	 Invoke the Sphere tool from Standard Primitives in the Command Panel and create a 
sphere in the Top viewport. 

2.	 Modify the name of the sphere to earth sphere. Set the value of the Radius spinner to 58.42  
in the Parameters rollout.  

3.	 Make sure that earth sphere is selected and then choose Edit > Clone from the menu bar; 
the Clone Options dialog box is displayed.
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4.	 Select the Copy radio button in the Object area and enter wireframe sphere in the Name 
edit box. Next, choose the OK button to close the dialog box.  In the Parameters rollout, 
set the radius of wireframe sphere to 58.0 in the Radius spinner.	    

	 Next, you need to apply maps and material to the earth sphere and the wireframe sphere.

5.	 Navigate to the c14_3dsmax_2014_tut folder that you have downloaded from the CADCIM 
website in Tutorial 1. Next, copy EarthMap_colored.jpg and EarthMap_b&w.jpg at the location 
\Documents\3dsmax2014\c14_tut2\sceneassets\images.

6.	 Select earth sphere in any viewport and invoke the Compact Material Editor tool; the 
Material Editor dialog box is displayed.

	
7.	 Select the 01-Default sample slot, if it is not already selected, and then modify its name 

in the Material Name text box to earth map. 

8.	 In the Shader Basic Parameters rollout, make sure that the Blinn shader is selected in 
the drop-down list, and then select the 2-Sided check box. 

	 Next, you need to assign a map to the shader. 

9.	 In the Blinn Basic Parameters rollout, choose the Diffuse map button on the right side 
of the Diffuse color swatch; the Material/Map Browser dialog box is displayed. Select 
the Bitmap map and choose the OK button; the Select Bitmap Image File dialog box is 
displayed. As the project folder is already set, the images folder is displayed in the Look 
in drop-down list of this dialog box. Select the file EarthMap_colored.jpg and choose the 
Open button; the selected image is displayed in the sample slot. Also, various rollouts are 
displayed to modify the coordinates of the map.

10.	 Choose the Go to Parent button to go back to the parent 
level and then choose the Opacity map button in the 
Blinn Basic Parameters rollout; the Material/Map 
Browser dialog box is displayed. Select the Bitmap map 
and choose the OK button; the Select Bitmap Image 
File dialog box is displayed. Select the EarthMap_b&w.jpg 
image and choose the Open button; the selected image is 
displayed in the sample slot, as shown in Figure 14-41. 

11.	 Choose the Go to Parent button again and make sure 
earth sphere is selected in the viewport. Next, choose the 
Assign Material to Selection button; earth map is assigned 
to the earth sphere in the viewport. 

12.	 Choose the Show Shaded Material in Viewport button to view the assigned map in the 
viewport.

13.	 Render the Perspective viewport to view the map applied using the Render Production 
tool, as shown in Figure 14-42.

Figure 14-41  The earth 
map in the sample slot
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	 Next, you need to create material for wireframe sphere.

14.	 Select the 02-Default sample slot and modify its name in the Material Name text box to 
wireframe map. 

15.	 In the Shader Basic Parameters rollout, make sure that the Blinn shader is selected in 
the drop-down list and then select the Wire check box; wireframes are displayed in the 
sample slot, as shown in Figure 14-43. 

Figure 14-42  The earth map applied 
to the earth sphere after rendering 

Figure 14-43  Wireframes displayed 
in the sample slot

16.	 In the Blinn Basic Parameters rollout, choose the Diffuse color swatch; the Color Selector: 
Diffuse Color dialog box is displayed. Set the values in the Red, Green, and Blue spinners 
as given below and choose the OK button to exit the dialog box.  

	 Red: 239		  Green: 106		   Blue: 18

17.	 In the Specular Highlights area, set the value 53 in the Specular Level spinner.

18.	 Select wireframe sphere in the viewport and then choose the Assign Material to Selection 
button; the wireframe map is assigned to wireframe sphere in the viewport. 

19.	 Choose the Show Shaded Material in Viewport button to view the assigned map in the 
viewport. Close the Material Editor dialog box.

20.	 Invoke the Zoom Extents All tool to view both the spheres in viewports.

	 Next, you need to align wireframe sphere with earth sphere.

21.	 Select wireframe sphere in the viewport and invoke the Align tool from the Main Toolbar; the 
shape of the cursor changes. Next, select earth sphere in the viewport; the Align Selection 
(earth sphere) dialog box is displayed. 
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22.	 In the Align Position (World) area, make sure the X Position, Y Position, and Z Position 
check boxes are selected. Next, select the Pivot Point radio button both in the Current 
Object and Target Object areas. Then, choose the OK button to close the dialog box.

23.	 Invoke the Zoom Extents All tool; wireframe sphere is aligned with earth sphere in viewports, 
as shown in Figure 14-44.  

Figure 14-44  Alignment of the wireframe and the earth sphere in viewports    

24.	 Activate the Perspective viewport. Choose the Render Production tool from the Main 
Toolbar; the rendered sphere is displayed in the Rendered Frame window, as shown in 
Figure 14-45.

25.	 Select wireframe sphere and earth sphere in the 
viewport, simultaneously and then group them 
as wireframe earth sphere.  

Creating the Text
In this section, you will create the text around the 
wireframe earth sphere by using the Text tool.  

1.	 Invoke  the  Text  too l  f rom Create  > 
Shapes > Splines > Object Type rollout in the 
Command Panel. In the Parameters rollout, set 
the values as follows:

Figure 14-45  The sphere at rendering
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	 Select the Arial Italic font type from the drop-down list located on the top of the 
rollout.

	 Make sure that the left alignment button is chosen.
	 Size: 30.0 	

	 Text area
	 Enter CADCIM Technologies.

2.	 Click in the center of Front viewport; the CADCIM Technologies text is displayed in 
viewports. It is automatically named as Text001. 

3.	 Invoke the Zoom Extents All tool and align Text001 in viewports, as shown in 
Figure 14-46. 

Figure 14-46  Alignment of Text001 in viewports

	 Now, you need to apply the Extrude modifier to add depth to the text.

4.	 Make sure that Text001 is selected in the viewport. Choose the Modify tab in the Command 
Panel. Next, select the Extrude modifier from the Modifier List drop-down list; the 
Extrude modifier is displayed in the modifier stack. 

5.	 In the Parameters rollout of the Extrude modifier, set the value 3.0 in the Amount 
spinner.

	 Next, you need to apply material to Text001. 
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6.	 Invoke the Material Editor tool; the Material Editor dialog box is displayed. Select 
the 03-Default sample slot and modify its name in the Material Name text box to text 
material. 

7.	 In the Blinn Basic Parameters rollout, choose the Diffuse color swatch; the Color Selector: 
Diffuse Color dialog box is displayed. Set the following values in the Red, Green, and 
Blue spinners and then choose the OK button to exit the dialog box.  

	 Red: 253		  Green: 185		   Blue: 2

8.	 Make sure Text001 is selected in the viewport and then choose the Assign Material to 
Selection button; the text material is assigned to Text001 in the viewport. Close the Material 
Editor dialog box. 

	
	 Next, you need to apply the Bend modifier to Text001 to bend it around wireframe earth 

sphere. 	

9.	 Make sure Text001 is selected in the viewport and then choose the Modify tab in the 
Command Panel. Next, select the Bend modifier from the Modifier List drop-down list; 
the Bend modifier is displayed in the modifier stack. 

10.	 In the Parameters rollout of the Bend modifier, set the values as follows:

	 Bend area
	 Angle: 237.5

	 Bend Axis area
	 Select the X radio button.

11.	 Align Text001 in viewports, as shown in Figure 14-47.

Assigning Camera in Scene
In this section, you will assign camera in the scene.

1.	 Invoke the Zoom All tool and zoom out in all viewports, simultaneously to make a proper 
room around wireframe earth sphere.

2.	 Invoke the Free tool from Create > Cameras in the Command Panel and click in the 
Front viewport; a free camera is displayed in all viewports and is automatically named as 
Camera001.

3.	 Align Camera001 in viewports to view the front side of the scene and then press the C key in 
the Perspective viewport to activate the Camera001 viewport, as shown in Figure 14-48.
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Figure 14-47  The Text001 aligned in viewports after applying the Extrude and Bend 
modifiers

Figure 14-48  The Camera001 aligned in viewports
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Creating Animated Space Background	
In this section, you will create background for the scene.

1.	 Choose Rendering > Environment from the menu bar; the Environment and Effects 
dialog box is displayed with the Environment tab chosen by default. Also, various rollouts 
are displayed in the Environment tab.  

2.	 In the Common Parameters rollout, choose the Environment Map button in the 
Background area; the Material/Map Browser dialog box is displayed. Select the Noise 
map from the Maps > Standard rollout and choose the OK button; the Noise map is 
displayed on the Environment Map button and applied as the background.

	 Next, you need to set the parameters of the Noise map.  

3.	 Press the M key to invoke the Material Editor dialog box. Select the 04-Default sample 
slot.

4.	 In the Environment and Effects dialog box, move the cursor

Figure 14-49  The sample slot with 
the Noise environment

over the Environment Map button, press and hold the 
left mouse button, drag it to the 04-Default sample slot 
in the Material Editor dialog box, and release the left 
mouse button; the Instance (Copy) Map dialog box is 
displayed. Select the Instance radio button and choose 
the OK button; the 04-Default sample slot is displayed, 
as shown in Figure 14-49. Also, various rollouts to modify 
the Noise map are displayed. 

5.	 Modify the name of the sample slot in the Material 
Name text box to space environment map.   

	 Next, you need to modify the parameters of the Noise 
map.

6.	 In the Noise Parameters rollout, set the values as

Figure 14-50  The scene with the 
space environment map

 
given below:

	 Select the Fractal radio button in the Noise Type 
area.    

	 Size: 0.2		  High: 0.8	
	 Low: 0.7		  Levels: 3.0

7.	 Render the Camera001 viewport; the scene is 
displayed with space environment map, as shown in 
Figure 14-50.

	 Next, you need to animate the stars in space environment map.
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8.	 Choose the Time Configuration button; the Time Configuration dialog box is displayed. 
In the Animation area of this dialog box, set the value 1000 in the End Time spinner 
and press the ENTER key; the number of frames in the active time segment increases to 
1000. Choose the OK button to exit the dialog box.

9.	 Choose the Toggle Auto Key Mode button to turn on the animation mode and then 
choose the Go to Start button to move the time slider to frame 0. In the Noise Parameters 
rollout of the Material Editor dialog box, make sure that the value in the Phase spinner 
is 0.0 at frame 0. 

10.	 Choose the Go to End button to move the time slider to frame 1000. In the Noise 
Parameters rollout, set the value 7.0 in the Phase spinner. The stars in space environment map 
appear to be blinking in the final output at rendering. 

11.	 Choose the Toggle Auto Key Mode button to turn off the animation mode and then close 
the Material Editor dialog box. Also, close the Environment and Effects dialog box.    

Creating and Animating Lights in the Scene
To create light in the scene, you need to create omni and spot lights in the scene.

1.	 Invoke the Zoom tool and zoom out the Top, Front, and Left viewports to create proper 
room around wireframe earth sphere, refer to Figure 14-51. 

Figure 14-51  The wireframe earth sphere zoomed out
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2.	 Activate the Top viewport and invoke the Omni tool from Create > Lights > Standard > 
Object Type rollout in the Command Panel. In the Top viewport, click at the center of 
wireframe earth sphere; an omni light is displayed in all viewports. It is automatically named 
as Omni001. Right-click to exit the command.

3.	 Align Omni001 light in all viewports, refer to Figure 14-52. 

4.	 Create four copies of Omni001 light and align all lights, as shown in Figure 14-52.

Figure 14-52  Omni lights aligned in viewports

Note
If your scene has more lighting effects, then choose the Modify tab in the Command Panel and 
set the intensity of omni lights. To do so, you need to modify the value in the Multiplier spinner 
of the Intensity/Color/Attenuation rollout.  

 
	 Next, you need to add advance effects to omni lights.

5.	 In the Front viewport, select the omni light that is placed on the left side of wireframe earth 
sphere, as shown in Figure 14-53. 

6.	 Choose the Modify tab in the Command Panel and expand the Atmospheres & Effects 
rollout. Choose the Add button; the Add Atmospheres or Effect dialog box is displayed. 
Select the Lens Effects option and choose the OK button to exit the dialog box; the Lens 
Effects option is displayed in the Atmospheres & Effects rollout.                                                                                                                                       

	 Next, you need to set the parameters for the Lens Effects. 
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Figure 14-53  Omni light selected to add the 
advance effects

7.	 Select the Lens Effects option in the Atmospheres & Effects rollout and choose the Setup 
button; the Environment and Effects dialog box is displayed with the Effects tab chosen. 
Also, various rollouts are displayed in this tab. 

8.	 In the Lens Effects Parameters rollout, select the Glow option and choose the arrow 
that is pointing toward the right; the Glow effect is now available for the omni light at 
rendering. Also, the Glow Element rollout is displayed in the Environment and Effects 
dialog box to modify the parameters of the Glow effect. 

9.	 In the Glow Element rollout, set the values as follows:

	 Size: 10.0		  Intensity: 150.0 

10.	 In the Lens Effects Parameters rollout, select Ray and then choose the arrow that is 
pointing toward the right; the Ray effect is now available for the omni light at rendering. 
Also, the Ray Element rollout is displayed in the Environment and Effects dialog box to 
modify the parameters of the Ray effect. 

11.	 In the Ray Element rollout, set the values as follows:

	 Size: 50.0		  Intensity: 10.0		  Num: 50

	 Use the default values for other options.

12.	 To animate rays in the scene, choose the Toggle Auto Key Mode button to turn on the 
animation mode. Next, choose the Go to Start button to move the time slider to frame 
0. In the Ray Element rollout, make sure that the value in the Angle spinner is 0.0 at 
frame 0. 

13.	 Choose the Go to End button to move the time slider to frame 1000, and set the value 
in the Angle spinner to 180.0. The rays appear to be rotating in the final output after 
rendering. 
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14.	 Choose the Toggle Auto Key Mode button to turn off the animation mode.

15.	 In the Lens Effects Parameters rollout, select the Ring option and then choose the 
arrow that is pointing toward the right side; the Ring effect becomes available for the 
omni light at rendering. Also, the Ring Element rollout is displayed in the Environment 
and Effects dialog box to modify the parameters of the Ring effect. 

16.	 In the Ring Element rollout, set the values as follows:

	 Size: 3.0		  Intensity: 15.0	

	 Use the default values for other options.

17.	 Close the Environment and Effects dialog box and render the Camera001 viewport; the 
omni light is displayed, as shown in Figure 14-54.  

Note
If you are not able to view the Omni Light in your render, move Camera001 so that you can 
see the Omni light in your render.     

18.	 In the Front viewport, select the omni light that is placed just above wireframe earth sphere. 
Align it at the top of wireframe earth sphere, as shown in Figure 14-55. Next, add the Lens 
Effects as described above and set the parameters of different effects in the Environment 
and Effects dialog box as follows: 

	 Glow effect 
	 Size: 3.0		  Intensity: 150.0

	 Ray effect
	 Size: 10.0		  Intensity: 30.0		  Num: 10

	 Star effect
	 Size: 10.0		  Intensity: 50.0		  Width: 1.0

Figure 14-55  The omni light aligned just 
above the wireframe earth sphere

Figure 14-54  The effect of the omni light 
displayed at rendering
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19.	 To animate the effects of this omni light in the scene, choose the Toggle Auto Key Mode 
button to turn on the animation mode. Now, choose the Go to Start button to move the 
time slider to frame 0. Also, in the Star Element rollout, make sure that the value in the 
Angle spinner is 0.0 at frame 0. 

20.	 Choose the Go to End button to move the time slider to 

Figure 14-56  The omni light with 
the lens effect on rendering

frame 1000 and set the value in the Angle spinner to 
90.0. The stars appear to be rotating in the final output 
after rendering. 

21.	 Choose the Toggle Auto Key Mode button to turn off 
the animation mode.

	 After applying the effects, the omni light with the 
lens effect is displayed after rendering, as shown in 
Figure 14-56.

	 Next, you need to add spot lights to the scene.

22.	 Invoke the Target Spot tool from Create > Lights > Standard > Object Type rollout 
in the Command Panel and then create a spot light in the Front viewport, as shown 
in Figure 14-57. Also, create another spot light in the Top viewport, as shown in 
Figure 14-58.

Figure 14-58  Spot light created in the Top 
viewport

Figure 14-57  Spot light created in the Front 
viewport

	 The spotlights are automatically named as Spot001 and Spot002. 
                                                              					   
	 Now, you need to modify the parameters of the spot lights.

23.	 Select Spot001 that you created in the Front viewport and choose the Modify tab in 
the Command Panel; various rollouts are displayed to modify the parameters of the 
spotlight.

24.	 In the Spotlight Parameters rollout, set the values as follows:

	 Hotspot/Beam: 25.3		 Falloff/Field: 30.0 
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25.	 In the Atmospheres & Effects rollout, add the Volume Light effect, select the Volume 
Light option in the rollout, and choose the Setup button; the Environment and Effects 
dialog box is displayed. In the Volume area of the Volume Light Parameters rollout, set 
the value in the Density spinner to 1.5. Close the Environment and Effects dialog box. 

26.	 Render the Camera001 viewport; the scene is displayed, as shown in Figure 14-59.

27.	 In the Advance Effects rollout of the Modify panel, select the Map check box in the 
Projector Map area. Then, choose the Projector Map button labeled as None and assign 
a bitmap image of your choice to this map to give a more realistic effect to the Volume 
Light at rendering, refer to Figure 14-60.  

Figure 14-60  The scene at rendering 
after assigning a map to Projector 
Map

Figure 14-59  The scene at rendering 
after applying the Volume Light effect 
in the Spot001 light 

28.	  After rendering, you will notice that the Volume Light is visible up to the infinite distance. 
To control the distance of the Volume Light, set the parameters in the Far Attenuation 
area in the Intensity/Color/Attenuation rollout as follows:

	 Select the Use and Show check boxes.
	 Start: 10		  End: 850

Note
You may need to adjust the values in the Start and 

Figure 14-61  The scene displayed at 
rendering after setting the parameters in 
the Far Attenuation area 

End spinners as the values may differ depending on 
the placement of the light in the scene.

29.	 Render the Camera001 viewport; the scene is 
displayed, as shown in Figure 14-61.

30.	 Select Spot002 in the viewport and choose the Modify 
tab in the Command Panel; all rollouts are displayed 
to modify the parameters of the selected light.
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31.	 In the Spotlight Parameters rollout, set the values as follows:

	 Hotspot/Beam: 5.0		  Falloff/Field: 7.0

32.	 Invoke the Zoom Extents All tool and align Spot002  in viewports, as shown in 
Figure 14-62.

Figure 14-62  The Spot002 light aligned in viewports

        

	 Next, you need to animate Spot001. 

33.	 Invoke the Select by Name tool and select Spot001 and Spot001.Target in the Top viewport. 
Next, invoke the Zoom Extents All Selected tool to view the selected light properly.

34.	 Choose the Toggle Auto Key Mode button to turn on the animation mode and then 
choose the Go to Start button to move the time slider to frame 0.

35.	 Choose the Go to End button to move the time slider to frame 1000 and invoke the Select 
and Rotate tool. Next, in the Top viewport, move the cursor over the X-axis and rotate 
the Spot001 and Spot001.Target in the clockwise direction until the value in the Z spinner 
becomes -360 in the coordinate display. 

36.	 Choose the Toggle Auto Key Mode button to turn off the animation mode.

Animating Wireframe Earth Sphere and Text
In this section, you will animate wireframe earth sphere and Text001 in the opposite directions.
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1.	 Activate the Top viewport and select wireframe earth sphere. Then, invoke the Zoom 
Extents All Selected tool; wireframe earth sphere is zoomed in all viewports, as shown in 
Figure 14-63.

Figure 14-63  The wireframe earth sphere zoomed in viewports

Note
When you invoke a tool from the viewport navigation controls, it does not affect the Camera001 
viewport.     

2.	 Choose the Toggle Auto Key Mode button to turn on the animation mode and choose 
the Go to Start button to move the time slider to frame 0.

3.	 Choose the Go to End button to move the time slider to frame 1000 and then invoke the 
Select and Rotate tool. In the Top viewport, move the cursor over the X-axis and rotate 
wireframe earth sphere in the counterclockwise direction until the value in the Z spinner 
becomes 360 in the coordinate display. 

4.	 Choose the Toggle Auto Key Mode button to turn off the animation mode.

	 Next, you need to animate Text001 around wireframe earth sphere. 

5.	 Select Text001 in the Top viewport and choose the Hierarchy tab in the Command  
Panel. In the Adjust Pivot rollout, choose the Affect Pivot Only button; the 
pivot point of Text001 is displayed in the viewport, as shown in Figure 14-64.
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6.	 Align the pivot point of Text001 at the center of wireframe earth sphere, as shown in 
Figure 14-65. Then, choose the Affects Pivot Only button again to deactivate it.

6.	 Align the pivot point of the Text001 at the center of the wireframe earth sphere, refer to 
Figure 14-65. Then, choose the Affect Pivot Only button again to deactivate it. 

Figure 14-64  The pivot point of the Text001 
displayed in the Top viewport

Figure 14-65  The pivot point of the Text001 
aligned in the Top viewport 

7.	 Invoke the Select and Rotate tool and rotate Text001 in the Top viewport along the Z-axis 
until the value in the Z spinner becomes -180 in the coordinate display. Next, invoke the 
Select and Move tool and align Text001, as shown in Figure 14-66.

8. 	 Right-click on the Select and Rotate tool; the Rotate Transform Type-In dialog box is 
displayed. Enter 10 in the Z spinner of the Offset:Screen area and press the ENTER key; 
Text001 rotates in the Front viewport, as shown in Figure 14-67.

Figure 14-66  The Text001 rotated in the Top 
viewport

Figure 14-67  The Text001 rotated in the Front 
viewport

9.	 Choose the Toggle Auto Key Mode button to turn on the animation mode. Choose the 
Go to End button to move the time slider to frame 1000 and make sure that Text001 
is selected. Activate the Front viewport. Right-click on the Select and Rotate tool; the 
Rotate Transform Type-In dialog box is displayed. Enter -360 in the Y spinner of the 
Offset:Screen area and press the ENTER key. 

10.	 Choose the Toggle Auto Key Mode button to turn off the animation mode and choose 
the Play Animation button to view the animation.
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Saving and Rendering the Scene
In this section, you will save the scene and then render it. You can also view the final rendered 
image sequence by downloading the file c14_3dsmax_2014_rndr.zip from www.cadcim.com. The 
path of the file is as follows: Textbooks > Animation and Visual Effects > 3ds Max > Autodesk 3ds 
Max  2014: A Comprehensive Guide

1.	 Choose Save from the Application menu.

2.	 To view the final output of the scene that contains all movements, textures, lights, and 
animations, you need to render the scene. To do so, follow the procedure described in 
Tutorial 1 of this chapter.

 Self-Evaluation Test 
Answer the following questions and then compare them to those given at the end of this 
chapter:

1.	 Which of the following buttons is used to turn on the animation mode?
	
		  (a) Toggle Auto Key Mode		  (b) Toggle Set Key Mode
		  (c) Both a and  b			   (d) None of these

2.	 Which of the following tools is used to control the animation keys in an animation?

		  (a) Track View	 			   (b) Key Mode Toggle		
		  (c) Play Animation	 		  (d) Time Configuration	

3.	 Which of the following modifiers is used to create morphing in objects?

		  (a) Morph		  		  (b) Scatter		
		  (c) Mesher				    (d) Terrain	

4.	 Which of the following options is used to add special effects on rendering in the Rendering 
pull-down menu?

		
		  (a) Render	 			   (b) Material Editor
		  (c) Effects		  		  (d) None of these

5.	 In the set key animation mode, you need to set the keys for the animation of the selected 
object by choosing the Set Keys button. (T/F)	

6.	 To move the time slider to another frame, you can enter the frame number directly in the 
Current Frame (Go to frame) spinner. (T/F)

7.	 The Time Configuration button is used to set the animation length by defining the 
number of frames in the track bar. (T/F)
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8.	 The __________ button is used to jump between the keyframes directly.

9.	 The __________ displays the timeline with the frame numbers in it.

10.	 To render the final animation, you need to invoke the __________ tool in the Main 
Toolbar.

 Review Questions 
Answer the following questions:

1.	 Which of the following effects can be assigned to the rendered scene from Rendering > 
Effects in the menu bar?

 
		  (a) Blur		  			   (b) Lens Effects
		  (c) Motion Blur				   (d) All of these  

2.	 Which of the following options in the Animation pull-down menu is used to create a 
preview animation?

 
		  (a) View Preview		  	 (b) Make Preview
		  (c) Rename Preview			   (d) None of these

3.	 Which of the following areas in the Render Setup dialog box is used to decide 
whether Autodesk 3ds Max will use the full resolution maps or the proxies of maps at 
rendering ?

 
		  (a) Render Output			   (b) Time Output		
		  (c) Advanced Lighting			   (d) Bitmap Performance 
							             and Memory Options

4.	 In the Curve Editor mode of the track view, the animation is displayed as a spreadsheet 
of keys. (T/F)

5.	 The options in the Frame Rate area of the Time Configuration dialog box are used to 
define a particular frame rate for animation in frames per second. (T/F)

6.	 The Playback area in the Time Configuration dialog box is used to slow down the speed 
of the animation. (T/F)

7.	 To assign the NVIDIA mental ray renderer for rendering the animation, you need to 
invoke the Quick Render (Production) tool in the Main Toolbar. (T/F)

8.	 To create the preview of an animation, select the __________ option from the __________ 
pull-down menu. 
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9.	 To save the rendered animation, you need to define a file with the __________ extension 
in the __________ area of the Render Setup dialog box.

10.	 The __________ button is used to play the animation of an object in the viewport.

exercises
The rendered output of the scene used in the following exercises can be accessed by 
downloading the c14_3dsmax_2014_exr.zip file from www.cadcim.com. The path of the file is 
as follows: Textbooks > Animation and Visual Effects > 3ds Max > Autodesk 3ds Max 2014: A 
Comprehensive Guide

Exercise 1
Start 3ds Max 2014 and then perform the following operations:

Create different primitives at some distance in the Top viewport and try the following steps:

1.	 Create a free camera in the viewport. Next, create an animation of the camera using the 
auto key animation mode such that it touches the top of all primitives one by one. Also, 
create the same animation using the set key animation mode and notice the difference.  

2.	 Create an omni light in the scene, choose the Modify tab, and expand the Atmospheres 
& Effects rollout. Then, add atmospheric effects to the light to view special effects on 
rendering.  

3.	 Select the free camera in the viewport and invoke the Curve Editor tool in the Main 
Toolbar; the Track View - Curve Editor dialog box is displayed. Next, edit the keys in 
the edit window and notice the effect in your animation.  

4.	 Invoke the Render Scene Dialog tool; the Render Scene dialog box is displayed. In the 
Assign Renderer rollout, set the NVIDIA mental ray renderer to render the Camera001 
viewport and view the difference in the final output.

5.	 Select the Make Preview option from the Animation pull-down menu; the Make Preview 
dialog box is displayed. Set the parameters for different options and choose the Create 
button to create the preview of the animation.   

6.	 Choose Rendering > Effects from the menu bar and add special effects to the scene.
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Exercise 2
Create the early morning scene and animate the sea water, refer to Figure 14-68. 	 		
			    		                              	  (Expected time: 30 min)

Figure 14-68  The morning scene

Hints:
1.	 Create an omni light for the sun effect and use the Lens effects in it.
2.	 Create water as discussed in Tutorial 1 of this chapter. 
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Exercise 3
Create the solar system using the standard primitives and lights, as shown in Figure 14-69.   
                                                                                                           (Expected time: 60 min) 

Figure 14-69 The solar system

Answers to Self-Evaluation Test
1.  c,  2.  a,  3.  a,  4.  c,  5.  T, 6.  T, 7.  T, 8.  Key Mode Toggle ,  9. track bar, 
10. Render Production
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Figure 15-1  The Systems in the 
Command Panel

Figure 15-2  The Ring Array system Figure 15-3  The Parameters 
rollout in the Motion tab

      

                

Figure 15-4  The object selected 
in the hierarchy tree to replace the 
boxes of the Ring Array system 

Figure 15-5  The box selected in 
the hierarchy tree to be replaced 
with the object
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Figure 15-7  The boxes of the Ring 
Array system replaced with the object 
(teapot)

Figure 15-6  The Paste dialog box

Figure 15-8  The scene after creating 
the Sunlight system

Figure 15-9  The scene after changing 
the position of the sun

                  

Figure 15-10  The Sunlight system in all viewports
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Figure 15-11  The Control 
Parameters rollout

Figure 15-12  The Geographic Location dialog box

Figure 15-13  The 
Parameters rollout
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Figure 15-14  The Daylight System Creation message box

Figure 15-15  The Daylight system created in viewports

Figure 15-16  The Daylight 
Parameters rollout
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Figure 15-17  The child object linked to the 
parent object using the Select and Link tool

Figure 15-18  The Link Info button  
chosen in the Hierarchy tab

Figure 15-19  The hierarchy of bones created
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Figure 15-20  The Bones 
Parameters rollout
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Figure 15-21  The bones with the fins added to 
them

Figure 15-22  Partial view of 
the Bone Tools dialog box

Figure 15-23  The IK 
Chain Assignment 
rollout
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Figure 15-24  The biped model displayed in viewports

Figure 15-25  The male, female, classic, and 
skeleton type biped models 
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Figure 15-26  The shadow pattern in the 
scene

Figure 15-27  Alignment of the Camera001 in viewports 
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Figure 15-28  The Sunlight system created in viewports

Figure 15-29  The time slider at frame 40
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Figure 15-30  The biped model animation

  	

Figure 15-31  The biped model displayed in viewports
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Figure 15-32  The rollouts 
displayed after choosing the
Footstep Mode button 

 

Figure 15-33  The Top viewport after using 
the Zoom and Pan tools

Figure 15-34  The footsteps created in 
the Top viewport 
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Figure 15-36  The footsteps after rotating them 
in the Top viewport

Figure 15-35  The footsteps aligned 
using the Select and Move tool

Figure 15-37  The biped model moving after choosing the Play Animation button

Figure 15-38  New footsteps created 
in the Top viewport
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Figure 15-39  The biped model moving according to the newly created footsteps

	

Figure 15-40  The running biped model in viewports
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Figure 15-41  The Bip001 in running position after loading the Run.bip file

Figure 15-43  Model to be created in 
Exercise 1(view 2)

Figure 15-42  Model to be created in 
Exercise 1(view 1)

Figure 15-44  Model to be created in Exercise 1 
(view 3)
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Dynamics and 
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Figure 16-1  The MassFX Toolbar 

Figure 16-2  Various options  
displayed in the flyout

Figure 16-3  The rigid body with the 
Initial Velocity sub-object level selected

Figure 16-4  The rigid body with the 
Initial Spin sub-object level selected

Figure 16-5  The rigid body with the 
Center of Mass sub-object level selected

Figure 16-6  The rigid body with the Mesh 
Transform sub-object level selected
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Figure 16-7  The Rigid 
Body  Properties rollout

 

Figure 16-8 The Physical 
Material rollout

 

Figure 16-9  The Physical 
Shapes rollout
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Figure 16-10  The Physical 
Mesh Parameters rollout for 
the Box mesh type

Figure 16-11  The Advanced 
rollout
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Figure 16-12  The mCloth 
modifier in the Modify panel

Figure 16-13  The mCloth 
Simulation rollout

Figure 16-14  The Capture 
States rollout
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Figure 16-15  The Physical 
Fabric Properties rollout

Figure 16-16  The Volume 
Properties rollout

 

Figure 16-17  The 
Interaction rollout
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Figure 16-18  The 
Tearing rollout

Figure 16-19  The 
Visualize rollout

 

Figure 16-20  The 
Advanced rollout
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Figure 16-21  The rollouts of rigid 
constraint in the Modify panel 

Figure 16-22  The MAXScript message box
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Figure 16-23  The  
General rollout

Figure 16-24  The Translation 
Limits rollout
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Figure 16-25  The Swing & 
Twist Limits rollout

Figure 16-26 The 
Spring rollout

Figure 16-27  The Advanced 
rollout

Figure 16-28  Various 
options in the flyout
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Figure 16-29  Partial view of 
the MassFX Tools dialog box 

Figure 16-30  The Simulation, 
Simulation Settings, and  
Utilities rol louts  in the 
Simulation Tools tab
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Figure 16-31  The Scene Explorer - MassFX Explorer window 

Figure 16-32  The Validate PhysX Scene dialog box 

Figure 16-33  Various options  
displayed in the Ragdoll flyout
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Figure 16-34  The Helpers 
button chosen in the Command 
Panel

Figure 16-35  A dummy helper 
object in the Perspective viewport

Figure 16-36  A point helper object Figure 16-37  The Parameters rollout

Figure 16-38  A tape measure created in a scene Figure 16-39  The Parameters rollout
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Figure 16-41  The Parameters rolloutFigure 16-40  A protractor helper object

     

Figure 16-43  The Parameters rolloutFigure 16-42  A compass rose

Figure 16-44  A container helper Figure 16-45  Partial view of various 
rollouts displayed for the container helper 
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Figure 16-46  The Add Container Node dialog box

Figure 16-47  A BoxGizmo helper

Figure 16-48  The rollouts for modifying 
the BoxGizmo helper in the Modify panel

Figure 16-49  The Add Atmosphere dialog box
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Figure 16-50  The ball falling on sliders at frame 42

Figure 16-51  Alignment of back support with 
the grid
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Figure 16-52  The slider1 geometry after 
aligning the polygons

Figure 16-53  Alignment of the slider1 in 
the Front viewport 

	

Figure 16-54  The sliders aligned in the Front viewport
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Figure 16-55  Alignment of ball in viewports

Figure 16-56  Key animation of ball are baked 

		

Figure 16-57  The scene for Tutorial 2
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Figure 16-58  The brick wall with a metal ball and metal rod in viewports 

Figure 16-59  Universal constraint aligned in viewports
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Figure 16-60  Baked keyframe in the track bar

 

Figure 16-61  Scene for Exercise 1
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Figure 16-62  Simulation of falling balls at different frames



                Particle Flow
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Figure 17-1  The PF 
Source tool in the 
Object Type rollout

 

Figure 17-2  The Particle emitter
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Figure 17-3  The Particle View window 
             

Figure 17-4  The Emission 
rollout
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Figure 17-5  The Selection 
rollout

Figure 17-6  The System 
Management rollout

Figure 17-7  The Script 
rollout
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Figure 17-8 The PF Source 001: Every Step Update Script window

Figure17-9  The Open File dialog box
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Figure 17-10  The PF Source 001: Final Step Update Script window

 

Figure 17-11 The Particle View window
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Figure 17-12  The shortcut menu

Figure 17-13  The Display tools 
in the Display menu

Figure 17-14  The Depot area with Particle Flow actions
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Figure 17-15  The Clone Options 
dialog box

Figure 17-16  The Select Preset 
Flow dialog box
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Figure 17-17  The Duplicate Name dialog box

Figure 17-19  The Birth Texture iconFigure 17-18  The Particle Paint helper

Figure 17-20  The Group Selection icon



17-10				                Autodesk 3ds Max 2014: A Comprehensive Guide

Figure 17-21  The sandman dispersing in sand

Figure 17-22  The c17_tut1_start.max file displayed
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Figure 17-23  The PF source icon

Figure 17-24  The Standard Flow

Figure 17-25  The Sandman_skin 
added to the Emitter Objects area
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Figure 17-26  The Material 
Static 001 rollout

Figure 17-27  The Time Configuration 
dialog box

Figure 17-28  The Event 002 wired to the 
Collision 001 test
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Figure 17-29  The Force 
001 rollout

Figure 17-30  The Split Amount 
001 test added to the Event 002
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Figure 17-31  The 
Particle Flow

Figure 17-32  The Particles emitting from the character
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Figure 17-33  Particles emitting as the sound is played at frame 118

Figure 17-34  The value of the Oversampling 
spinner set to 5 in the Audio Controller dialolg box
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Figure 17-35  The ProSound dialog box

Figure 17-36  The Speed by
Surface 001 (None) operator
in the Event Display area

Figure 17-37  The Move Transform 
Type-In dialog box
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Figure 17-38  The Spawn 
test in Event 001

Figure 17-39  The Spawn test 
linked Event 001
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Figure 17-40  The Material 
Dynamic operator in PF 
Source 001  

Figure 17-41  Particles animating on frame 259
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Figure 17-42  Leaves simulation

 



Particle Systems 
and Space Warps-I
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 Figure 18-2  The Spray particle 
system 

 Figure 18-1  Various tools displayed 
to create particle systems 

 Figure 18-3  The emitter displayed in all viewports for the Spray particle system
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 Figure 18-4  The Particles 
area in the Parameters rollout

 Figure 18-7  The Emitter 
area

 Figure 18-6  The Timing area Figure 18-5  The Render area

 Figure 18-8  The snow 
particles on rendering
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 Figure 18-9  The particles displayed in all viewports for the Snow particle system

  

 Figure 18-11  The facing snow particles  Figure 18-10  The triangular snow particles



Particle Systems and Space Warps-I		         18-5

 Figure 18-12  The particles generated for the Super Spray particle system

 Figure 18-13  The Basic 
Parameters rollout
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 Figure 18-14  Partial view of 
the Particle Generation rollout

 Figure 18-15  Partial view 
of the Particle Type rollout

 

 Figure 18-16  The meta particles  Figure 18-17  The torus object selected 
to create the instance particles 
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 Figure 18-18  Partial view of the 
Rotation and Collision rollout           

 Figure 18-20  The Particle Spawn rollout Figure 18-19  The Bubble Motion rollout

 Figure 18-21  The Load/
Save Presets rollout
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 Figure 18-22  The particles generated for the Blizzard particle system

 Figure 18-23  The particles generated from the distribution object (teapot) in viewports
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 Figure 18-25  The PArray particle system 
with the Object Fragments particle type

 Figure 18-24  Partial view of 
the Basic Parameters rollout

 Figure 18-26  The emitter created for the PCloud particle system 
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 Figure 18-27  The Particle Formation 
area in the Basic Parameters rollout

 Figure 18-28  The Particle Motion area 
in the Particle Generation rollout

 Figure 18-29  The Parameters rollout  Figure 18-30  The BlobMesh object created 
from the blob mesh compound object 
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 Figure 18-31  The mesher object in 
the Perspective viewport

 Figure 18-32  The Parameters rollout 

 Figure 18-34  The Bend modifier assigned 
to the instanced particle system

 Figure 18-33  The instance of the particle 
system displayed

 Figure 18-36  The cursor displayed on 
invoking the Bind to Space Warp tool

 Figure 18-35  The Forces category 
selected in the drop-down list 
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 Figure 18-37  A dotted line displayed from the 
selected object to the space warp object

 Figure 18-38  The space warp object 
displayed in the Command Panel 

 Figure 18-39  The effect 
of Push space warp on the 
particle system 

 Figure 18-40  The Push space warp icon  Figure 18-41  Partial view 
of the Parameters rollout 
for Push space warp
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 Figure 18-42  The spherical shape of the Push 
space warp

 

 Figure 18-43  The particle system with the Gravity space warp 
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 Figure 18-44  The Parameters 
rollout for the Gravity space warp

 Figure 18-45  The particle system with the spherical Gravity space warp 

             



Particle Systems and Space Warps-I		         18-15

 Figure 18-46  The particle system with the Path Follow space warp 

 Figure 18-48  The particles 
with the stream taper effect

 Figure 18-49  The particles 
with the stream swirl effect

 Figure 18-47  Partial view of the 
Basic Parameters rollout 
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 Figure 18-50  The effect of the Wind space warp on the particle system

 Figure 18-51  The Wind area 
in the Parameters rollout 

Figure 18-52  The effect of the 
PBomb space warp on a sphere
at a single frame at rendering
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 Figure 18-53  The PBomb space warp icon in the viewport 

 Figure 18-55  The PBomb icon after 
selecting the Cylindrical radio button 

 Figure 18-54  The Basic 
Parameters rollout for the 
PBomb space warp
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 Figure 18-56  The effect of the PBomb 
space warp on a sphere after selecting the 
Cylindrical radio button at rendering 

 Figure 18-57  The PBomb icon after 
selecting the Planar radio button 



Particle Systems             
and Space Warps-II
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Figure 19-1  The particles affected by the Deflector space warp

  

Figure 19-2  The 
Parameters rollout for 
the Deflector space warp
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Figure 19-3  The particles affected by the SDeflector space warp

Figure 19-4  The particles affected by the UDeflector space warp
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Figure 19-5  The Basic Parameters 
rollout of the UDeflector space warp

Figure 19-6  The particles affected by the POmniFlect space warp
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Figure 19-8  The particles refracted and 
reflected by the space warp

Figure 19-7  Partial view of 
the Parameters rollout

Figure 19-9  The FFD(Box) Figure 19-10  The control points moved to 
modify the shape of the bound object
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Figure 19-11  The space warp icon for 
the Wave space warp

Figure 19-12  The effect of the Wave space 
warp

Figure 19-13  The 
Parameters rollout

Figure 19-14  The effect of the Ripple space 
warp
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Figure 19-17  The Bomb 
Parameters rollout

Figure 19-15  The effect of the 
Bomb space warp at one frame

Figure 19-16  The icon of the 
Bomb space warp

 

Figure 19-18  The box shaped space warp gizmo displayed in all viewports 
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Figure 19-19  The effect of the Skew space warp Figure 19-20  The Gizmo Parameters rollout

 

Figure 19-21  The 
Parameters rollout

Figure 19-22  The effect of the Stretch space warp Figure 19-23  The Parameters rollout
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Figure 19-24  The animated fountains in the scene

Figure 19-25  The Camera001 aligned in viewports
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Figure 19-26  The scene after aligning the Camera001 in viewports 

 

Figure 19-27  The cylinder for creating the water surface
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Figure 19-28  The objects displayed at 
rendering after assigning the materials 

Figure 19-29  The emitter aligned in viewports
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Figure 19-30  The particle simulation displayed in all viewports after playing the animation

Figure 19-31  The particles after applying the Gravity space warp



Particle Systems and Space Warps-II		         19-13

Figure 19-32  The particles after applying the Deflector space warp

Figure 19-33  The particles after modifying the settings of the Deflector space wrap
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Figure 19-34  The scene after rendering Figure 19-35  The rendered scene after 
applying the motion blur effect

Figure 19-36  The four copies of the fountain01 after alignment
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Figure 19-37  The scene after rendering

Figure 19-38  The plants, railings, and park benches in the scene after the alignment 
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Figure 19-39  The Omni01 light in viewports after the alignment

Figure 19-40  All omni lights aligned in the 
Top viewport 
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Figure 19-41  The omni lights in viewports after the alignment

Figure 19-42  The scene at rendering after 
assigning the lights

Figure 19-43  The scene with the environment 
after rendering 
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Figure 19-44  The smoke rising from an incense stick

Figure 19-45  A line for creating the 
incense stick stand

	

Figure 19-46  The incense stick stand and the free camera aligned in viewports
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Figure 19-47  The emitter for Super Spray particle system aligned in viewports

	

Figure 19-48  The particles in the Camera001 viewport at one frame  
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Figure 19-49  The Wind space warp icon aligned in viewports 

Figure 19-50  The smoke after binding with the Wind Space Warp icon in viewports



Particle Systems and Space Warps-II		         19-21

Figure 19-51  The Drag space warp icon aligned in viewports 

Figure 19-52  The smoke after binding with the Drag space warp icon in viewports
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Figure 19-53  The scene after rendering

Figure 19-54  The omni lights aligned in viewports 
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Figure 19-55  The scene at rendering after modifying the color of the environment

		

Figure 19-56  The object floating on the sea
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Figure 19-57  The rainy effect



Project 1

Figure P1-1  The model of the logo

Figure P1-2  The Units Setup dialog box
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Figure P1-3  The Scale Deformation(X) dialog box after scaling at different points

	

Figure P1-4  Column01 modified using the Scale Deformation(X) dialog box



Corporate Design Project	        P1-3

Figure P1-5  Column01Top is aligned with the top of Column01

	

Figure P1-6  Column02 Assembly created
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Figure P1-7  The path for the left-hand horn created
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Figure P1-8  Horn-Left modified using the Scale Deformation(X) dialog box

Figure P1-9  HornAssemblyLeft created
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Figure P1-10  The text displayed as a single object

Figure P1-11  The logo text created



Corporate Design Project	        P1-7

Figure P1-12  A bevel deformation applied to Logo Text and the text centered over the horns

Figure P1-13  The floor and three stairs created and aligned
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Figure P1-14  Saving the material library
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Figure P1-15  The spotlights created and positioned

Figure P1-16  The omni light positioned
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Figure P1-17  The Exclude/Include dialog box

Figure P1-18  The camera created and aligned
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Figure P1-19  The scene rendered after creating the lights and camera

	

Figure P1-20 The Omni001\Color dialog box
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Figure P1-21  A rendered image of the final animation at frame 0



Project 2

Creating a Diner

Figure P2-1  The scene of the diner
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Figure P2-2  Floor created and a material assigned to it

Figure P2-3  The Wall02 geometry is aligned with the end of Floor
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Figure P2-4  Material assigned to Wall01 and Wall02

Figure P2-5  The profile of seat created
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Figure P2-6  The vertices of Seat modified to create a curved back and bottom

Figure P2-7  Booth and Seat created in the viewport
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Figure P2-8  Mirror image is created 40 units to the right of Booth01

Figure P2-9  Top of the table created
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Figure P2-10  The table components aligned

Figure P2-11  The lofted star shape
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Figure P2-12  The vertices created and moved in the Scale Deformation(X) dialog box

Figure P2-13  Shade moved into position
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Figure P2-14  A suspension cylinder created

Figure P2-15  A light placed inside the lamp shade
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Figure P2-16  A glass with water created

	

Figure P2-17  Drink02 created and positioned
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Figure P2-18  Plate01 created and positioned

 

Figure P2-19  The window placed on the wall
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		  Figure P2-20  The text for the sign created

	

Figure P2-21  Omni01 light created and positioned
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Figure P2-22  Blind01 created and positioned

Figure P2-23  The Array dialog box
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Figure P2-24  The blinds created using the Array tool

Figure P2-25  The selected objects copied and positioned
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Figure P2-26  Aligning objects in the center of the Camera001 viewport

Figure P2-27  The Spot003.Target moved and placed in the middle of the window



Creating a Diner	       P2-15

Figure P2-28  The rendered view of the scene

Figure P2-29  The blinds at the midpoint of the animation
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